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<Organization of This User’s Guide>
The User’s Guide for this system comprises Volumes 1 to 3.

Volume 1
This book. For the contents of this volume, see “Table of Contents” at the front.
Chapter 1 DVS-9000 Functions
Chapter 2 Menus and Control Panel
Chapter 3 Signal Selection and Transitions
Chapter 4 Keys
Chapter 5 Wipes
Chapter 6 DME Wipes
Chapter 7 Frame Memory
Chapter 8 Color Backgrounds, Copy and Swap, and Other Settings
Chapter 9 Color Corrector
Chapter 10 Special Functions
Appendix (Volume 1)

• Wipe Pattern List
• DME Wipe Pattern List
• Menu Tree

Index

Volume 2
The volume comprises the following chapters.
Chapter 11 DME Operations
Chapter 12 External Devices
Chapter 13 Keyframe Effects
Chapter 14 Snapshots
Chapter 15 Utility/Shotbox
Chapter 16 Macros
Chapter 17 Files
Appendix (Volume 2)

• SpotLighting
• Functional Differences With Models of DME
• Macro File Editing Rules
• About the Macro Attachment List Display
• Menu Operations Not Recorded in a Menu Macro

Index

Volume 3
The volume comprises the following chapters.
Chapter 18 System Setup (System)
Chapter 19 Control Panel Setup (Panel)
Chapter 20 Switcher Setup (Switcher)
Chapter 21 DME Setup (DME)
Chapter 22 DCU Setup (DCU)
Chapter 23 Setup Relating to Router Interface and Tally (Router/Tally)
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Chapter 24 Simple Connection of the MKS-8080/8082 AUX Bus Remote 
Panel

Chapter 25 DIAGNOSIS
Appendix (Volume 3)

• Data Saved by [Setup Define] and [Initial Status Define]
• Error Messages

Index
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Functions Newly Supported in Version 8.00

The functions newly supported in the DVS-9000 system version 8.00 are as 
follows.

Functions relating to operability

Classification Functions supported Menu No. See page

Vol.1 Vol.2 Vol.3

Router control The source for each destination can 
be switched with the Router Control 
menu

5111 321 - 82

Snapshot Router region is added to the regions 
for which you can save snapshots.

- - 221 -
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Introduction

This manual is the User’s Guide for the DVS-9000/9000SF Production 
Switcher system supporting the SDTV signal format only. The DVS-9000 and 
DVS-9000SF have different numbers of M/E banks and input/output signals, 
but are otherwise functionally identical.
This manual refers to these generically as the “DVS-9000 system,” and 
describes principally the operation of the system using the CCP-9000 series of 
center control panels.
The User's Guide for this system comprises three volumes.
For the contents of each volume, see the section “Organization of This User’s 
Guide” at the front of this volume.

Devices and system nomenclature
In this manual, when discussing the principal components of the DVS-9000 
system, in place of the formal product names, abbreviated names 
characterizing the functions and features are sometimes used. When 
distinctions between system configurations must be drawn, the terms in the 
following table are used.

Principal components and naming
The formal product names of the principal components of the DVS-9000 
system, and the terms used in this manual are as follows.

System nomenclature
The following terms are used for systems, depending on the combination of 
installed options, and the signal format.

Formal product name Term used in this manual

DVS-9000/9000SF Production Switcher 
Processor

Switcher or switcher processor

BKDS-9470 DME Board Set DME or DME board set or BKDS-9470

MVE-8000A Multi Format DME Processor DME or DME processor or MVE-8000A

MVE-9000 Multi Format DME Processor DME or DME processor or MVE-9000

CCP-9000/9000A-series Center Control 
Panel

Control panel or center control panel

DCU-8000 (MKS-8700) Device Control Unit DCU or MKS-8700

DCU-2000 (MKS-2700) Device Control Unit DCU or MKS-2700
Introduction
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Related manuals
The following manuals are supplied with the individual products of the DVS-
9000 Production Switcher system.

DVS-9000/9000SF-C Switcher Processor Pack
• DVS-9000/9000SF-C Operation Manual
• DVS-9000/9000SF-C Installation Manual

MVE-8000A DME Processor Pack
• MVE-8000A Operation Manual
• MVE-8000A Installation Manual

BKDS-9470 DME Board Set
• BKDS-9470 Operation Manual
• BKDS-9470 Installation Manual

MVE-9000-C DME Processor Pack
• MVE-9000-C Operation Manual
• MVE-9000-C Installation Manual

CCP-9000-C Center Control Panel Pack
• CCP-9000-C Operation Manual
• CCP-9000-C Installation Manual
• CCP-9000A-C Operation Manual
• CCP-9000A-C Installation Manual

DCU-8000 Device Control Unit Pack
• DCU-8000 Operation Manual
• DCU-8000 Installation Manual

DCU-2000 Device Control Unit Pack
• DCU-2000-C Operation Manual
• DCU-2000-C Installation Manual

System configuration and features Term for system

A system in which the center control panel has 
two M/E banks

2M/E system

A system in which the center control panel has 
one M/E bank

1M/E system
15Introduction
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Features of the DVS-9000 Production 
Switcher System

The DVS-9000 Production Switcher system boasts extensible high 
performance and multifunctionality. The following are some of the principal 
features of this system.

System configuration flexibility

SDTV support
This system supports the SDTV signal formats 480i/59.94 and 576i/50. The 
format selection can be switched by a simple control panel operation.

Extensible system configuration
By suitable combination of options, the switcher can be configured with 
various inputs and outputs, and different numbers of M/E banks. The system 
offers the flexibility to change and expand as required.
Additionally, by installing the optional BKDS-9470 DME Board Set, or 
connecting an MVE-8000A or MVE-9000 extensible DME processor, which 
provides any number from one to four channels, you can obtain a maximum of 
four channels of DME functionality.

Powerful external device interfaces
By connecting to a Sony routing switcher or similar, a large system can be 
built. From the control panel, it is also possible to operate other equipment, 
including VTRs and disk recorders.

Powerful tally system
The complete system including routing switcher provides an all-inclusive tally 
system. The system can be adapted to different applications and settings, using 
multiple tally outputs, including both on-air and recording tallies.

Comprehensive video manipulation

M/E banks
Each mix/effects bank (M/E bank) is equipped with four keyers, and each 
keyer is capable not only of chroma keying, but also independent key 
transitions separate from the background transitions. The four keys can be 
freely combined, to carry out four different program outputs.
Features of the DVS-9000 Production Switcher System
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Powerful frame memory functions
The frame memory can store 444 frames, and up to eight of these can be 
recalled simultaneously.

Link operation with DME
Using the BKDS-9470 DME Board Set (option), a range of DME functions 
including DME wipes and processed keys can be handled as switcher 
functions.
When the BKDS-9470 is installed, you can interface to a maximum of four 
DME channels.
Note that the MVE-8000A and MVE-9000 can also be used with this system 
by connecting through an SDI interface.

Designed for use in a live broadcasting environment

High-performance user interface
The menu control block provides a large color LCD panel, with rapid touch-
panel menu selection.
The source name displays have color backlit LCD displays. The signal names, 
and graphical representations of the patterns associated with buttons provide 
intuitive feedback, and allow the immediate decisions that are required in a live 
operating environment.
17Features of the DVS-9000 Production Switcher System
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Basic Video Processing

This section introduces basic functions used for video processing on the 
switcher.

Transitions

In the M/E banks and PGM/PST bank, the switch from the current video stream 
(appearing on the corresponding program monitor) to a new video stream is 
referred to as a transition.
In the M/E banks and PGM/PST bank, you can change one of the images, the 
background, and keys 1 to 4 (downstream keys 1 to 4 in the PGM/PST bank), 
and also vary combinations of these simultaneously.
The following are examples of transition.

Changing the background
A background transition switches from the video currently selected on the 
background A bus (the current video) to the video selected on the background 
B bus (the new video).

In the default selection of flip-flop mode (see page 126), the background 
always switches in the direction from the A bus to the B bus. When the 
transition completes, the cross-point selections on the A and B buses are 
interchanged.

Background BBackground A

Transition
Basic Video Processing
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Inserting and deleting a key

You can insert one or more of the four keys (downstream keys on the PGM/
PST bank).
If you select a key which is already inserted, the transition will delete the key.
A simultaneous combination of deleting and inserting keys is also possible.

Inserting or deleting key 1 and key 2

Deleting key 1 and inserting key 2

Delete

Insert

Key 1

Key 2

Key 1

Key 2

Transition
19Basic Video Processing
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Simultaneously changing the background and keys
You can change any of the four keys (downstream keys on the PGM/PST bank) 
and the background at the same time.

Changing the background and key 2 simultaneously

Changing the background and keys 1 to 4 simultaneously

Selecting the transition type determines the way in which the transition occurs. 
The following are the transition type.
• Mix
• NAM (non-additive mix)
• Super mix 
• Preset color mix (color matte)
• Wipe
• DME wipe
• Clip transition
• Cut

Key 1

Key 2

Transition

Key 1

Key 2 Key 3 Key 4

Transition
Basic Video Processing



  C
hapter 1 

D
V

S
-9000 F

unctions

There are two modes for carrying out a transition: auto transitions are carried 
out by a button operation, and manual transitions are carried out using the fader 
lever. It is also possible to combine these two modes.

Independent Key Transitions
In addition to common transitions, it is possible to carry out independent 
transitions on the keyers of the M/E banks and PGM/PST bank. These are 
called “independent key transitions.”
By carrying out an independent key transition in combination with a common 
transition, different transition types can be used for the background and keys. 
The following description compares the independent key transition with a 
common transition, taking a simultaneous change of the background and key 
as an example.

Video used in the transition

Effect of a common transition
In the case shown in the previous illustration, carrying out a common transition 
produces the following change in the image.

Effect of a common transition

Background A Background B Key to insert

Same wipe is applied to 
background and key.

Transition type: wipe
21Basic Video Processing
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Effect of use with an independent key transition
The key is inserted with an independent key transition as the background 
changes with a common transition, providing the following result.

Effect of a background transition and independent key transition

For details of transitions, see Chapter 3 “Signal Selection and Transitions” 
(page 91).

Keys

A key is an effect in which a part of the background image is replaced by an 
image or superimposed text. The signal determining how the background is cut 
out is termed “key source,” and the signal that replaces the cut-out part is 
termed “key fill.” The system component responsible for processing a key is 
referred to as a keyer.
Each switcher bank has four keyers, each providing the same functionality.

On each switcher bank, you can use the following key types (methods of 
processing the key source).
• Luminance key
• Linear key
• Color vector key
• Chroma key
• Wipe pattern key
• Key wipe pattern key

Key modifiers
You can apply borders and other modifiers to the edge of the key image.

Different wipe patterns are applied to 
the background and key transitions.

Transition type: 
wipe

Independent key 
transition type: 
wipe
Basic Video Processing
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Masks

A mask allows a part of the image to be replaced by the background or a key. 
To prevent unwanted holes in the background, or if a key is not the desired 
shape, you can correct this with a mask.

Wipes

A wipe is a transition from the current video stream to a new video stream, 
using a wipe pattern.
Changing the background by means of a wipe is referred to as a “background 
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition, 
and those that can be selected in an independent key transition.

The patterns that can be used for a wipe are as follows. 
• Standard wipe patterns
• Enhanced wipes
• Rotary wipes
• Mosaic wipe pattern
• Random and diamond dust wipe patterns

You can combine two selected patterns (referred to as main and “sub”) to 
create a new pattern (pattern mix).

You can also specify the wipe direction, or set the pattern position, applying 
various changes and modifiers to the selected wipe pattern.

For details, see Chapter 5 “Wipes” (page 189).

DME Wipes

A DME wipe is a wipe transition that uses a DME effect to change from one 
video image to the next. 
There are two types of DME wipe: those which can be selected for a normal 
transition, and those which can be selected for an independent key transition.

The patterns that can be used for a DME wipe are as follows. 
Slide, Squeeze, Split, Door, Flip tumble, Mirror, Sphere, Character trail, 
Wave, Ripple, Page turn, Page roll, Frame in-out, Picture-in-picture, 2D 
trans, 3D trans, Sparkle, Split slide, Mosaic, Defocus, Brick, and User 
programmable DME
23Basic Video Processing
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You can also specify the wipe direction, or set the pattern position, applying 
various changes and modifiers to the selected DME wipe pattern.

For details, see Chapter 6 “DME Wipes” (page 223).

Frame Memory

Frame memory is a function for using a still image or video (frame memory 
clip) as material for editing.
You can create a still image by capturing a frame of input video or a clip by 
specifying a range of input video. The created images and clips can be written 
to memory for playback, editing, and output.

For details, see Chapter 7 “Frame Memory” (page 257).

Color Backgrounds

This function can be used to obtain color background video.
Two color signals generated from the dedicated generators can be switched or 
mixed, and then output.

For details, see “Color Background” (page 304).

Copy and Swap

This function can be used to copy and swap the settings among the M/E-1 to 
M/E-3, and PGM/PST banks or between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E and PGM/PST banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition control block
• Matte data (color 1, color 2, and how to compose them)
• Color settings
• DME channel settings

For details, see “Copy and Swap” (page 308).
Basic Video Processing
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Video Process

The term “video process” is applied to adjustments to the gain, hue, black level 
of the input video signal. There are two types of adjustment; adjustment of an 
individual primary input signal and adjustment as image effects on a particular 
bus

For details, see “Video Process” (page 323).

Color Corrector

The color corrector enables video signal color correction (black balance/white 
balance adjustment, gamma correction, knee correction, etc.).
The color corrector includes the following adjustments.
• Input video processing
• Primary color correction
• Secondary color correction
• RGB clip
• Luminance processing
• Spot color adjustment
• Output video processing
• YUV clip

For details, see Chapter 9 “Color Corrector” (page 327).

Simple P/P Software

By installing the BZS-9250 simple P/P software in the DVS-9000/9000SF 
Switcher Processor, you can use the program/preset function without using M/
E hardware.

For details, see “Simple P/P Software” (page 348).
25Basic Video Processing
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Creation of Special Effects and 
Management of Data and Operations

This section introduces functions used for creation of special effects, control of 
external devices or switcher operations, and data management.

Digital Multi Effects (DME)

When used with the switcher, DME allows you to add three-dimensional 
effects such as image movement, rotation, magnification and shrinking, as well 
as a wide variety of special effects. 
Each channel can be used on its own or in combination with other channels, 
which allows you to create advanced effects with more complexity.

The following types of DME special effects are available.
• Edge effects: Border, Crop, Beveled Edge, Key Border, Art Edge, Flex 

Shadow
• Effects for entire image: Defocus, Blur, Multi Move
• Effects for video image: Sepia, Mono, Posterization, Solarization, Nega, 

Contrast, Mosaic, Mask, Sketch, Metal, Dim and Fade, Glow
• Freeze effects
• Nonlinear effects: Wave, Mosaic Glass, Flag, Twist, Ripple, Rings, Broken 

Glass, Flying Bar, Blind, Split, Split Slide, Mirror, Multi Mirror, 
Kaleidoscope, Lens, Circle, Panorama, Page Turn, Roll, Cylinder, Sphere, 
Explosion, Swirl, Melt, Character Trail

• Lighting effects: Lighting, Spotlighting
• Recursive effects: Trail, Motion Decay, Keyframe Strobe
• Background color
• Separate Sides (effects for front and back sides)
• Signal inversion (Invert effect)
• Key density adjustment
• Key source selection

Global effects
Global effects are special effects created by combining the images of 
successive channels. The following types of global effects are available.
• Combiner
• Brick
• Shadow

For details, see Chapter 11 “DME” (Volume 2).
Creation of Special Effects and Management of Data and Operations
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External Devices

In this system, you can operate while controlling the following types of 
external device:
• Devices supporting P-Bus (Peripheral II protocol) 
• Devices supporting GPI
• VTRs
• Disk recorder (Sony disk 9-pin protocol and video disk communications 

protocol)
• Extended VTR (Abekas A53 protocol)

For details on the devices that can be connected, consult your Sony 
representative.

You can control an external device by previously registering timeline 
keyframes.

For details, see Chapter 12 “External Devices” (Volume 2).

Keyframes

A keyframe represents an instantaneous state of an image; it can be saved in a 
register (see “Registers” in Chapter 13 (Volume 2)) and recalled for reuse.
By arranging a number of keyframes on the time axis, and interpolating 
between successive keyframes, you can create an effect in which there is a 
continuous change from each keyframe to the next.
27Creation of Special Effects and Management of Data and Operations
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The following figure shows three keyframes created with a wipe pattern (the 
circle) in different positions. This is interpolated to create the effect shown.

Example of keyframes and effect execution

You can save the sequence of keyframes representing a single effect in a 
register. Then by recalling this register, you can replay the same effect.

For details, see Chapter 13 “Keyframe Effects” (Volume 2).

Snapshots

The term “snapshot” refers to a function whereby the various settings required 
to apply a particular effect to an image are saved in a register as a set of data, 
for recall as required, to recover the original state.

Snapshots are divided as follows.
• Snapshots applying to a particular region (functional block of the switcher or 

DME)
• Master snapshot
• Key snapshot
• Wipe snapshot
• DME wipe snapshot:

An individual snapshot may also have attached special conditions relating to 
switcher or DME operation when the snapshot is recalled.

Background A

Background B
Interpolated images

Keyframe 1 Keyframe 2 Keyframe 3

Effect execution
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These conditions are called “attributes” of the snapshot, and can be added when 
the snapshot is saved or recalled.

For details, see Chapter 14 “Snapshots” (Volume 2).

Utility

The utility function refers to a function whereby you can assign an arbitrary 
action or a shortcut for frequently used menu to a particular button, then 
instantly recall the action or menu by pressing the button.

For details, see “Utility Execution” in Chapter 15 (Volume 2).

Shotbox

The term “shotbox” refers to a function whereby for each specified region (see 
“Regions” in Chapter 13 (Volume 2)) any snapshot or keyframe effect can be 
recalled simultaneously.

For details, see “Shotbox” in Chapter 15 (Volume 2).

Macros

The term “macro” refers to the function whereby a sequence of signal 
selections and other operations on the control panel is saved as data in memory, 
so that it can be recalled as required to automatically execute the same 
sequence of operations.
The individual control panel operations constituting a macro are termed 
“events.
Macros also provide the following functions.

Menu macros
The term “menu macro” refers to the function whereby a sequence of menu 
operations is saved as data in memory, so that it can be recalled as required to 
automatically execute the same sequence of operations.

Macro timeline
By recording macro recall and execute action on a timeline, in the same way as 
for keyframes in an effect, you can automatically execute them in a sequence.
29Creation of Special Effects and Management of Data and Operations
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Macro attachment
Macro attachment is a function whereby a macro register is assigned to a 
control panel button or a particular position of a fader lever, linking the 
execution of the button function or a fader lever operation with a macro 
execution.

For details, see Chapter 16 “Macros” (Volume 2).

Files

You can save register data, including setup information and snapshot 
information, as a file on a hard disk or memory card, and recall it as required.
You can operate on individual files or registers, or together in a batch.
Regarding frame memory, it is possible to capture image data stored in an 
external device into frame memory. You can also convert the format of image 
data in frame memory into a different format and save it in an external device.

The following files can be saved and recalled.
• Operation mode setup data for system as a whole and individual devices
• Device status data for system startup
• Key memory setting data
• Video process memory setting data
• Keyframe effect setting data
• Snapshot setting data
• Wipe snapshot setting data
• DME wipe snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Macro setting data
• Macro attachment data
• Menu macro setting data
• Frame memory image data

For details, see Chapter 17 “Files” (Volume 2).
Creation of Special Effects and Management of Data and Operations
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Setup

Various settings are required, in order to operate the switcher, control panel, 
DME, external devices, and so on, connected together in a single system.
This is referred to as “setup,” and you can carry out the setup operations from 
the Engineering Setup menu.

The settings in the Engineering Setup menu are grouped under the following 
headings.

• System setup (System)

For details, see Chapter 18 “System Setup” (Volume 3).

• Panel setup (Panel)

For details, see Chapter 19 “Control Panel Setup (Panel)” (Volume 3).

• Switcher setup (Switcher)

For details, see Chapter 20 “Switcher Setup (Switcher)” (Volume 3).

• DME setup (DME)

For details, see Chapter 21 “DME Setup (DME)” (Volume 3).

• DCU setup (DCU)

For details, see Chapter 22 “DCU Setup (DCU)” (Volume 3).

• Router/tally setup (Router/Tally)

For details, see Chapter 23 “Setup Relating to Router Interface and Tally 
(Router/Tally)” (Volume 3).
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Names and Functions of Parts of the 
Control Panel

Example Control Panel Configuration

Example control panel configuration (with CCP-9000 2M/E panel)

Key control block (page 55)

Keyframe control block (page 45)

Device control block (joystick) (page 43)

Menu control block (page 51)

Transition control block (page 39)

Utility/Shotbox control 
block (page 65)

Numeric keypad control block (page 48)

Auxiliary bus control block (page 50)

M/E-1 bank

PGM/PST bank

Cross-point control block (page 37)

Memory card/USB adaptor block (page 52)

Device control block 
(page 59)

Up to three units 
connectable

Downstream key control 
block (page 66)
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Example control panel configuration (with CCP-9000A 2M/E panel)

Key control block (page 55)

Keyframe control block (page 45)

Device control block (joystick) (page 43)

Menu control block (page 51)

Transition control block (page 39)

Utility/Shotbox control 
block (page 65)

Numeric keypad control block (page 48)

Auxiliary bus control block (page 50)

M/E-1 bank

PGM/PST bank

Cross-point control block (page 37)

“Memory Stick”/USB connections block (page 53)

Device control block 
(page 59)

Up to three units 
connectable

Downstream key control 
block (page 66)
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Example control panel configuration (with CCP-9000A 1M/E panel)

Key control block (page 55)

Keyframe control block (page 45)

Device control block (joystick) (page 43)

Menu control block (page 51)

Transition control block (page 39)

Utility/Shotbox control 
block (page 65)

Numeric keypad control block (page 48)

Auxiliary bus control block (page 50)

M/E-1 bank

Cross-point control block (page 37)

“Memory Stick”/USB connections block (page 53)

Device control block 
(page 59)

Up to three units 
connectable

Downstream key control 
block (page 66)
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
Cross-Point Control Block

In the cross-point control block, you can 
select the signals to be used in this M/E 
bank or PGM/PST bank.

a Cross-point buttons
These buttons select the signals used for 
video creation on this M/E bank or PGM/
PST bank. Each row of buttons corresponds 
to one or more signal buses within the 
switcher.
Key row: The buttons in this row select the 

bus signals specified with the key row 
delegation buttons ([DSK1] to [DSK4], 
[DME1] to [DME4], [UTIL1], or 
[UTIL2]) or delegation buttons in the 
auxiliary bus control block.

The later pressed delegation button 
takes precedence and the selection is 
reflected in the key row.

Background A row: Press the desired 
button to select the signal as the current 
background video on this M/E bank or 
PGM/PST bank.

Background B row: Press the desired 
button to select the signal as the 
background after the next transition on 
this M/E bank or PGM/PST bank.

SHIFTUTIL2UTIL1DME4DME3DME2DME1DSK4DSK3DSK2DSK1
XPT

HOLD

1 Cross-point buttons

2 Source name displays

3 Key row delegation buttons

4 XPT HOLD button

5 SHIFT button

Key row

Background A row

Background B row
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Cross-point button numbers
Cross-point button and reentry buttons are 
respectively numbered.

For details, see “Cross-point button 
control block button numbers” (page 97).

Assigning signals to button
You can assign a signal to each button using 
the Setup menu.

For details on the operation, see “Cross-
Point Settings (Xpt Assign Menu)” in 
Chapter 19 (Volume 3).

Visual indications on cross-point buttons

For details on the operation, see “Colors of 
lit cross-point buttons” (page 100).

b Source name displays
These show the names of the signals which 
can be selected on the cross-point buttons, 
in two or four characters, or in auto mode.
While the [SHIFT] button or the [SHIFT] 
button assigned to the column of cross-
point buttons is enabled, the source name of 
the signal assigned to the column of cross-
point buttons in shift mode appears. You 
can select green, orange, or yellow for the 
background color of the source name 
display, for each source separately. You can 
set the source name display mode and 
background color in a Setup menu.

c Key row delegation buttons
Use these buttons to assign buses to the key 
row, copy keys, or assign DME to keys.

d XPT (cross-point) HOLD button
Turning this button on enables you to recall 
a keyframe or snapshot while keeping the 
current cross-point selection unchanged. 
This function is valid for the background A 
and B rows.

By means of setup settings, you can also 
enable this for the following function 
blocks.
• Background A and B rows
• Key buses
• Utility 1 and 2 buses
• External DME bus
• DME utility 1 and 2 buses

e SHIFT button
When this button is enabled, either the 
source name displays show the shifted 
signal names, or the shifted signals for all 
buses in this M/E (P/P) bank are enabled. 
You can select either mode in a Setup 
menu.
Each press of the button toggles between 
the enabled and disabled states.
Using a Setup menu operation, you can also 
make this button function as the [SHIFT] 
button for the whole cross-point control 
block inclusive of the key row and 
background A and B rows.
Names and Functions of Parts of the Control Panel
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Transition Control Block

In the transition control block, you can 
modify the output of the M/E bank or PGM/
PST bank, and perform transitions. Both 

common transition and independent key 
transition operations are possible.

a Next transition selection buttons
Press these buttons, turning them on, to 
determine what the next transition will 
apply to.
BKGD: Next transition changes the 

background.

KEY1 to KEY4 (DSK1 to DSK4 in the 
PGM/PST bank): Press this button, 
turning it on, to make the next 
transition insert or remove the 
corresponding key (keys 1 to 4). If a 

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

DSK1
TRANS

DSK2
TRANS

DSK3
TRANS

DSK4
TRANS

9 PRIOR SET button

1 Next transition selection buttons

8 Key status display

2 Transition type selection buttons

7 KF button

6 Pattern limit buttons

5 TRANS PVW button

3 Transition execution section

4 Wipe direction selection buttons

0 Independent key/downstream 
key transition execution section
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key is currently inserted it will be 
removed, and vice versa.
In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 4.

KEY PRIOR (priority): When this button 
is lit, the setting of the key priority after 
the next transition is enabled. The key 
priority after the next transition appears 
in the key status display.

ALL: Pressing this button turns on a 
preselected set of the [BKGD], [KEY1] 
to [KEY4], and [KEY PRIOR] buttons.
Make this setting in a Setup menu.

b Transition type selection buttons
You can assign these buttons in setup to any 
transition type (see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3)).
Press one of these buttons, turning it on, to 
determine the type of the next transition.
When multi-program mode is selected in 
the Setup menu (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
20 (Volume 3)), two or more of the 
following buttons may light.
You can also assign a function to these 
buttons to select whether or not the fader 
levers are used as keyframe faders.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.
In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 
transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 

100% to zero in the second half while 
the new video is maintained at 100%.

SUPER MIX: The current video is 
maintained at 100% output for the first 
half of the transition as the new video is 
mixed while increasing progressively 
to 100%. The current video is then 
progressively reduced from 100% to 
zero in the second half while the new 
video is maintained at 100%.

PST (preset) COLOR MIX: In the first 
transition, the current video is replaced 
by the color matte in a mix (dissolve), 
then in the second transition the color 
matte is replaced by the new video also 
in a mix (dissolve).
In place of a color matte, you can select 
any signal on the utility 2 bus.

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: A wipe type of transition is carried 
out, using the DME effect selected in 
the DME Wipe menu.

FM1&2CLIP, FM3&4CLIP, 
FM5&6CLIP, FM7&8CLIP: A 
recorded clip is played back together 
with the transition. At this point, you 
can also carry out a transition (wipe or 
mix (dissolve)) simultaneously 
together with the clip.

KF (keyframe): Press this button, turning 
it on, to enable using the fader lever as 
a keyframe fader.

c Transition execution section
Transition indicator: This comprises 

multiple LEDs, which show the 
progress of the transition.

Fader lever: Move up or down to carry out 
the transition. When the [KF] button or 
a transition type selection button to 
which the KF button function has been 
assigned is lit, you can use this as a 
keyframe fader.
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Transition rate display: This shows the 
“transition rate” (the time from the 
beginning of a transition to its 
completion) set for an auto transition, 
in frames.
You can set the transition rate using the 
numeric keypad control block or menu.

AUTO TRANS (transition) button: 
Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

CUT button: Pressing this button carries 
out the transition as a cut (i.e. 
instantaneously).

d Wipe direction selection buttons
When you have selected a wipe or DME 
wipe as the transition type, press one of 
these buttons, turning it on, to select the 
wipe direction.
NORM (normal): The wipe proceeds in 

the direction from black to white as 
shown on the pattern in the lists of 
patterns see “Wipe Pattern List” (page 
353) and “DME Wipe Pattern List” 
(page 359), or in the direction of the 
arrow.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button plays the 
tape.

REV (reverse): The wipe proceeds in the 
opposite direction to that when the 
[NORM] button is pressed.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button cues the tape 
automatically to the start point.

NORM/REV (normal/reverse): The wipe 
direction alternates between normal 
and reverse every time a transition is 
executed.

When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button stops the 
tape.

e TRANS PVW (transition preview) 
button

When this button is lit, you can check in 
advance the video changes during the 
transition, on the preview output from the 
M/E or PGM/PST bank.
During the preview, you can use the fader 
lever, [AUTO TRANS] button, and [CUT] 
button. One of the following functions of 
this button can be selected in a Setup mode.
• When the transition completes, the 

system returns to the normal mode.
• The transition preview mode is 

maintained while this button is pressed.
• Switching is made between the transition 

preview mode and normal mode every 
time this button is pressed.

f Pattern limit buttons
PTN (pattern) LIMIT: Pressing this 

button, turning it on, enables the 
pattern limit function.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button plays the 
tape.

LIMIT SET: Use this button to set a 
pattern limit when the [PTN LIMIT] 
button is off.
Move the fader lever to the position of 
a particular pattern size, and stop it 
there, then press this button to set the 
pattern limit range.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button stops the 
tape.

g KF (keyframe) button
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
41Names and Functions of Parts of the Control Panel
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setup, pressing this button cues the tape 
automatically to the start point. When not, 
pressing this button to turn it on allows you 
to use the fader lever as a keyframe fader.

h Key status display
For each of keys 1 to 4, the corresponding 
ON indicator lights when the key is 
inserted. It also shows the priority (1 to 4) 
of each key.

i PRIOR (priority) SET button
While this button is held down, you can set 
the key priority.
The setting mode when this button is 
pressed depends on whether or not the 
[KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the 

current key priority is set.
• When the [KEY PRIOR] button is lit, the 

key priority after the next transition is set.
Press the [KEY PRIOR] button as required, 
to switch between these two modes.
In either mode, hold down the [PRIOR 
SET] button, and press the button ([KEY1] 
to [KEY4]) corresponding to the key you 
want to bring to the front.

The following controls are used as the 
independent key transition control block.

j Independent key/downstream key 
transition execution section

KEY1 TRANS to KEY4 TRANS (DSK1 
TRANS to DSK4 TRANS in the 
PGM/PST bank) buttons: These 
correspond to keys 1 to 4 from top to 
bottom; press one to carry out an auto 
transition. The transition rate for an 
independent key transition can be set in 
the numeric keypad control block or in 
a menu.

The color with which buttons are lit shows 
the status, as follows.
Lit green: During a transition

Lit amber: Key on. Not inserted into 
program video (final output video from 
the switcher).

Lit red: Key on. Inserted into program 
video (final output video from the 
switcher).

Not lit: Key off.
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Device Control Block (Joystick)

The joystick type device control block is 
used for three-dimensional transform 
operations using a DME.

a Operating buttons
The functions of these buttons are 
equivalent to the functions in three-
dimensional transform operation mode of 
the operating buttons of the trackball type 
device control block.

Note

To select a required DME channel, use the 
region selection buttons in the numeric 
keypad control block.

Use of the SHIFT button
Pressing a button in the device control 
block while holding down the [SHIFT] 
button enables the shifted function of the 
button. Also, pressing a button in the 
keyframe control block while holding down 

the [SHIFT] button enables the shifted 
function of the button.

About the [CLR WORK BUFR] (clear 
work buffer) button
When [M/E-1] or [P/P] is selected along in 
the numeric region selection buttons of the 
keypad control block, press this button 
twice in rapid succession to reset all 
parameters of the selected M/E or P/P to 
their initial values. When a DME channel is 
selected in the region selection buttons, the 
operation is the same as when using a 
trackball type device control block in the 
three-dimensional transform operation 
mode .

PAUSE

COPY

INS

RUN

MENU LOCAL GLB SRC TRGT

ROT

SHIFT

PASTEREV

MOD

ASP
SKEW
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NEXT
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X
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b Joystick
When the three-dimensional transform 
operation mode is enabled
By moving this, you can carry out 
operations in the x-, y-, and z-axes.
When the following buttons are held down, 
operation of the joystick is switched to a 
finer control. (fine mode)
• The button on the end of the joystick
• [SRC] button
• [TRGT] button
Depending on the settings made in the 
Setup menu, the operation speed multiple 
can be changed.

When the effect run control mode is 
enabled
By moving the joystick sideways, you can 
run the keyframe effect, independent of the 
STOP NEXT KF, EFF LOOP, and similar 
settings in the keyframe control block. 
Move to the right to run the effect in the 
normal direction, and to the left for the 
reverse direction.

c MENU button
The function of this button is equivalent to 
the function of the [MENU] button in the 
trackball type device control block.
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Keyframe Control Block

In the keyframe control block, you can 
carry out effect editing and execution.

a EDIT ENBL (edit enable) button
Press this button, turning it on, to enable 
effect editing operations with the keyframe 
control block.
When macro editing is carried out, this 
button lights red.

b Edit point specification buttons
GO TO KF/TC (Go to keyframe/

timecode): Press this button, turning it 
on, to enter a numeric value from the 
numeric keypad control block, and 
move the edit point to the specified 
keyframe.
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0 EFF LOOP button

1 EDIT ENBL button

2 Edit point specification buttons

3 Editing buttons

4 Duration setting buttons

5 KF LOOP button

6 PAUSE button

7 Effect execution section

8 Effect execution direction selection buttons

9 STOP NEXT KF button

qa RUN CTRL button
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To move the edit point to the specified 
timecode position, hold down the 
[SHIFT] button in the device control 
block, then press this button, turning it 
on, and enter the desired numeric value 
from the numeric keypad control block.
During macro editing, pressing this 
button moves the edit point to the event 
number specified by numeric entry 
with the numeric keypad control block.

PREV KF (previous keyframe): When 
this button is pressed, the edit point 
moves to the keyframe immediately 
before the current time (the position 
where the effect is currently stopped).
During macro editing, pressing this 
button moves the edit point to the event 
immediately before the current event.

NEXT KF (next keyframe): When this 
button is pressed, the edit point moves 
to the keyframe immediately after the 
current time.
During macro editing, pressing this 
button moves the edit point to the event 
immediately after the current event.

c Editing buttons
FROM TO: Press this button, turning it on, 

to enter numeric values from the 
numeric keypad control block, and 
select a specified range of keyframes 
(during macro editing, the specified 
range of events).

INS (insert): When this button is pressed, a 
new keyframe is inserted after the 
current keyframe. Pressing this button 
while holding down the [SHIFT] 
button in the device control block 
inserts a new keyframe before the 
current keyframe.
During macro editing, pressing this 
button moves the edit point to the event 
immediately after the current event.

MOD (modify): When this button is 
pressed, the selected keyframe is 
modified with the values of the current 

keyframe. When the edit point is 
between two keyframes, the 
immediately preceding keyframe is 
modified. You can also select multiple 
keyframes, and modify them in a single 
operation. At this time, pressing this 
button while holding down the 
[SHIFT] button in the device control 
block modifies all selected keyframes 
with the changed values taken as 
relative values.
During macro editing, pressing this 
button amends the selected event.

DEL (delete): When this button is pressed, 
the selected keyframe is deleted. When 
the edit point is between two 
keyframes, the immediately preceding 
keyframe is deleted. During macro 
editing, pressing this button deletes the 
selected event. You can also select 
multiple keyframes or macro events, 
and delete them in a single operation.

COPY: When this button is pressed, the 
selected keyframe (during macro 
editing, macro event) is copied. You 
can also select multiple keyframes or 
macro events, and copy them in a 
single operation.

PASTE: When this button is pressed, the 
deleted or copied keyframe (during 
macro editing, macro event) is inserted 
after the current keyframe (during 
macro editing, macro event). Pressing 
this button while holding down the 
[SHIFT] button in the device control 
block inserts the deleted or copied 
keyframe (during macro editing, macro 
event) before the current keyframe 
(during macro editing, macro event).

UNDO: When this button is pressed, the 
last executed keyframe (during macro 
editing, macro event) insertion, 
modification, or deletion, or paste 
operation is canceled.
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d Duration setting buttons
KF DUR (keyframe duration): Press this 

button, turning it on, to set the 
keyframe duration of the selected 
keyframe, by numeric value entry from 
the numeric keypad control block.

EFF DUR (effect duration): Press this 
button, turning it on, to set the effect 
duration from the numeric keypad 
control block.

DELAY: Press this button, turning it on, to 
enter a delay value from the numeric 
keypad control block.

CONST DUR (constant duration): Select 
the duration mode. When this is lit, the 
mode is constant duration mode, and 
when off, variable duration mode.

e KF LOOP (keyframe loop) button
Press this button, turning it on, to execute 
the effect the specified number of times 
through the keyframes in the specified 
range.

f PAUSE button
When this button is pressed, a pause is 
applied to the selected keyframe.
When editing a macro, press this button, 
turning it on, to include a pause event in the 
macro. The pause length can be set in the 
numeric keypad control block.

g Effect execution section
RUN: When this button is pressed, the 

effect is run from the first keyframe to 
the last keyframe. However, if a pause 
is set on a keyframe, the effect stops at 
that point. Press this button again to 
resume execution, and continue to the 
next pause point or the end of the 
effect.

REWIND: When this button is pressed, the 
currently recalled effect is rewound to 
the first keyframe.

h Effect execution direction selection 
buttons

REV (reverse): When this button is off, 
effect execution runs from the first 
keyframe to the last keyframe. When 
this button is lit, effect execution runs 
from the last keyframe to the first 
keyframe.

NORM/REV (normal/reverse): Press this 
button, turning it on, to reverse the 
direction of the effect when it reaches 
the last keyframe or first keyframe.

i STOP NEXT KF (stop next 
keyframe) button

When this button is pressed, turning it on, 
the effect execution range is from the 
current time to the next keyframe.

j EFF LOOP (effect loop) button
When the effect reaches the last keyframe 
with this button on, it returns to the first 
keyframe and repeats.

k RUN CTRL (run control) button
When this button is on, you can execute 
keyframe effects without being affected by 
the STOP NEXT KF or EFF LOOP settings 
in the keyframe control block.
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Numeric Keypad Control Block

The numeric keypad control block is used 
for region selection, for saving and 
recalling snapshots, effects and shotboxes, 

for entering numeric values for trackball 
operation and keyframe operation, and for 
transition rate entry.

a Mode selection buttons
EFF (effect): Press to save or recall an 

effect.
SNAPSHOT: Press to save or recall a 

snapshot.
SHOTBOX: Press to save or recall a 

shotbox.
MCRO (macro): Press to save, recall or 

edit a macro.
TRANS RATE (transition rate): Press to 

set the transition rate. 
Hold down this button, and press one of 
the key row delegation buttons [KEY1] 
to [KEY4] in the cross-point control 

block to set an independent key 
transition rate.

b Region selection buttons
These select the functional block (“region”) 
of the control panel to which operations 
apply.
You can select more than one region at the 
same time.
The first button you press is taken as the 
reference region, and lights green, while the 
next pressed button lights amber.
With the exception of the [MASTER] and 
[ALL] buttons, you can change the region 
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assignment to the buttons as desired in the 
Setup menu.
MASTR: Press this, turning it on, to save 

region information in a master 
snapshot register or master timeline 
register, or to recall such region 
information.

ALL: Select all regions. When any region 
is already selected, pressing this button 
makes all regions unselected.

M/E 1 and P/P: Select the corresponding 
regions, M/E-1 and PGM/PST.

USER 1 to USER 8: Select the 
corresponding User regions.

P-Bus: Select the P-Bus region.
GPI: Select the GPI region.
RTR: Select the router region.
DEV1 to DEV12: Select the Device 1 to 

Device 12 regions respectively.
MCRO: Select the macro region.

c Function selection buttons
UNDO: After recalling a register, press this 

button to return to the state before 
recalling the register.

STORE STATS (store status): This lights 
amber when data is stored in a register. 
After saving data to a register, hold 
down this button and press the 
[UNDO] button to return the register to 
the state before the data was saved.

STORE: Press this button to switch to the 
mode for saving a snapshot, effect, 
shotbox or macro in a register.

RCALL (recall): Press this button to 
switch to the mode for recalling a 
snapshot, effect, shotbox or macro  
from a register.

[STORE] button or [RCALL] button 
flashes amber when one or more of the 
regions assigned to the Region selection 
buttons are not selected by the Region 
Select menu.

d Numeric keypad
In addition to the buttons for numeric input, 
this includes buttons for adding attributes to 
snapshots.
0 to 9: Used to input numeric digits.
. (period): Enters the decimal point.

When the [TRANS RATE] button is lit, 
enters “00.” When the [EFF] button, 
[SNAPSHOT] button or [SHOTBOX] 
button is lit, this is used to find an 
empty register.

+/–/ EFF DISS (effect dissolve): Invert the 
sign, negative or positive.
When the [SNAPSHOT] button is lit, 
applies the effect dissolve attribute to a 
snapshot.

CLR/AUTO TRANS (clear/auto 
transition): Clear an input value, 
returning to the previous state.
When the [SNAPSHOT] button is lit, 
applies the auto transition attribute to a 
snapshot.

TRIM/GPI ENBL (enable): After 
entering a difference value to be added 
to an existing setting, press this button 
to confirm the change.

ENTER: Confirm an entered value.

e Display
This shows the selected region name and 
entered numeric values.
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Auxiliary Bus Control Block

a AUX delegation buttons
Press one of these buttons, turning it on, to 
select the bus to assign to the key row of the 
bank selected with the bank selection 
buttons. These 10 buttons from left to right 
have ID numbers 1 to 10. When the 
[SHIFT] button is enabled, their ID 
numbers switch to 11 to 20. Pressing one of 
the buttons selects the bus assigned to the 
ID number. That is, you can select up to 20 
buses using these AUX delegation buttons 
in combination with the [SHIFT] button. 
The assignment of buses to the ID numbers 
can be done in a Setup menu.

For buses that can be selected, see “Bus 
Selection” (page 95).

For each bank, the key row is shared 
between the auxiliary bus control block and 
cross-point control block. Priority is given 
to the control block in which the delegation 
button is last pressed. When priority is 

given to the cross-point control block, all 
these buttons go off.

b Bank selection buttons
These select the bank for which the AUX 
delegation buttons are enabled.

c KEY button
While this button is held down, you can use 
the cross-point row of buttons to select key 
signals.

d SHIFT button
While this button is enabled, the AUX 
delegation buttons have the shifted ID 
numbers. In a Setup menu, you can select 
one of the following three modes for this 
button.
• The button takes effect while being held 

down.
• Every time the button is pressed, it 

toggles between the shifted and unshifted 
states for the AUX delegation buttons.
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• The button does not take effect even 
when pressed.

Menu Control Block

a Top menu selection buttons
These select the menu appearing in the 
menu display.
It is also possible to change the assignment 
of these buttons in setup.

For details, see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3).

b Menu display
This shows the menu currently in use.

c Knobs
These adjust the parameter values 
appearing in the menu.

d User preference buttons
These recall the functions or menus 
assigned to them in the Setup menu.
In the default setup, nothing is assigned to 
the [PREFS 1] to [PREFS 7] buttons.
It is also possible to change the assignment 
of these buttons in setup.

For details, see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3).

PREFS 8 button: When this button is on, 
control of an editor from the Remote1 
port on the rear panel of the switcher is 
possible. However, even when it is off, 
control of the Edit PVW bus is always 
possible.
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Memory Card/USB Adaptor Block

a Memory card slot
This slot accepts a PCMCIA Type II 
compliant memory card. You can use it in 
software installation, and for saving and 
reading in data, such as snapshot, keyframe, 
effect, and setup data.

b DEVICE connectors
This is a USB connector.
You can connect a device such as a mouse, 
keyboard, USB storage, and so on, that is 
equipped with a USB interface to any of 
these connectors.

For details on the devices that can be 
connected, consult your Sony 
representative.

c Memory card access indicator
This indicator lights when the memory card 
is accessed for reading or writing.

Note

When the indicator is lit, do not take out the 
memory card.

1 Memory card slot

2 DEVICE connector

3 Memory card access indicator
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“Memory Stick”/USB Connections Block

a “Memory Stick” status indicator
Lights in red during access to a “Memory 
Stick.”

Note

Do not power the unit off or remove a 
“Memory Stick” when the “Memory Stick” 
status indicator is lit.

b “Memory Stick” slot
Insert “Memory Sticks.” You can use it in 
software installation, and for saving and 
reading data, such as snapshot, keyframe, 
effect, and setup data.

See the next item, “Memory Sticks” for 
more information about the usable 
“Memory Sticks” and their handling.

c DEVICE connectors
There is a USB connector.
You can connect a device such as a mouse, 
keyboard, USB storage, and so on, that is 
equipped with a USB interface to any of 
these connectors.

For details on the devices that can be 
connected, consult your Sony 
representative.

d POWER A, B status indicators
The status indicators light in green when 
the unit is powered on.
The POWER B status indicator does not 
light when the optional HK-PSU11 Power 
Supply Unit is not supplied in the factory 
configuration.

About “Memory Sticks”

Usable “Memory Sticks”
This unit has been confirmed to operate 
with those of the following “Memory 
Sticks” that have a capacity of 8 GB 
(gigabytes) or less. However, operation 
with all “Memory Sticks” is not guaranteed.
• “Memory Stick”
• “Memory Stick PRO”
• “Memory Stick Duo”
• “Memory Stick PRO Duo”

Notes

• When using a “Memory Stick PRO,” 
high-rate data transfer using parallel 
interface is not supported.

• A “MagicGate Memory Stick” can also 
be used, but this system does not support 
the MagicGate function.

A POWER B

3 DEVICE connector2 “Memory Stick” slot

1 “Memory Stick” status indicator

4 POWER A, B status indicators
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• When using a “Memory Stick Duo,” be 
sure to use it with a “Memory Stick Duo 
Adaptor” (MSAC-M2 or equivalent). If 
you insert a “Memory Stick Duo” 
without using the adaptor, there is the 
possibility that the stick cannot be 
removed, resulting in a serious accident.

Handling “Memory Sticks”
When using “Memory Sticks,” pay 
attention to the following points.
• Do not touch the connector of the 

“Memory Stick” with anything, including 
your finger or metallic objects.

• Do not attach anything other than the 
supplied label to the “Memory Stick” 
labeling position.

• Attach the label so that it does not stick 
out beyond the labeling position.

• Carry and store the “Memory Stick” in its 
case.

• Do not strike, bend, or drop the “Memory 
Stick.”

• Do not disassemble or modify the 
“Memory Stick.”

• Do not allow the “Memory Stick” to get 
wet.

• Do not use or store the “Memory Stick” 
in a location that is:
– Extremely hot, such as in a car parked 

in the sun
– Under direct sunlight
– Very humid or subject to corrosive 

substances
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Key Control Block (MKS-8035 Key Control Module, 
Option)

Each of the M/E and PGM/PST banks 
includes four keyers (for keys 1 to 4), and 
you can delegate this control block to any 

desired keyer. In this control block, you can 
adjust and modify keys.

a Delegation buttons
Key delegation: Press one of the [KEY1] 

to [KEY4] buttons to delegate the key 

control block to the corresponding 
keyer.

M/E delegation: Press one of the [M/E 1] 
to [M/E 3], and [P/P] buttons to select 
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the bank (the M/E bank or PGM/PST 
bank) to which the key control block is 
delegated.

Notes

• When the MKS-9011 1M/E Control 
Panel is used, only the [P/P] is enabled. 
When the MKS-9012 2M/E Control 
Panel is used, only the [M/E-1] and [P/P] 
are enabled.

• With the MKS-9011/9012, you cannot 
directly control DME5 to DME8.

TRANS: By pressing this button, you can 
check the DME channel used for DME 
wipes on the M/E or PGM/PST bank. 
Also, by pressing this button, then 
pressing one of the DME channel 
selection buttons, you can preset the 
DME channel to be used when a DME 
wipe is selected as the transition type 
for the next transition.
When presetting the DME channel for 
an independent key transition, hold 
down this button, then press one of the 
[KEY1] to [KEY4] buttons, turning the 
two buttons on, beforehand.

b Key type selection buttons
Press one of these buttons, turning it on, to 
select the desired key type.
Depending on the selected key type, 
various parameters are displayed, and you 
can set the values with the knobs.
The following key types can be selected.
LUM: luminance key
LIN: linear key
CRK: chroma key
CVK: color vector key
PTN: key wipe pattern key

For details, see “Key Types” (page 138).

c Key fill/key source selection buttons
AUTO SEL (selection): Use the signal 

selected on the key fill bus, and the 

paired key source signal. The setting of 
key fill and key source pairs is carried 
out in a Setup menu.

SPLIT: To use the signal selected on the 
key fill bus as key fill, and a signal 
separate from the signal assigned in a 
pair with key fill for key source, press 
this button, turning it on.

To use the signal selected on the key fill bus 
as key source (self keying), press the 
[AUTO SEL] button and [SPLIT] button at 
the same time, so that both are off.
MATTE FILL: To use a color matte from 

the internal generator as key fill, press 
this button, turning it on. You can 
adjust the color matte using the knobs.
When this button is off, the signal 
selected on the key fill bus is used as 
key fill.

d Key modifier buttons
To add an edge modifier to the key, press 
one of these buttons, turning it on.
Depending on the edge type selected, 
parameters appear in the displays, and you 
can set the values with the knobs.
KEY DROP: When the selected edge type 

is “normal” and soft edge is not 
selected or when drop border or 
shadow is selected,  turning this button 
on lowers the key fill and key source 
position by four or eight scan lines as 
set in the key menu.
To select 4H or 8H, use the Key menu.
When the selected edge type is 
“normal” and soft edge is selected or 
when border, outline, or emboss is 
selected, this button lights 
automatically.

BDR (border): Apply a border of a 
uniform thickness to the whole key.

DROP BDR (drop border): Apply a 
border to two sides of the key (for 
example, below and to the right, or 
below and to the left).
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SHDW (shadow): Apply a shadow to two 
sides of the key (for example, below 
and to the right, or below and to the 
left).

OUTLINE: Use the outline of the key.
EMBOS (emboss): Apply an embossing 

effect to the periphery of the key.
• To select a “normal” as the edge type 

(that is, a plain edge), set all five of the 
above buttons off.

• When border, drop border, or shadow is 
selected, you can use a special color 
matte or a signal selected on the utility 1 
bus for the edge.

• When emboss is selected, you can use the 
dedicated color matte signal for the 
emboss function.

• When outline is selected, the signal 
selected on the key fill bus is used to fill 
the edge.

MAIN MASK: Press this button, turning it 
on, to enable the key mask using the 
main pattern. It also enables you to set 
the parameters with the knobs.

SUB MASK: Press this button, turning it 
on, to enable the key mask using the 
sub pattern. It also enables you to set 
the parameters with the knobs.

ZABTN (zabton): When this is pressed, 
turning it on, a translucent pattern is 
inserted behind the key. With the 
knobs, you can adjust the color, size, 
density, and softness parameters.

SOFT EDGE: Soften the edge of the key.

e MORE button
When there are more than four parameters, 
this button lights amber. When it is pressed, 
it changes from amber to green and the fifth 
and subsequent parameters are assigned to 
the knobs, allowing them to be adjusted.

f SHOW KEY button
While this button is held down, a key 
processed key source signal is output from 
the specified output port. You can make the 

output specification independently for each 
of edit preview and the preview of the M/E 
or PGM/PST bank in a Setup menu.

g Knobs
Turn the knobs to adjust the parameter 
values.

h Displays
Each display shows the initial letters of the 
parameter name and the parameter value 
(maximum three digits including a minus 
sign for a negative value).

i DME channel selection buttons
Press one of these buttons, turning it on, to 
assign a DME channel to the keyer. 
The number of valid DME channel 
selection buttons depends on the number of 
channels installed in the DME processor.
A maximum of four consecutively 
numbered DME channels from DME 1 to 4 
can be assigned to one keyer. 
A DME channel assigned to a keyer cannot 
be selected on another keyer. However, 
using the override function it is possible to 
allocate a channel already allocated to 
another keyer to the currently selected 
keyer. If DME channel allocations have 
been made in a Setup menu, these buttons 
cannot be used to make DME channel 
allocations. Using the trace function, it is 
possible to check which keyer a DME 
channel is allocated to.

j ON AIR indicators
These light red when the corresponding 
DME channels are included in the final 
program output.

k Output destination specification 
buttons

MON (DME monitor): Hold down this 
button and press the selection button 
for the DME channel you want to 
assign to the monitor output; you can 
57Names and Functions of Parts of the Control Panel



58

   C
hapter 2 

M
enus and C

ontrol P
anel
then monitor the output signal on the 
DME monitor output.
While this button is held down, the 
DME channel selection buttons light as 
follows, allowing you to check the 
monitor assignment.
Lit amber: DME channel that can 

currently be monitored
Lit green: DME channel currently 

assigned to the monitor output
FM FEED (frame memory feed): When 

you press this button, it lights 
momentarily amber, then for the 
currently selected keyer, the key 
processed signals are selected for frame 
memory sources 1 and 2. If a DME is 
selected on the currently selected 
keyer, the key fill and key source 
signals to which a DME effect is 
applied are assigned to frame memory 
sources 1 and 2; otherwise the key fill 
and key source signals are assigned.
Carrying out a frame memory feed 
causes the [PROC KEY] button to light 
amber.

PROC KEY (processed key): When this 
button is on, the key fill/source signal 
subjected to key processing or signal 
subjected to a DME effect on the 
currently selected keyer can be selected 
as a reentry signal (PROC V or PROC 
K) for the M/E or PGM/PST bank, on 
the auxiliary bus or the like.
If a DME is selected on the currently 
selected keyer, the key fill and key 
source signals to which a DME effect is 
applied are assigned; otherwise the key 
fill and key source are assigned.

l OVERRIDE button
To select a DME channel already allocated 
to another keyer or transition to the 
currently selected keyer (or transition), hold 
down this button, and press the DME 
channel selection button.

m TRACE button
When a DME channel is already allocated 
to another keyer or transition, hold down 
this button, and press the corresponding 
DME channel selection button, to switch to 
the state in which the keyer (or transition) to 
which the DME channel is allocated is 
currently selected.

n AUTO DELEG (auto delegation) 
button

When this button is on, the key delegation 
selection state of the key control block is 
linked to the next transition selection state 
of the transition control block.

o RESIZER button
Cannot be used.
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Device Control Block (MKS-8031TB Trackball Module, 
Option)

The device control block is used for three-
dimensional transform operations using a 
DME, for wipe pattern position setting, and 

for VTR/disk recorder or frame memory 
clip operations.

a Region selection buttons
The operation mode allocated to the device 
control block depends on the selection state 
of the region selection buttons.
When the [M/E 1], [M/E 2], [M/E 3], and 

[P/P] buttons are selected: This 
enables the wipe pattern position 
setting (positioner) operation mode in 
the device control block. You can 
select multiple buttons simultaneously.
When the MKS-9011 1M/E Control 
Panel is used, only the [P/P] is enabled. 
When the MKS-9012 2M/E Control 

Panel is used, only the [M/E-1] and [P/
P] are enabled.

When the [USER] button is selected: This 
enables pattern position setting used 
for color backgrounds.

When the [DME 1] to [DME 8] buttons 
are selected: This enables the three-
dimensional transform operation mode 
in the device control block.
Press a button, turning it on, to select a 
DME channel. You can select multiple 
buttons simultaneously.
The number of valid buttons depends 

DEVUSERM/E1

DME1

DME5

MENU

SHIFT

M/E2

DME2

DME6

ASP
PERS
SUB

AXIS
LOC
MAIN

LOCAL
K1

CB1

GLB
K2

CB2

CLR
WORK
BUFR

M/E3

DME3

DME7

X

P/P

DME4

DME8

Y Z CTR

RUN
CTRL

RSZR
CTRL

LOC
SIZE
ASP

LOC
XYZ
LOC

ROT
POS

RSZR

SRC
K3

TRGT
K4

1 Region selection buttons

3 Trackball

4 Z-ring2 Operating buttons

5 MENU button
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on the number of DME processor 
channels installed.
With the MKS-9011/9012 control 
panel, you cannot directly control 
DME5 to DME8.

When the [DEV] button is selected: This 
enables the VTR/disk recorder/frame 
memory operation mode in the device 
control block. Each button functions as 
follows.
(From upper left to right in the above 
figure)
[M/E1] to [M/E3]: DEV1 (device 1) to 

DEV3 (device 3)
[P/P]: DEV4 (device 4)
[USER]: FM1CLIP (frame memory 

clip 1)
[Unused]: FM2CLIP (frame memory 

clip 2)
[DME1] to [DME4]: DEV5 (device 5) 

to DEV8 (device 8)
[Unused]: FM LOOP (frame memory 

loop)
[DME5] to [DME8]: DEV9 (device 9) 

to DEV12 (device 12)
To exit from this mode, press the 
[DEV] button again, turning it off.

When the [RUN CTRL] button is 
selected: This enables the effect run 
control mode in the device control 
block.

[RSZR CTRL] button: Cannot be used.
The functions of the operation buttons, 
trackball, and Z-ring vary with the 
operation mode as follows.

b Operation buttons

When the positioner operation mode is 
enabled
K1 CB1: Press this button to enable wipe 

pattern position setting for key 1 
(DSK1).
When the [USER] button is selected, 
pattern position setting for color 
background 1 is enabled.

K2 CB2: Press this button to enable wipe 
pattern position setting for key 2 
(DSK2).
When the [USER] button is selected, 
pattern position setting is enabled for 
color background 2.

K3: Press this button to enable wipe pattern 
position setting for key 3 (DSK3).

K4: Press this button to enable wipe pattern 
position setting for key 4 (DSK4).

MAIN: Press this button to enable main 
wipe pattern position setting for normal 
transitions.

SUB: Press this button to enable sub wipe 
pattern position setting for normal 
transitions.

Among the [K1 CB1] button, [K2 CB2] 
button, [K3] button, [K4] button, [MAIN] 
button, and [SUB] button, you can select 
multiple buttons.

POS: Press this button to enable pattern 
movement in the x-axis and y-axis 
directions with the trackball.
When the [USER] button is selected, 
this enables the trackball to move the 
pattern in the x-axis and y-axis 
directions, and the Z-ring to adjust the 
size of the pattern.

X, Y: These restrict the axes affected by the 
trackball and Z-ring to the x- or y-axis. 

Z: This restricts the axes affected by the 
trackball and Z-ring to the z-axis.

CTR (center): When this button is pressed, 
the pattern position returns to the 
center. When the [USER] button is 
selected, the pattern size also returns to 
50.00.

SHIFT/CLR WORK BUFR: These are 
not used in positioner operation mode.
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When the three-dimensional transform 
operation mode is enabled
The Buttons are used for three-dimensional 
DME transformations.

For details, see “Basic Operations” in 
Chapter 11 (Volume 2).

When the VTR/disk recorder/frame 
memory operation mode is enabled
The Buttons are used for VTR control or 
playback of frame memory clips.

For details, see “Controlling the Tape/Disk 
Transport” in Chapter 12 (Volume 2).

c Trackball
When the positioner operation mode is 
enabled
By moving this, you can move the pattern 
in the x-axis and y-axis directions.

When the three-dimensional transform 
operation mode is enabled
Move the trackball to control the x- and y-
axes in a three-dimensional transform.
When the [SRC] or [TRGT] button is held 
down, the trackball operation is switched to 
a finer control. (fine mode)

d Z-ring 
When the positioner operation mode is 
enabled
When the [USER] button is selected, by 
turning the ring you can adjust the size of 
the pattern.

When the three-dimensional transform 
operation mode is enabled
Turn this ring to control the z-axis in a 
three-dimensional transform.
When the [SRC] or [TRGT] button is held 
down, the Z-ring operation is switched to a 
finer control. (fine mode)

When the effect run control mode is 
enabled

By turning the Z-ring, you can run the 
keyframe effect, independent of the STOP 
NEXT KF, EFF LOOP, and similar settings 
in the keyframe control block. Turn 
clockwise to run the effect in the normal 
direction, and counterclockwise for the 
reverse direction.

When the VTR/disk recorder/frame 
memory operation mode is enabled
Turning the Z-ring controls the tape 
transport/disk drive/frame memory clip 
operations, at a speed determined by the 
operating buttons. Turn clockwise for the 
normal direction, and counterclockwise for 
the reverse direction.

e MENU button
Press this button, turning it on, to enable 
adjusting the parameters allocated to the 
knobs in the menu using the trackball and 
Z-ring.
In the case of the DME menu, the operation 
applies to the selected DME channel.
In VTR/disk recorder/frame memory 
operation mode, press this button, setting it 
to On, to make it possible to carry out 
timeline start/stop point setting operation 
for the device selected with the device 
selection buttons (timeline setting mode).
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Device Control Block (MKS-8036A Search Dial Module, 
Option)

Using the device control block (MKS-
8036A search dial module 1), option), you 
can directly operate an XDCAM, disk 
recorder, VTR or other external device, 
frame memory clip, or shotbox. The device 

control block (MKS-8031TB track ball 
module, option) can be used together.

1) The product name of the MKS-8036A is “device 
control module,” but in this manual it is referred to 
as “search dial module” to distinguish it from the 
MKS-8031TB trackball module.

a Timecode display
This shows the current time (CURRENT) 
and the start and stop point timecode values 
for the current reference device (START 
TC, STOP TC). When you press a device 
selection button, the button lights, selecting 
the assigned device as the reference device, 
and displaying its setting value.
In the case of the [SBOX] buttons, the 
display does not change. The displayed 

setting value depends on whether the 
[TIMELINE] button is on or off, as follows.

When the [TIMELINE] button is on: 
Displays the start and stop points of the 
last set keyframe on the timeline. When 
the keyframe number is changed and 
the last register and keyframe change, 
the display also changes. (timeline 
setting mode)

TIME
LINE

DEV
1

CURRENT

START TC

STOP TC

DEV
2

DEV
3

DEV
4

DEV
5

DEV
6

FM1
CLIP

FM2
CLIP

SBOX
1

SBOX
2

SBOX
3

START
TC

STOP
TC

SET
START

TC

SET
STOP

TC

SET
DUR

STB
OFF

ALL
STOP

STOP

RECPLAY FFREWCUE

DELAY

SHTL JOG VAR ENBL

1 Timecode display

2 Device selection buttons

4 DELAY button

5 Editing 
buttons

6External device 
operation buttons

7 TIMELINE button

8 STOP button

9 Search dial

3 SBOX buttons
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When the [TIMELINE] button is off: 
Displays the Cueup & Play (rewind 
action) start and stop points.

b Device selection buttons
These buttons are used for selecting 
assigned external devices or frame memory 
clips. Each button can only be assigned to a 
single device. Carry out the assignment in 
the Setup menu (see “Overall Control 
Panel Settings (Config Menu)” in Chapter 
19 (Volume 3)). To select an assigned 
device, press the corresponding button, 
which lights green. To select more than one 
device simultaneously, hold down the 
button for the first selection, while pressing 
the buttons for the other selections in turn. 
The second and subsequent selected 
buttons light amber. If you press another 
button without holding down the first 
selected button, the second button will be 
the reference device and light green.
DEV: Assign external devices DEV1 to 

DEV12.
FM CLIP: Assign frame memory clips 

FM1 to FM8.
Device selection buttons can be set as 
SBOX buttons or DELAY button in the 
Setup menu.

c SBOX (shotbox) buttons
Assign a shotbox saved in registers 1 to 99. 
When you press a button, the assigned 
shotbox is selected, and executed. Carry out 
the assignment in the Setup menu (see 
“Overall Control Panel Settings (Config 
Menu)” in Chapter 19 (Volume 3)).
SBOX buttons can be set as device 
selection buttons or DELAY button in the 
Setup menu.

d DELAY button
When pressed, this button lights green, the 
numeric keypad control block display 
changes to DELAY__  :  , and you can set 
the start delay time for the selected device. 

The setting range is from 00:00 to 59:29 
(depends on the video format). This button 
goes off when another timecode setting 
button ([START TC], [STOP TC], [SET 
START TC], [SET STOP TC], or [SET 
DUR]) is pressed. 
The DELAY button can be set as a device 
selection button or an SBOX button in the 
Setup menu. Carry out the assignment in 
the Setup menu (see “Overall Control 
Panel Settings (Config Menu)” in Chapter 
19 (Volume 3)).

e Editing buttons
These carry out Cueup & Play (rewind 
action) operations on material, and timeline 
settings. These operations are only valid 
while a device is selected with the device 
selection buttons.
START TC: When pressed, this button 

flashes amber, and sounds a beep, 
setting the timecode at that time as the 
device start point (on the timeline when 
the [TIMELINE] button is On, and  
Cueup & Play start point when Off). If 
you press once more, the timecode at 
that time is overwritten as a new start 
point.

STOP TC: When pressed, this button 
flashes amber, and sounds a beep, 
setting the timecode at that time as the 
device stop point (on the timeline when 
the [TIMELINE] button is On, and 
Cueup & Play stop point when Off). If 
you press once more, the timecode at 
that time is overwritten as a new stop 
point.

SET START TC, SET STOP TC, SET 
DUR: When pressed, these buttons 
light green, “START TC”, “STOP TC” 
or “DUR” appears in the numeric 
keypad control block display, and you 
can enter a timecode from the numeric 
keypad. If you enter a numeric value 
and press the [ENTER] button, the 
button goes off, whereas if you press 
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the [ENTER] button without entering a 
numeric value the numeric keypad 
control block display shows 
“--:--:--:--”. To exit the numeric value 
entry mode, either repeat pressing the 
same button, or press a different 
numeric keypad control block linked 
button, or a mode selection button such 
as the [EFF] and [SNAPSHOT] 
buttons in the numeric keypad control 
block. If the timecode has been set 
correctly, the entered numeric value 
appears in the timecode display.

STB (standby) OFF: When pressed, this 
button flashes amber, and the device 
selected with the device selection 
buttons exits from the standby mode.
This button cannot be used for frame 
memory clip operations.

CUE: When pressed, this button flashes 
amber together with the [ALL STOP] 
button, and the device selected with the 
device selection button is cued up to the 
start point of the material. When more 
than one device is selected, the amber 
flashing continues until the reference 
device is cued up, and when the cueing 
up is finished, this button lights green.

REW: When pressed, this button lights 
amber, and material of the device 
selected with the device selection 
buttons is rewound. To stop during the 
rewind, press the [STOP] button or 
[ALL STOP] button.

PLAY: When pressed, this button lights 
amber, and the device selected with the 
device selection buttons plays. The 
playback stops not only if the [STOP] 
button is pressed, but also if any of the 
[STB OFF], [SHTL], [JOG], [CUE], 
[REW], [PLAY], [FF], and [ALL 
STOP] buttons is pressed. When the 
[VAR] button is pressed while the 
device is playing back, the device plays 

at one times normal speed in variable 
mode.

FF: When pressed, this button lights amber, 
and the material of the device selected 
with the device selection buttons is fast 
forwarded. To stop during the fast 
forward, press the [STOP] button or 
[ALL STOP] button.

ALL STOP: When pressed, all device 
material playback and other operations 
stop. During cueing up of any of the 
devices, this button flashes amber, and 
when all cueing up operations are 
completed, it lights green.

REC: When pressed simultaneously with 
the [PLAY] button, this button lights 
red (the [PLAY] button lights amber), 
and the image from the selected device 
is recorded.
This button cannot be used for frame 
memory clip operations.

f External device operation buttons
ENBL (enable): When this is pressed, 

turning it on, the search dial [VAR], 
[JOG], and [SHTL] button operations 
are enabled.

VAR (variable): Sets the search dial to 
variable mode.

JOG: Sets the search dial to jog mode.
SHTL (shuttle): Sets the search dial to 

shuttle mode.

g TIMELINE button
Press to switch the device selected with the 
device selection buttons to timeline setting 
mode.

h STOP button
When pressed, this lights amber, and 
operation of the device selected with the 
device selection buttons stops.

i Search dial
Use this for search and other operations on 
the material of an external device. 
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For details of the method of use, see 
“Controlling Tape/Disk Transport” in 
Chapter 12 (Volume 2).

Utility/Shotbox Control Block (MKS-8033 Utility/
Shotbox Module, Option)

a Bank selection buttons
Press any of the [BANK1] to [BANK4] 
buttons to select a bank of 24 memory recall 
buttons. The selected button lights amber.

b Memory recall buttons
You can use these buttons to recall 
frequently used menus, utility functions, 
shotbox registers, or macro registers that 
you have assigned.
When a utility function is allocated to a 
button, the button lights orange (or green 
depending on the status), and the allocated 
function name appears. Pressing the button 
executes the allocated function. When the 

function constitutes a switching on/off 
operation, the button lights green; 
otherwise, it only momentarily lights green.
When a shotbox register or macro register 
recall is assigned to a button, the button 
lights orange, and the assigned register 
name appears. (If the register is empty, the 
button goes off.) In the case of a shotbox 
function, pressing the button executes the 
assigned shotbox function, and the button 
lights yellow. In the case of a macro 
register, pressing the button executes the 
assigned macro, and the button flashes 
yellow.

1
BANK

1 2 3 4

7
BANK

2

BANK
3

BANK
4

5 6

8 9 10 11 12

13 14 15 16 17 18

19 20 21 22 23 24

1 Bank selection buttons

2 Memory recall buttons
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Downstream Key Control Block (MKS-8032 DSK Fader 
Module, Option)

a Key delegation buttons
Press one of the [DSK1] to [DSK4] buttons 
to delegate this control block to the 
corresponding keyer.
When the MKS-9012 2M/E Control Panel 
is used, it is possible to delegate this control 
block to key 1 to key 4 of the M/E bank 
using a Setup menu.

b Independent key transition type 
selection buttons

Press one of these buttons, turning it on, to 
select the downstream key transition type.

MIX: Carry out a dissolve with the key 
selected with the key delegation 
buttons.

WIPE: Carry out a wipe with the key 
selected with the key delegation 
buttons.

DME: This switches the key selected with 
the key delegation buttons, using a 
DME wipe.

CUT: Instantaneously insert or delete the 
key selected with the key delegation 
buttons.

SHIFT: When setting is made in the Setup 
menu to allow a different transition 
type for inserting or deleting a key, it is 

DSK1 DSK2 WIPEUNDO

DSK3 DSK4 SHIFT MIX

K-SS

CUT

DME

K-SS
STORE

DSK1
ON

DSK2
ON

DSK3
ON

DSK4
ON

TAKETAKETAKETAKE

1 Key delegation buttons

5 Key source name display/key snapshot
buttons

4 Key snapshot setting
buttons

3 Independent key transition execution section

2 Independent key transition type 
selection buttons
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
possible to display and set the 
transition after the next transition while 
this button is held down.

c Independent key transition 
execution section

DSK1 (downstream key 1) ON to DSK4 
ON buttons: Press these to 
instantaneously cut the downstream 
keys 1, 2, 3, and 4 in or, when the 
downstream keys are already inserted, 
cut them out. When the key 
corresponding to the button appears in 
the final program output, the button 
lights red, and otherwise lights amber.

TAKE buttons: These correspond to 
downstream keys 1, 2, 3, and 4 from 
left to right; press to execute an auto 
transition. The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

Fader lever: Move this to carry out a 
manual downstream key transition.

Transition indicator: This comprises 
multiple LEDs, which show the 
progress of the downstream key 
transition.

d Key snapshot setting buttons
K-SS (key snapshot): This enables key 

snapshot mode.
K-SS STORE (key snapshot store): To 

save a key snapshot, hold down this 
button, and press the key source name 
display/key snapshot button for the 
register you want to save.

UNDO (key snapshot recall undo): This 
undoes the last key snapshot recall.

e Key source name display/key 
snapshot buttons

These display the selected source name for 
each corresponding keyer. In snapshot 
mode, they correspond to registers 1 to 4 of 

the selected keyer, and pressing the button 
saves or recalls a key snapshot.
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Basic Menu Operations

Menu Organization

Operations on the DVS-9000 switcher 
system make frequent use of menu 
operations. This section describes the 
menus and their interrelationships.

Overview
All detailed settings for basic operations 
such as transitions, keys, DME, or wipes, 
are made in menus. There are also menus 
for carrying out general system control, 
managing setting data, and initial setup.

About the Top Menu List

When the control panel is powered on, the 
top menu list appears as shown below.
You can also display this by selecting VF1 
‘Top Menu List’ after pressing the [HOME] 
button at the upper left in the top menu 
selection button area of the menu control 
block.

To display the top menu
In the same way as for the top menu 
selection buttons in the menu control block, 
press each button to display the particular 
top menu in the menu display.
The top menu list button is the same as the 
default layout of the top menu selection 
buttons. However, even if the assignment of 
the top menu selection buttons is changed, 
this does not affect the top menu list.

To shut down the menus
Press the [Shutdown] button at the lower 
right.
This operation is the same as the shut down 
operation in the top menu window.

For details, see “Shutting down the menus” 
(page 86).
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Accessing Menus

You can use any of the following methods 
to access a menu, and the initially displayed 
menu page depends on the method used.
• Pressing a top menu selection button in 

the menu control block.
This displays the page you last accessed 
in the particular menu. After initially 
powering on the system, however, the 
page of VF1 - HF1 of the particular menu 
is always selected.

• Pressing a button other than a top menu 
button twice in rapid succession (see 
page 70).
Depending on the button, this may 

display a fixed page or the page selected 
last time you accessed the menu.

• Press the menu page selection button at 
the top left of the menu display.
The top menu window appears; press the 
top menu selection button for the 
particular menu, or enter the menu 
number with the numeric keypad, and 
press the Enter button.

For details of the VF buttons and HF 
buttons, see “Interpreting the Menu 
Screen” (page 75).

Menus accessed from a top menu selection button

Buttons Menus Function See

HOME Home Recalling menus using the top 
menu list or shortcut menu

Top menu list: page 68 Shortcut 
menu: page 88

M/E 1 M/E-1 Transition, keys, and wipe 
settings for the M/E-1 bank

page 112 (transitions), page 
139 (keys), page 191 (wipes)

P/P PGM/PST Transition, downstream key, and 
wipe settings for the PGM/PST 
bank

FRAME 
MEM

Frame Memory Frame memory settings page 261

COLOR 
BKGD

Color Bkgd Color background settings page 304

AUX/MON Aux/Mon AUX bus settings page 319

CCR CCR Color corrector settings page 327

COPY 
SWAP

Copy/Swap Copy and swap settings page 308

MISC Misc Safe title settings page 316

STATS Status Status display page 320

DME DME DME special effect settings Chapter 11 (Volume 2)

GLB EFF Global Effect Global effect settings Chapter 11 (Volume 2)

RTR Router Destination, source and level 
selections

page 321

DEV Device Settings for external device 
operation

Chapter 12 (Volume 2)
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Menus accessed by pressing a button twice
For relevant buttons other than the top 
menu selection buttons, pressing twice in 
rapid succession directly recalls a related 
menu page. The following table lists these 

buttons of each control block, together with 
the menus they recall. (XX represents the 
HF menu recalled last in the VF menu.)

MCRO Macro Macro register settings Chapter 16 (Volume 2)

KEY 
FRAME

Key Frame Keyframe settings Chapter 13 (Volume 2)

EFF Effect Keyframe effect register settings Chapter 13 (Volume 2)

SNAP 
SHOT

Snapshot Snapshot register settings Chapter 14 (Volume 2)

SHOTBOX Shotbox Shotbox register settings Chapter 15 (Volume 2)

FILE File File settings Chapter 17 (Volume 2)

ENG 
SETUP

Engineering Setup Setup functions Chapter 18 to Chapter 24 
(Volume 3)

DIAG Diagnosis Status information display Appendix (Volume 3)

Buttons Menus Function See

Cross-point control block

Buttons Menus See

FM1 to 8 signals assigned 
buttons

Frame Memory >Still >Recall page 271

Color Bkgd1 signal assigned 
button

Color Bkgd >Color Bkgd1 page 304

Color Bkgd2 signal assigned 
button

Color Bkgd >Color Bkgd2

CCR1 signal assigned button CCR >CCR1 >XX page 329

CCR2 signal assigned button CCR >CCR2 >XX

DME1 to DME4 DME >XX Chapter 11 
(Volume 2)

KEY1 to KEY4 (DSK1 to 
DSK4)

• M/E-1 >Key1, 2, 3, 4 >XX 
• PGM/PST >DSK1, 2, 3, 4 >XX

page 145
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a) The menu recalled depends on which of the M/E delegation buttons and key delegation buttons 
are selected in the key control block.

Transition control block

Buttons Menus See

KEY1 (DSK1) • M/E-1 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 145

KEY2 (DSK2) • M/E-1 >Key2 >XX 
• PGM/PST >DSK2 >XX

KEY3 (DSK3) • M/E-1 >Key3 >XX 
• PGM/PST >DSK3 >XX

KEY4 (DSK4) • M/E-1 >Key4 >XX 
• PGM/PST >DSK4 >XX

WIPE M/E-1, PGM/PST >Wipe >Main Pattern page 191

DME M/E-1, PGM/PST >DME Wipe >XX page 235

SUPER MIX M/E-1, PGM/PST >Misc >Transition page 113

PST COLOR MIX M/E-1, PGM/PST >Misc >Transition page 114

FM1&2 CLIP,
FM3&4 CLIP,
FM5&6 CLIP,
FM7&8 CLIP

M/E-1, 2, 3, PGM/PST >Misc >ClipTransition page 295

PRIOR SET M/E-1, PGM/PST >Misc >Key Priority page 109

KEY PRIOR M/E-1, PGM/PST >Misc >Next Key Priority page 110

Key control block a)

Buttons Menus See

KEY1 • M/E-1 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 145

KEY2 • M/E-1 > Key2 > XX 
• PGM/PST >DSK2 >XX

KEY3 • M/E-1 >Key3 >XX 
• PGM/PST >DSK3 >XX

KEY4 • M/E-1 >Key4 >XX 
• PGM/PST >DSK4 >XX

LUM • M/E-1 >Key1, 2, 3, 4 >Type 
• PGM/PST >DSK1, 2, 3, 4 >Type

page 146

LIN

CVK

PTN

CRK • M/E-1 >Key 1, 2, 3, 4 >Type >Chroma Adjust 
• PGM/PST >DSK1, 2, 3, 4 >Type >Chroma Adjust

page 151
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a) The menu recalled depends on which of the M/E-1 bank and PGM/PST bank the numeric 
control block is delegated to.

b) When other than [MASTR] is selected with the region selection buttons.
c) When [MASTR] is selected with the region selection buttons.
d) When the [SNAPSHOT] button or [EFF] button is set to On, or lit green.

a) The menu recalled depends on which of keyers 1 to 4 the downstream key control block is 
delegated to.

b) Recalling is possible only when the [K-SS] button is On.

Numeric keypad control block

Buttons Menus See

EFF • Effect >Effect 1-99 >XX b) 

• Effect >Master Timeline >Store c)

Chapter 13 
(Volume 2)

SNAPSHOT • Snapshot >Snapshot >XX b) 

• Snapshot >Master Snapshot >Store c)

Chapter 14 
(Volume 2)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15 
(Volume 2)

MCRO Macro >Register >XX Chapter 16 
(Volume 2)

TRANS RATE a) Misc >Transition page 120

STORE RCALL Key Frame >Region Select d) Chapter 13 
(Volume 2)

Downstream key control block a)

Buttons Menus See

DSK1 • M/E-1 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 145

DSK2 • M/E-1 >Key2 >XX 
• PGM/PST >DSK2 >XX

DSK3 • M/E-1 >Key3 >XX 
• PGM/PST >DSK3 >XX

DSK4 • M/E-1 >Key4 >XX 
• PGM/PST >DSK4 >XX

WIPE • M/E-1 >Key1, 2, 3, 4 >Transition >Wipe Adjust 
>Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select

page 216

DME • M/E-1 >Key1, 2, 3, 4 >Transition >Wipe Adjust 
>Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe 
Adjust >Pattern Select

page 246

K-SS STORE b) Snapshot >Key Snapshot  >XX Chapter 14 
(Volume 2)
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a) When the three-dimensional transformation operation mode is enabled.
b) When the [MENU] button is Off.
c) When the [MENU] button is On.

a) When the [TIMELINE] button is Off.
b) When the [TIMELINE] button is On.

Auxiliary bus control block

Buttons Menus See

FMS1, FMS2 Frame Memory >Still >Freeze/Store page 268

FM1 to 8 signals assigned 
buttons

Frame Memory >Still >Recall page 271

Color Bkgd1 signal assigned 
button

Color Bkgd >Color Bkgd1 page 304

Color Bkgd2 signal assigned 
button

Color Bkgd >Color Bkgd2

CCR1 signal assigned button CCR >CCR1 >XX page 327

CCR2 signal assigned button CCR >CCR2 >XX

Device control block (trackball)

Buttons Menus See

DME1 to DME4 a) DME >XX Chapter 11 
(Volume 2)

DEV1 to DEV12 assigned 
buttons

• Device >DDR/VTR >Cueup & Play b)

• Device >DDR/VTR >Timeline c)

Chapter 12 
(Volume 2)

FM1CLIP to FM8CLIP 
assigned buttons

Frame Memory >Clip >Recall page 285

Device control block (search dial)

Buttons Menus See

DEV1 to DEV12 • Device >DDR/VTR >Cueup & Play a) 

• Device >DDR/VTR >Timeline b)

Chapter 12 
(Volume 2)

FM1CLIP to FM8CLIP 
assigned buttons

Frame Memory >Clip >Recall page 285
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Displaying a Menu

To display, for example, the M/E-1 >Key1 
>Type menu, use either of the following 
operations.
• Press the top menu selection button [M/E 

1], then press the VF1 ‘Key1’ button and 
the HF1 ‘Type’ button in that order.

• Press the menu page number button in the 
upper left corner of the menu screen to 
display the top menu window, then enter 

the page number of the M/E-1 >Key1 
>Type menu, which is 1111, and press 
the [Enter] button. (For details of the 
menu page numbers, see  “Menu Tree” 
(page 373).)

The M/E-1 >Key1 >Type menu appears in 
the menu display as follows.

M/E-1 >Key1 >Type menu

2 Menu page number button

1 Menu title 
button

6 Function button area

7 Parameter group button

8 Knob 
parameter 
buttons3 VF buttons

4 HF buttons

9 Previous page button

5 Status area

0 Keyframe status

qa Default recall button

qs b (previous) button and B (next) 
button
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Interpreting the Menu 
Screen

The menu screen consists of the following 
principal parts.
When buttons on the screen are lit or 
represented in a depressed state, this 
indicates that the corresponding item or 
function is selected (set on).

a Menu title button
This shows the title of the menu screen.
You can set different colors for the main 
menu site and subsidiary menu site (see 
page 88).

b Menu page number button
This shows the menu screen page number. 
When you press this button, the top menu 
window (see page 85) appears. You can 
enter the page number for the desired menu, 
or press one of the top menu selection 
buttons in the window, to display that 
menu.
While the system is accessing the hard disk, 
the indicator lights red.

Note

When the indicator is lit, do not power off 
the switcher.

c VF buttons
These indicate the larger subdivisions of 
this menu.
Depending on the selected item, the menu 
screen contents including the HF button 
indications change.

d HF buttons
These indicate the items within the menu.
Depending on the selected item, the menu 
indications change.
Depending on the function, if any one is on, 
the status is shown by an orange bar, as in 
the following figure.

e Status area
This shows the status of the settings items 
controlled by the selected menu.
An orange frame appears around the 
parameter area relating to the displayed 
menu. For each of the twelve areas, 
pressing the display jumps to the related 
menu.

f Function button area
This shows the functions which can be 
operated in the currently selected menu by 
means of buttons.
Each function button corresponds to a 
function which can be set in the currently 
selected menu. Press it to enable the 
function, to display a parameter group and 
adjust the parameters with the knobs, or to 
execute the function.
These buttons are in groups by function. In 
the screen example shown on the previous 
page, the [Key Bus] and [Matte] function 
buttons constitute the <Key Fill> group.

g Parameter group button
This displays parameter group names for 
which the knobs can make adjustments, the 
current parameter setting page number, and 
the total number of the parameter setting 
pages. (Example: Color Vector 1/2)
When there are more than five parameters 
within the same parameter group, press this 
button to display the sixth and subsequent 

Indicator for internal hard 
disk

Indicator for frame 
memory external hard disk
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parameters, which can then be controlled 
by the knobs.

h Knob parameter buttons
These show the parameters currently 
controlled by the knobs and their values. 
Pressing one of these buttons displays the 
numeric keypad window (see page 83), and 
you can then enter a new value for the 
corresponding parameter with the numeric 
keypad.

i Previous page button
This shows the page number of the 
previously displayed menu screen. Press it 
to go back to that page. When the indication 
[Parent] appears, this displays the parent 
directory.

j Keyframe status
This shows the keyframe status of the 
reference region. Pressing this button 
switches the menu screen as follows.
When a menu other than the Key Frame 

menu is currently shown: The menu 
screen switches to the Key Frame 
menu.

When the Key Frame menu is currently 
shown: The menu screen switches to 
the menu that was on the screen 
immediately before the Key Frame 
menu.

In some parts of menus such as the File 
menu, this functions as a “Region selection 
area,” for selecting the region to which 
operations apply.

k Default recall button
This only appears in those menus for which 
the default recall function is available. (See 
“Menus allowing a return to default 
settings” (page 78).)
Press this button, turning it on, then press a 
VF button or knob parameter button to 
return the settings to their default values, in 
the following groupings.

• Function grouping: the functions within 
an HF menu under the VF button

• Knob parameters (parameters currently 
controlled by the knobs)

l b (previous) button and B (next) 
button

The b button returns to the previous menu. 
Press the B button to continue to the next 
menu.

Menu Operations

Selecting an item

1 Press the VF button (1 to 7) for the 
desired group of items.

The HF button (1 to 7) indications 
change to show the items within the 
selected group.

2 Press the HF button for the desired 
item.

The indications in the status area and 
function button area change, and you 
can now make various changes to the 
selected item.

Selecting a function
Press the appropriate function button within 
the function button area.

Shape and color of the button
Pressing the button turns it on, and it lights, 
showing the state.
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Lit pale blue: The function is enabled, and 
the parameters can currently be 
adjusted with the knobs.

Lit orange: The function is enabled.
Lit purple: Execution button. Pressing the 

button immediately executes the 
function. (Example: [Auto Start] 
button in the Chroma Adjust menu)

Pressing a button of this type displays a 
further menu, allowing more detailed 
settings. (Example: [Chroma Adjust] 
button in the Type menu)

Setting parameters

This marking on a function button indicates 
that there are parameters which can be 
adjusted with the knobs.
Pressing this function button assigns 
parameters to the knobs.
You can set the parameter values by either 
of the following methods.
• Turn the knob (1 to 5) corresponding to 

the parameter, to adjust the value.
• Press the knob parameter buttons (1 to 5) 

corresponding to the parameter. This 
displays the numeric keypad window 
allowing you to enter the desired value.

In the description of specific setting 
procedures, the knob adjustment is 
described, as follows.

Example: When wipe pattern key is selected

When the [MENU] button in the device 
control block is lit, you can use the trackball 
and Z-ring to control the parameters.
• Move the trackball on the x-axis to 

control the parameter for knob 1 or on the 
y-axis to control the parameter for knob 
2. Moving up or to the right increases the 
parameter value, and moving down or to 
the left decreases the parameter value.

• Use the Z-ring to adjust the parameter for 
knob 3. Turning clockwise increases the 
parameter value, and turning 
counterclockwise decreases the 
parameter value.

Going back to the previous menu
To return to the last displayed menu, press 
the previous page button.

Returning to default state in function 
groupings

1 Press the [Default Recall] button, 
turning it on.

This enters the menu default recall 
mode.

2 Press the VF button you want to return 
to the default state.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00
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This returns the settings within the 
function grouping to the default state, 
and the [Default Recall] button goes 
off.

Note

The default state of the settings depends on 
the setting of the initial status mode, set in 
the Setup menu of system setup, as follows.
User: The state when [Initial Status Define] 

is executed.
Factory: Factory default settings

Returning knob parameters to 
default state

1 Press the [Default Recall] button, 
turning it on.

This enters the menu default recall 
mode.

2 Press the knob parameter button you 
want to return to the default state.

This returns the knob parameter value 
to the default state, and the [Default 
Recall] button goes off.

Notes

• In the following table, “Menus allowing a 
return to default settings,” the default 
recall function does not apply to some 
knob parameters.

For details, see the table, “Knob 
parameters to which default recall does 
not apply” on page 80.

• The default recall function does not 
return the horizontal (H) and vertical (V) 
position settings to their default state 
individually. Returning the horizontal 
(H) position to its default state also 
returns the vertical (V) position to its 
default state automatically, and vice 
versa. For details, see the table, “Knob 
parameters subject to restriction on 
default recall” on page 82.

Menus allowing a return to default settings

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name

M/E1 VF1 1110-series Key1 a)

VF2 1120-series Key2 a)

VF3 1130-series Key3 a)

VF4 1140-series Key4 a)

VF5 1150-series Wipe a)

VF6 1160-series DME Wipe a)

VF7 1170-series Misc a)
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M/E2 VF1 1210-series Key1 a)

VF2 1220-series Key2 a)

VF3 1230-series Key3 a)

VF4 1240-series Key4 a)

VF5 1250-series Wipe a)

VF6 1260-series DME Wipe a)

VF7 1270-series Misc a)

M/E3 VF1 1310-series Key1 a)

VF2 1320-series Key2 a)

VF3 1330-series Key3 a)

VF4 1340-series Key4 a)

VF5 1350-series Wipe a)

VF6 1360-series DME Wipe a)

VF7 1370-series Misc a)

P/P VF1 1410-series DSK1 a)

VF2 1420-series DSK2 a)

VF3 1430-series DSK3 a)

VF4 1440-series DSK4 a)

VF5 1450-series Wipe a)

VF6 1460-series DME Wipe a)

VF7 1470-series Misc a)

COLOR BKGD VF1 2210 Color Bkgd 1 a)

VF2 2220 Color Bkgd 2 a)

CCR VF1 2410-series CCR1 a)

VF2 2420-series CCR2 a)

FRAME MEM VF1 2510-series Still b)

VF2 2520-series Clip b)

VF3 2530-series Reposition/Lock b)

VF4 2540-series File b)

VF5 2550-series Folder b)

AUX/MON VF1 2311 Aux Bus b)

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name
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a) Menu to return to the default settings for particular functions or for particular knob parameters 
(for the relevant knob parameters, see page 80)

b) Menu to return to the default settings for particular knob parameters (for the relevant knob 
parameters, see page 80)

DME VF1 4110-series Edge b)

VF2 4120-series Video Modify b)

VF3 4131 Freeze b)

VF4 4141 Non-Linear b)

VF5 4150-series Light/Trail b)

VF6 4160-series Input/Output b)

VF7 4170-series Enhanced Video 
Modify b)

GLB EFF VF1 4210-series Ch1–Ch4 b)

VF2 4220-series Ch5–Ch8 b)

KEY FRAME (HF3) 6113 Path b)

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name

Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter

1111 Type [Luminance] and [Linear] in 
<Key Type> group

4 Filter

[Color Vector] in <Key Type> 
group

1
2
(Parameter 
group [2/2])

Y Filter, 
C Filter

1111.1 Type >CRK Adjust [Key Active] 5 Filter

[Color Cancel] in <Color 
Cancel> group

5 Filter

1112.1 Edge >Matte [Mix Color] in <Edge Matte> 
group

5 Pattern

[Multi] 3 Invert Type

1113 Main Mask [Pattern] 5 Pattern

[Multi] 3 Invert Type
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a) The menu numbers shown by way of example are those for M/E-1: the same applies for M/E-2, 
M/E-3, and P/P. Also, content applying to Key1 applies equally to Key2, Key3, and Key4.

1116 Transition [Wipe] in <ON Transition Type> 
group

1

5 

Transition 
Rate
Pattern

[Wipe] in <OFF Transition Type> 
group

1

5 

Transition 
Rate
Pattern

[Key Blink] and [Edge Blink] in 
<Blink> group

1 Blink Rate

[Mix] in <Transition Type> group 1 Transition 
Type

[Wipe] in <Transition Type> 
group

1

5 

Transition 
Rate
Pattern

1116.1 Transition >
Wipe Adjust

[Multi] 3 Invert Type

[H] and [V] in <Pairing> group 1 Width

[H], [V], and [Fringe] in 
<Modulation> group

4 Shape

1154 Edge/Direction [Split] in <Edge> group 1 Split No

1154.1 Edge/Direction >
Matte Adjust

[Mix Color] in <Edge Matte> 
group

3 Pattern

[Multi] 3 Invert Type

1155 Main Modify [H] and [V] in <Pairing> group 1 Width

[H], [V], and [Fringe] in 
<Modulation> group

4 Shape

1164 Edge/Direction [Independent Trans Rate] in 
<Pattern Limit Release> group

1 Transition 
Rate

1171 Transition [Mix], [Nam], [Super Mix], 
[Preset Color Mix], [Wipe], [DME 
Wipe], and [FTB] in <Transition 
Type> group

1 Transition 
Rate

Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter
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a) The menu numbers shown by way of example are those for M/E-1: the same applies to M/E-2, 
M/E-3, and P/P. Equally, content applying to Key1 applies equally to Key2, Key3, and Key4.

b) The same applies to Color Bkgd2.
c) The menu numbers shown by way of example are those for CCR1: the same applies to CCR2.
d) The sample applies to Mask2 Adjust.

Knob parameters subject to restriction on default recall

Menu number Menu name Button name Knob Parameter

1111.1 a) Type >CRK Adjust [Sample Mark] in the <Auto> group 1
2

Position H
Position V

1112.1 a) Edge >Matte 
Adjust

[Position]

1113 a) Main Mask [Position]

1116.1 a) Transition >Wipe 
Adjust

[Position]

1116.3 a) Transition >DME 
Wipe Adjust

[Position] 1
2

H
V

1154.1 a) Edge Direction 
>Matte Adjust

[Position] 1
2

Position H
Position V

1155 a) Main Modify [Position] in the <Position> group

1155.1 a) Main Modify 
>Multi Adjust

[Position]

1156 a) Sub Modify [Position] in the <Position> group

1156.1 a) Sub Modify >Multi 
Adjust

[Position]

2122.2 Composite 
>Pattern Adjust

[Position] 1
2

Position H
Position V

2131 Reposition [Normal]

[Black&White]

2210 Color Bkgd1 b) [Position]

2412.1 c) Primary CCR 
>Mask1 Adjust d)

[Position]

4116 DME >Edge 
>Wipe Crop

[Position/Size] 5 Pattern

4127 DME >Video 
Modify >Mask

[Position/Size]
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Numeric keypad window

a Item display
This is the name of the parameter being set 
in the numeric keypad window.

b Max./min. (maximum/minimum) 
value indication

This shows the maximum and minimum 
settings of the parameter.

c Input value
This is the value being input into the 
numeric keypad window.

d Close button
This closes the numeric keypad window.

e TC (timecode) button
When the numeric keypad window is 
opened for a setting requiring a timecode 
value to be entered, this button appears in a 
depressed state.
You can enter a timecode value in the range 
that depends on the signal format (see 

“Setting the Signal Format (Format 
Menu)” in Chapter 18 (Volume 3)) as 
follows:

00:00:00:00 to 23:59:59:nn,
where nn = (number of frames per 
second) – 1.

f  – (minus) button
This toggles the sign of the entered value. 
When it is pressed, the value is negative.

g Clear button
This clears the input. It does not change the 
parameter setting.

h Trim button
After entering the difference from the 
current value, press this button to confirm 
the numeric input.

i Enter button
This confirms the entered value.
If correctly set, the numeric keypad 
window closes.
If not correctly set, the input display 
changes color.

1 Item display

2 Max./min. value indication

3 Input value

4 Close button

5 TC (timecode) 
button

6 – (minus) 
button

7 Clear button

8 Trim button

9 Enter button
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Keyboard window

Note

Except when changing source names, the 
following characters cannot be used. The 
same applies to macro file editing.

space, \, /, :, ;, , (comma), . (dot), <, >, 
*, ?, ", |

a Item display
This is the name of the parameter being set 
in the keyboard window.

b Input string
This is the character string being input in 
the keyboard window.

c Close button
This closes the keyboard window.

d BS button
This clears the character immediately 
before the cursor in the input string.

e Caps Lock button
This enables input of capital letters only.

Note

You can enter items to be displayed on the 
control panel LCD using lowercase letters, 
but these will be converted to capitals for 
display.

1 Item display 2 Input string

4 BS button

3 Close button

0 Left button

6 Shift button

5 Caps Lock button

7 Space button

8 Clear button

9 Del button

qa Right button

qs Enter button

qd Line feed
button
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MS-DOS does not distinguish case in 
filenames, and therefore you are 
recommended to enter filenames in capital 
letters.

f Shift button
This selects the characters on the shift side 
of the keys. The shift is released when you 
enter a character.

g Space button
This enters a space character.

h Clear button
This clears all of the characters in the input 
string.

i Del button
This clears the character immediately after 
the cursor in the input string.

j Left button
This moves the cursor one character to the 
left in the input string.

k Right button
This moves the cursor one character to the 
right in the input string.

l Enter button
This sets the input string as a parameter 
value, and closes the keyboard window if 
the value has been entered correctly. If the 
value has not been entered correctly, the 
display color changes.

m Line feed button
After pressing the Shift button, press this 
button to feed a line. The input string shows 
“|”.

Function of the top menu window

1 Top menu selection buttons

2 Input display

3 Numeric entry section

6 Close button

4 Clear button

5 Enter button

7 Shut down button

8 Add Favorite button
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a Top menu selection buttons
These are the same as the top menu 
selection buttons in the menu control block. 
Pressing one of these buttons closes the top 
menu window and displays the selected 
menu in the menu display.

b Input display
This shows the page number entered with 
the numeric entry section.

c Numeric entry section
Enter a page number.

d Clear button
Press this to clear the input display.

e Enter button
Pressing this button without entering a page 
number closes the top menu window with 
the current menu remaining in the menu 
display.
If you enter a page number then press this 
button, this confirms the value in the input 
display. If it is a correct page number, the 
top menu window closes, and the menu 
display shows the new menu. If it is not 
correctly set, the input display changes 
color.

f Close button
Press this to close the top menu window.

g Shut down button
Shuts down the menus.

Note 

Be sure to shut down the menus before 
powering off the control panel.

Shutting down the menus

1 In the menu screen, press the menu 
page number button to open the top 
menu window.

For details of the top menu window, see  
“Function of the top menu window” 
(page 85).

2 Press [Shut down].

A confirmation message appears.

3 Press [Yes].

This shuts down the menu system after 
a while, and the menu display changes 
to black. Now power off the system.

To restart menu operations
Power on the control panel once more.

h Add Favorite button
Pressing this button allows the currently 
displayed menu to be registered to the 
Shortcut menu.

Registering a menu to the 
Shortcut menu

1 In the Home >Favorites >Shortcut 
menu, select the desired group.

2 Display the menu you want to register, 
and then press the [Add Favorite] 
button.

The currently displayed menu is 
automatically registered to a blank 
button.
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Use of the color palette window
When a parameter is assigned to the knobs 
as a combination of luminance, saturation, 

and hue, pressing a knob parameter button 
displays a color palette window.

a Color palette buttons
Press one of these to enter the 
corresponding color in the display.
By default the following settings are 
available.
First row: white, yellow, cyan, green
Second row: magenta, red, blue, black
Third row: all black

b Operation buttons
Set: If you press any color palette button 

with this button held down, the color 
shown in the color display is assigned 
to the color palette button.

Copy: If you press a color palette button 
with this button held down, the color is 
used as the source for copying. Next 
press a different color palette button to 
copy to that button.

Swap: If you press two color palette 
buttons in sequence with this button 
held down, the two colors are swapped.

Default: If you press any color palette 
button with this button held down, the 
color palette button is set to the default 
color.

c Color display
This shows the setting color, and the 
parameters (LUM, SAT, and HUE).
By adjusting the parameters with the knobs, 
you can create any color.
If a parameter value is outside the permitted 
range for RGB (0 to 255), the indication 
“Illegal Color” appears, and this is adjusted 
to a value in range.
Cancel: Pressing this button returns to the 

state when the color palette window 
was opened.

1Color palette 
buttons

3Color display

4Numeric 
keypad

2Operation 
buttons
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d Numeric keypad
Use this to enter numeric values for 
parameters.

For details of use, see page 83.

Switching Between the 
Main Menu Site and 
Subsidiary Menu Site

For menu transitions, you can store two 
separate versions in the main and subsidiary 
menu sites.
By switching sites, and pressing the b 
button and the B button you can trace the 
history in each menu.

To switch the subsidiary menu 
site on and off
Assign [SUB MENU SITE] to a menu 
control block top menu selection button or 
user preference button. To switch to the 
subsidiary menu site, press this button, 
turning it on.

For details of the assignment operation, see 
“Assigning Functions to the Menu Control 
Block Top Menu and User Preference 
buttons” in Chapter 19 (Volume 3).

Shortcut Menu

Recalling a menu using the 
shortcut menu

1 In the Home menu, select VF2 
‘Favorites’ and HF1 ‘Shortcut.’

The following menu appears.

2 In the [Group Select] box, select the 
group.

The group buttons appear.

3 Press the button for the desired menu.

Creating a shortcut menu
Assign frequently used menus to buttons, to 
create a “Favorites” menu.

To create a menu group

1 In the Home menu, select VF2 
‘Favorites’ and HF1 ‘Shortcut.’

The following menu appears.

2 Press [Group Edit].

The following menu appears.
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3 With the cursor, select the group name 
(in this case a blank button) for the 
operation.

4 Press [Rename].

A keyboard window appears.

5 Enter a group name (maximum 24 
characters), and press Enter.

This confirms the group name.

To copy a menu group

1 In the Home >Favorites >Group Edit 
menu, press the button for the copy 
source group.

2 Press [Copy].

3 Press the button for the copy 
destination group.

4 Press [Paste].

This copies the menu group settings.

To delete menu group settings

1 In the Home >Favorites >Group Edit 
menu, select the group to be deleted.

2 Press [Clear].

A confirmation message appears.

3 Press [Yes].

This deletes the settings.

To register a menu on a button
You can register 15 buttons in one group.

1 In the Home >Favorites >Shortcut 
menu, press [Button Edit].

2 Move the cursor to the position where 
you want to display the button. To 
change the content of an already 
displayed button, press the button to 
select it.

3 Press [Page Set].

A page number input window appears.

4 Enter the page number for the menu 
you want to register.

5 Press [Rename].

A keyboard window appears.

6 Enter the button name (maximum 24 
characters).

Menu No.

Button name
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7 To change the button color, press 
[Color Set].

Button color samples appear.

8 Press the desired color.

This completes the assignment of the 
menu to the button.

9 Repeat steps 2 to 8 to complete the 
“Favorites” menu.

To copy button settings

1 In the Home >Favorites >Button Edit 
menu, press the copy source button to 
select it.

2 Press [Copy].

3 Press the copy destination button to 
select it.

4 Press [Paste].

This copies the button settings.

To delete button settings
In the Home >Favorites >Button Edit 
menu, press [Clear].
This deletes the button settings.

Note

The shortcut menu settings are handled as 
part of the control panel setup. You can 
recall and save them in the same way as 
setup data.
Basic Menu Operations
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Video Processing Flow

The switch from the current video stream (appearing on the corresponding 
program monitor) to a new video stream is referred to as a transition.
The following illustration shows the flow of operations for carrying out a 
transition on an M/E bank or the PGM/PST bank.
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Select next transition (page 101)

Make key settings (page 137)

Keys 1 to 4

Select new background video (page 94)

Select transition type (page 101)

Select current background video 
(page 94)

Background

Cut Mix Super 
mix

Preset color 
mix

Wipe DME wipe

Make wipe settings 
(page 191)

Make DME wipe settings
(page 235)

Preview the effect of transition (page 129)

Execute the transition (page 117)

NAM
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Signal Selection

You carry out signal selection with the cross-point buttons in the cross-point 
control block of the M/E bank or PGM/PST bank, and the buttons in the 
auxiliary bus control block.

Cross-point control block

Basics of Signal Selection

Each of the M/E bank and auxiliary bus control block has cross-point buttons 
which are identified by numbers common to the bank and block, and a signal 
is assigned to each number.
These buttons are identified by numbers common to all of the banks and block, 
and a signal is assigned to each number.

SHIFTUTIL2UTIL1DME4DME3DME2DME1DSK4DSK3DSK2DSK1
XPT

HOLD

Source name displays

Key row

XPT HOLD button

Key delegation buttons

Background A row

Background B row

SHIFT button

Cross-point buttons
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The basis of signal selection is to select, in a cross-point button row, the cross-
point button to which is assigned the desired signal.

Bus Selection

The key row is shared by multiple buses.
To assign a bus to the cross-point buttons in the auxiliary bus control block, 
press one of the AUX delegation buttons to select the bus. 

The following table illustrates the correspondence between buses and cross-
point button rows, and the delegation operations.

Bank Bus name Cross-point 
button row

Delegation operation

M/E-1 Background A bus Background A 
row

−

Background B bus Background B 
row

−

Key 1 bus Key row Turn on the [KEY1] button

Key 2 bus Turn on the [KEY2] button

Key 3 bus Turn on the [KEY3] button

Key 4 bus Turn on the [KEY4] button

PGM/PST Program bus Program row −

Preset bus Preset row −

DSK 1 bus DSK row Turn on the [DSK1] button

DSK 2 bus Turn on the [DSK2] button

DSK 3 bus Turn on the [DSK3] button

DSK 4 bus Turn on the [DSK4] button

M/E-1 PGM/
PST

Utility 1 bus Key row Turn on the [UTIL1] button

Utility 2 bus Turn on the [UTIL2] button

DME 1 video bus Turn on the [DME1] button a)

DME 2 video bus Turn on the [DME2] button a)

DME 3 video bus Turn on the [DME3] button a)

DME 4 video bus Turn on the [DME4] button a)
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a) To turn on the [DME1] to [DME4] buttons requires one of the [KEY1] to [KEY4] and [DSK1] 
to [DKS4] buttons to be on.

Signal Assignment and Selection

Assigning signals to buttons
Each cross-point button has a button number, to which you assign a signal.
In addition to the signals input to the PRIMARY INPUTS 1 to 80 connectors 
(1 to 34 connectors for the DVS-9000SF) on the rear panel of the switcher, you 
can also select signals generated within the switcher.

Auxiliary 
bus control 
block

AUX1 to AUX48 buses The key row of 
the bank selected 
with the bank 
selection buttons 
in the auxiliary 
bus control block

Turn on the appropriate 
buttons in accordance with 
the signal assignment made 
in the Setup menu.

MONITOR 1 to 
MONITOR 8 buses

Frame memory source 
1 and frame memory 
source 2 buses

DME 1 to DME 4 
video buses

DME 1 to DME 4 key 
buses

Edit preview bus

M/E-1 UTILITY 1 and 
M/E-1 UTILITY 2 
buses

P/P UTILITY 1 and P/
P UTILITY 2 buses

M/E-1 Key 1 fill to M/
E-1 Key 4 fill buses

M/E-1 Key 1 source to 
M/E-1 Key 4 source 
buses

DSK 1 fill to DSK 4 fill 
buses

DSK 1 source to DSK 
4 source buses

M/E-1 external DME 
bus

P/P external DME bus

DME UTILITY 1 and 
DME UTILITY 2 buses

Bank Bus name Cross-point 
button row

Delegation operation
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Each button has assigned to it a video signal and a key signal, forming a pair. 
You can set these video and key combinations in a Setup menu. 

For details of Setup menu operations, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 19 (Volume 3).

Cross-point button control block button numbers
On the M/E and PGM/PST banks, each cross-point button has two button 
numbers, and you use the [SHIFT] button to switch between these numbers.
The button numbers are as follows.
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Inhibiting cross-point button operations
For each cross-point button, you can temporarily inhibit operations. 

Note

This setting is cleared when you reset the control panel. 

SHIFTUTIL2UTIL1DME4DME3DME2DME1KEY4KEY3KEY2KEY1
XPT

HOLD

1 2 3 4 5 6 7 8 9 10 11 12

13 14 15 16 17 18 19 20 21 22 23 24

SHIFTUTIL2UTIL1DME4DME3DME2DME1KEY4KEY3KEY2KEY1
XPT

HOLD

1 2 3 4 5 6 7 8 9 10 11

12 13 14 15 16 17 18 19 20 21 22

Button numbers when all 12 buttons are used as cross-point buttons.

When the SHIFT button is off:
When the SHIFT button is on:

SHIFT button

When the SHIFT button is off:
When the SHIFT button is on:

Button numbers when the rightmost buttons (12th buttons) are used as SHIFT buttons.

SHIFT button

SHIFT buttons
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Assigning a button to the function of disabling cross-point button 
operation
You can assign the button to be used for the operation to a user preference 
button, in setup. The [Inhibit All Clear] function is also assigned to this button. 
(See “Setting Button Assignments (Prefs/Utility menu)” in Chapter 19 (Volume 
3).)

Buses for which operations can be inhibited
This setting applies to the auxiliary bus control block and the cross-point 
buttons in each switcher bank.

For example, if you make the setting for one cross-point button in a switcher 
bank, this inhibits operation of all cross-point buttons with the same number in 
the following buses. 
The corresponding name also disappears from the source name display. 
• Background A, background B
• Keys 1 to 4
• Utility 1, Utility 2
• DME utility 1, DME utility 2
• External DME

To inhibit operation of a cross-point button
Hold down the button which “Inhibit Set” is assigned, and press the cross-point 
button whose operation you want to inhibit. 
The button you pressed flashes amber, and this makes the operation inhibited. 

Note

Even when you inhibit operation of a cross-point button, macro attachment 
settings are still possible (see “Setting and Canceling a Macro Attachment” in 
Chapter 16 (Volume 2)). 

To clear a cross-point button operation inhibit setting
Hold down the button to which “Inhibit Set” is assigned, and press the button 
whose operation is inhibited (flashing amber). 
This clears the operation inhibit setting for the button you pressed. 

To clear all operation inhibit settings
Press the button to which “Inhibit Set” is assigned and the button to which 
“Inhibit All Clear” is assigned simultaneously. 

Selection of signals linked with the audio mixer
When you select a signal in a switcher bank background A row or AUX bus 
control block which is set to be linked with the audio mixer, the program output 
of the audio mixer follows the signal selection.
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For details of the setting, see “Cross-Point Settings (Xpt Assign menu)” in 
Chapter 19 (Volume 3). 

Notes

• For details of audio mixers that can be connected, contact your Sony service 
or sales representative. 

• When the signal is switched with a snapshot, keyframe, and so on, the audio 
mixer is not linked. 

• When bus fixed mode is selected in setup (see page 126), the audio mixer 
program output is linked to the bus output as the background. 

Signal Name Display

You can attach a name (source name) to each signal assigned to a cross-point 
button, with a maximum of 16 characters.

• The source name displays in the cross-point control block and auxiliary bus 
control block show the source names of the video signals assigned to 
numbers 1 to 12 (or 11).

• To display the source names for shifted numbers (13 to 24 or 12 to 22), press 
the [SHIFT] button to the right of the key row delegation buttons.

• To display the source names of the key signals assigned to button numbers, 
hold down one of the key delegation buttons [KEY1] to [KEY4] or [DSK1] 
to [DSK4] buttons or, for the auxiliary bus control block, hold down the 
[KEY] button.

Colors of lit cross-point buttons
In a particular row of cross-point buttons, only the last pressed button is 
effective, and lights amber or red. The amber indicates the “low tally” state, 
and the red indicates the “high tally” state, to indicate whether or not the 
selected signal appears in the final output video.

Significance of colors of lit cross-point buttons

Color State Significance

Amber Low tally Does not appear in final output video

Red High tally Appears in final output video
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Transitions

Selecting the Next Transition

To execute a transition, it is first necessary to decide how the image will be 
changed as a result of the transition. This selection is carried out using the next 
transition selection buttons (see page 39) in the transition control block of each 
M/E or PGM/PST bank.

For details of operations, see “Procedure for Basic Transition Operation” 
(page 104).

Transition Types

Selecting the transition type determines the way in which the transition occurs.
Carry out the type selection with the transition type selection buttons in the 
transition control block of each M/E or PGM/PST bank.

For details of this operation, see “Procedure for Basic Transition Operation” 
(page 104).

The following are the transition types.

Mix
This is a dissolve, in which the new video progressively fades in over the 
current video, with the sum of the two video outputs maintained constant. At 
the mid-point of the transition (when the fader lever is in the center position), 
the output of each is 50%.
This transition type can also be selected for an independent key transition. In 
this case, the key either dissolves in or dissolves out similarly, with the 
progress of the transition.

NAM (non-additive mix)
In this dissolve, the current video and new video signals are compared, and the 
signal with the higher luminance level is given priority in the output. The 
current video is maintained at 100% output for the first half of the transition as 
the new video increases progressively to 100%, then the current video is 
progressively reduced from 100% to zero in the second half with the new video 
maintained at 100% output.
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Note 

This transition type is not available for an independent key transition.

Super mix
In this dissolve, the current video is maintained at 100% output for the first half 
of the transition as the new video is mixed while increasing progressively to 
100%, then the current video is progressively reduced from 100% to zero in the 
second half with the new video maintained at 100% output.

For details on super mix settings, see page 113.

Note 

This transition type is not available for an independent key transition.

Preset color mix
This is a two-stage dissolve, comprising two transitions, the first a dissolve to 
a color matte, and the second from the color matte to the new video.
In the first transition, the current video is replaced by the color matte in a mix 
(dissolve), then in the second transition the color matte is replaced by the new 
video also in a mix (dissolve). 

For details on color matte settings, see page 114.

Note 

This transition type is not available for an independent key transition.

Wipe
A wipe replaces the current video by the new video according to a 
predetermined pattern. This transition type can also be selected for an 
independent key transition.

For details, see “Wipes” (page 23) and Chapter 5 “Wipes” (page 189).

DME wipe
Using a DME effect, it is possible to obtain a transition to a new image from 
the current image, as in a wipe. You can also use this transition type as an 
independent key transition.
Transitions
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Note

To carry out DME wipes requires the BKDS-9470 DME Board Set or the 
MVE-8000A/9000 Multi Format DME Processor.

For details, see “DME Wipes” (page 23) and Chapter 6 “DME Wipes” (page 
223).

Clip transitions
Linked to a mix (dissolve) or wipe transition, a frame memory clip (movie) is 
played back. 

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.
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Procedure for Basic Transition Operation

The positions of the principal buttons used for basic transition operation are as 
follows.

Transition control block

1 In the cross-point control block, select the background video with the 
background A row of cross-point buttons.

2 Select the way in which the transition will affect the image, using the next 
transition selection buttons in the transition control block.

For an overview, see “Selecting the Next Transition” (page 101).

To change the background: Press the [BKGD] button, turning it on.
To insert or delete a key: Press one of the [KEY1] to [KEY4] buttons (or 

[DSK1] to [DSK4] buttons in the PGM/PST bank), turning it on.
To enable the key priority setting, which determines the key overlay 

order after the transition: Press the [KEY PRIOR] button, turning it 
on.

You can press more than one button at the same time.
To change the keys and background presets in Setup menus 

simultaneously: Press the [ALL] button.

To allocate a particular next transition button to the [ALL] button 
function, see “Operation Settings (Operation Menu)” in Chapter 19 
(Volume 3).

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

Next transition 
selection buttons

Transition type 
selection buttons

Transition execution 
section
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3 For the transition to change the key priority, set the priority for after the 

transition.

For details of the key priority setting operation, see “Key Priority Setting” 
(page 107).

4 Select the new video used for the transition.

• In the background B row of cross-point buttons, select the new 
background video.

• When inserting a key, select the key signal, and make any required 
settings.

For details of key settings, see Chapter 4 “Keys” (page 137).

To carry out a cut transition, skip to step 7; otherwise continue to step 5.

5 Select one of the transition type selection buttons in the transition control 
block.

To carry out a dissolve to the new video: Press one of the [MIX], 
[NAM], [SUPER MIX], and [PST COLOR MIX] buttons, turning it 
on.

To carry out a wipe: Press the [WIPE] or [DME] button, turning it on.
To carry out a transition while playing back a frame memory clip: 

Press one of the buttons corresponding to the clip to be used 
(FM1&2CLIP, FM3&4CLIP, FM5&6CLIP, and FM7&8CLIP).

You can also use the Misc  >Transition menu to select a desired transition 
type for the M/E or PGM/PST bank. (See “Selecting the Transition Type 
by a Menu Operation” (page 112).)

For an overview of the transition types, see “Transition Types” (page 
101).

Note

The transition type selection buttons in the transition control block can be 
interchanged in the setup menu.

For details, see “Overall Control Panel Settings (Config Menu)” in 
Chapter 19 (Volume 3).

6 Make the required settings, according to the selected transition type.

For details of the settings, see the relevant section.

Super mix: “Super Mix Settings” (page 113)
Preset color mix: “Color Matte Settings” (page 114)
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Wipe: “Basic Procedure for Wipe Settings” (page 191)
DME Wipe: “Basic Procedure for DME Wipe Settings” (page 235)
Clip transition: “Clip Transition Operations” (page 295)
Using the transition preview function (page 129), you can check the 
transition on the preview monitor.

7 Carry out the transition in the transition execution section.

For a gradual transition such as a mix (dissolve) or wipe: Press the 
[AUTO TRANS] button, or operate the fader lever.
To execute a transition by pressing the [AUTO TRANS] button, first 
set the transition rate (specified as the duration of the transition).
 (See “Setting the Transition Rate” (page 118).)
When you have selected a wipe or DME wipe as the transition type, 
you can also set the transition range. (See “Pattern Limit” (page 120).)

For an instantaneous transition: Press the [CUT] button.

For details, see “Executing a Transition” (page 117).

Transition linked to the audio mixer
If the video signal selected in the background B row is linked to the audio mixer 
in setup, then the audio mixer sound changes with the transition. That is, 
pressing the [AUTO TRANS] button gives a cross fade, and pressing the 
[CUT] button gives an instantaneous sound switch.

For details of setup, see “Cross-Point Settings (Xpt Assign Menu)” in Chapter 
19 (Volume 3).

Notes

• The audio mixer is not linked to a snapshot or key frame transition.
• The audio mixer is not linked to a transition using the fader lever.
• If the bus-fixed mode (see page 126) is selected in the setup menu, and the 

fader lever is in the lowest position, there is a cross fade from the audio 
selected on the B row to the audio selected on the A row.

• The audio mixer is not linked to a key transition.
• In the following cases, the audio and video may be out of sync.

– When carrying out a cross fade in some DME wipes (for example, “picture 
in picture”)

– When executing a preset color mix in two-stroke mode
• For details of audio mixers that can be used, Sony service or sales 

representative.
Procedure for Basic Transition Operation
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Key Priority Setting

Selecting the key priority
If a number of keys are already inserted in the current video, you can check or 
change the key priority, that is to say, the order in which the keys are overlaid.
When a key priority ([KEY PRIOR]) is selected as the next transition, you can 
also change the key priority in the new video.

The key priority values go from 1 to 4, with a higher priority key being “in 
front” as seen on the screen.

Priority sequence on the screen

There are two ways of setting the priority: either using the [PRIOR SET] button 
in the transition control block, or using the Misc menu to access the Key 
Priority menu for the M/E or PGM/PST bank.

Note 

When the operating mode is set to multi program, the key priority setting 
cannot be made.

Setting the Key Priority in the Transition Control Block

The positions of the buttons used for the operation are as follows.

4
3

2
1
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Transition control block

Changing the currently inserted key priority

1 If the next transition selection button [KEY PRIOR] is on, press another 
next transition selection button to turn the [KEY PRIOR] button off.

(When the [KEY PRIOR] button is on, the transition control block 
switches to the mode for changing the key priority for after the transition.)

2 Holding down the [PRIOR SET] button, press the one of the next transition 
selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] buttons in the 
PGM/PST bank) for the key to appear on top.

The selected key now appears on top, on the program monitor.
The priority of keys other than the selected one does not change.

To change the priority of more than one key, repeat this operation as 
required.

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

Next transition 
selection buttons

KEY PRIOR button

PRIOR SET button

Key 1 selected.

Key priority: 3, 1, 4, 2 Key priority: 1, 3, 4, 2
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Changing the key priority for after the transition

When executing a transition, turning on the next transition selection button 
[KEY PRIOR] causes the keys to be rearranged based on the set priority.
To set the key priority for after the transition, use the following procedure.

1 In the transition control block, hold down the [PRIOR SET] button and 
press the [KEY PRIOR] button to turn it on. Do not release the [PRIOR 
SET] button before advancing to step 2.

The [KEY PRIOR] button lights green, and it becomes possible to change 
the key priority setting for after the transition.

2 Hold down the [PRIOR SET] button, and press the one of the next 
transition selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] 
buttons in the PGM/PST bank) for the key you want to bring to the front 
after the transition.

To set the priority to be the same as before the transition, press the [BKGD] 
button.

Note

The [BKGD] button is only effective when in the mode for changing the 
key priority for after the transition. 

When the next transition selection button [KEY PRIOR] is on, the selected 
key appears on top on the preview monitor. The priority of keys other than 
the selected one does not change.

3 To change the priority of more than one key, repeat the previous operation 
as required.

4 Execute the transition.

The keys are rearranged based on the set priority.

Setting the Key Priority by a Menu Operation

Changing the priority of the currently inserted keys

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF3 ‘Key 
Priority.’

The Key Priority menu appears.
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2 For each of <Priority1>, <Priority2>, <Priority3>, and <Priority4>, select 
a key, to determine the key priority sequence.

The keys are inserted in the key priority sequence with priority 1 at the 
front.

Note

It is not possible to select the same key for two or more priority numbers.

The keys appear in the set order on the program monitor.

Changing the key priority for after the transition

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF4 ‘Next 
Key Priority.’

The Next Key Priority menu appears.

2 For each of <Priority1>, <Priority2>, <Priority3>, and <Priority4>, select 
a key, to determine the key priority sequence.

For details of the key priority sequence, see the figure shown for step 2 in 
the previous item (see page 110).

The keys appear in the set order on the preview monitor.

3 Execute the transition.

The keys are rearranged in the set order on the program monitor.

1
2

3
4

Priority 1

Priority 2

Priority 3

Priority 4
Key Priority Setting
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Display of the Key Output Status and Key Priority

You can check whether keys are currently output, and the key priority setting, 
using the key status display in the transition control block of the M/E or PGM/
PST bank.
The display is above the next transition selection buttons [KEY1] to [KEY4] 
([DSK1] to [DSK4] buttons in the PGM/PST bank).

Display of the key output status
When a key is included in the output from the M/E or PGM/PST bank, the 
corresponding ON indicator lights.

Key priority display
The key priority is indicated by numerals 1 to 4 lighting.
The topmost key as seen on the program monitor is priority 1, and the keys 
underneath are numbered 2, 3, 4 away from the viewer (see page 110).
To display the key priority for after the transition, press the [KEY PRIOR] 
button in the transition control block, turning it on. For keys for which the 
priority after the transition is different from the current priority, the 
corresponding numerals 1 to 4 flash. For a key with the same priority, the 
indication remains on.
Example key status display given when the [KEY PRIOR] button is pressed:
Current key priority: 1, 2, 3, 4
Key priority after the transition: 3, 2, 1, 4
Indicators: 1, 3 (flashing), 2, 1 (flashing), 3, 4

Example key status display (showing the key priority after the transition)

BKGD KEY1 KEY2 KEY3 KEY4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

Lit

Flashing Flashing

LitLit

Lit
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Selecting the Transition Type by a Menu 
Operation

You can also select the required transition type by a menu operation.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select the required transition type in the <Transition Type> group.

The parameter settings can now be adjusted with the knobs according to 
the selected transition type.

For details, see the following.
• “Super Mix Settings” (page 113)
• “Color Matte Settings” (page 114)
• “Setting the Transition Rate” (page 118)

Note

When multi-program mode is selected in the Setup menu (see “Settings for 
Switcher Configuration (Config Menu)” in Chapter 20 (Volume 3)), there 
may be cases in which two or more transition types have been selected.
Selecting the Transition Type by a Menu Operation
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Super Mix Settings

You can set the output levels of the current and new video signals at the mid-
point of the transition, in the range 0 to 100%. 

Note

This transition type is not available for an independent key transition.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Super Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the output levels.

Knob Parameter Adjustment Setting values

2 A Gain Background A output level 0.00 to 100.00% 

3 B Gain Background B output level 0.00 to 100.00% 
113Super Mix Settings
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Color Matte Settings

You can specify the color matte by luminance, saturation, and hue values.

Notes

• This transition type is not available for an independent key transition.
• In the multi-program mode, you can use a preset color mix only when 

selecting the background for the next transition.

One-stroke mode and one-time mode
• You can make a setting such that a preset color mix is carried out in a single 

transition. This is called “one-stroke mode.”
When the bus fixed mode is selected with a Setup menu setting, a preset color 
mix is always carried out in the one-stroke mode.

• You can also make a setting such that when a preset color mix is completed, 
the next transition switches to the previous transition type automatically. 
This is called “one-time mode.”

When only the background is changed

Preset color mix (changing background only)

Current video Color matte New video
Color Matte Settings
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When a key is inserted

Preset color mix (transition including key)

By means of a Setup menu setting, it is possible to preserve the key state while 
carrying out the color matte mix.

When, with a key inserted, a key is selected in the next transition

Preset color mix (when set to preserve key state)

Setting the color matte

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Preset Color Mix] in the <Transition Type> group.

3 In the <Preset Color Mix Fill> group, select one of the following.

Flat Color: monochrome color matte
Utility 2 Bus: signal selected on the utility 2 bus

4 When “Flat Color” is selected, turn the knobs to adjust the color matte.

Key fades out

Key

When a key is 
selected as the next 
transition

When no key is selected

Key fades in

Key

Key state preserved
Key gradually 
removed

Knob Parameter Adjustment Setting values

2 Luminance Luminance 0.00 to 100.00
115Color Matte Settings



116

   C
hapter 3 

S
ignal S

election and Transitions
3 Saturation Saturation 0.00 to 100.00

4 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values
Color Matte Settings
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Executing a Transition

There are two modes of executing a transition: an auto transition by button 
operation or a manual transition using the fader lever.
It is also possible to combine both methods, taking control with the fader lever 
of an auto transition which has partly completed, or complete a transition 
started with the fader lever as an auto transition.
By combining common transitions with independent key transitions, different 
transition types can be applied to the background and keys, for example 
allowing a key wipe combined with a background dissolve. 
When the audio mixer is linked in setup, you can carry out an auto transition, 
and also switch the sound with the audio mixer. (See “Transition linked to the 
audio mixer” (page 106).)

Transition Indicator Function

In each of the M/E banks and PGM/PST bank, to the left of the fader lever is a 
transition indicator composed of multiple LEDs. This indicator shows the state 
of the transition, whether auto or manual, by which LEDs are lit.

Transition indicator

Lit
117Executing a Transition
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For example, in the previous illustration, it can be seen that the transition is 
more than half completed.
When the transition is completed, all of the LEDs go off.

Setting the Transition Rate

There are two ways of setting the transition rate: using the numeric keypad 
control block to enter a numeric value, or using the Misc menu to access the 
Transition menu for the M/E or PGM/PST bank.
You can also display the transition rate and independent key transition rate for 
each of the M/E and PGM/PST banks, and change the settings. (See 
“Displaying a List of Transition Rates and Changing the Settings” (page 
317).)

Note

When a clip transition is selected as the transition type, it is not possible to set 
the transition rate.

Frame input mode and timecode input mode
For numeric input of the transition rate value, there are two modes: frame input 
mode and timecode input mode. The frame input mode is selected 
automatically when the frame display mode is selected. The timecode input 
mode is selected automatically when the timecode display mode is selected.
Frame input mode: The entered value is a number of frames.

Example: Entering 123 constitutes an entry of 123 frames
Timecode input mode: The entered value is a timecode value.

Example: Entering 123 constitutes an entry of 1 second 23 frames.

Note

Whereas you can enter a value of up to 999 in frame input mode, a value not 
smaller than 10 seconds cannot be entered in timecode input mode.

Frame display mode and timecode display mode
For the transition rate display in the transition control block, there are two 
modes: frame display mode and timecode display mode. You can select one of 
these modes in setup. (See “Operation Settings (Operation Menu)” in Chapter 
19 (Volume 3).)

Note

The setting is common to all banks of the switcher.
Executing a Transition
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Frame display mode: Values are shown as from 0 to 999 frames. In this 

display mode, a value entered in timecode input mode is converted for 
display as a number of frames.

Timecode display mode: Values are shown as timecode values, consisting of 
seconds and frames. In this display mode, a value entered in frame input 
mode is converted for display as a timecode value. If the value consists of 
four or more digits, the last digit is not shown.
Example: A value of 9 seconds 23 frames appears as “9.23” and a value 

of 10 seconds 1 frame appears as “10.0.”

Setting the transition rate in the numeric keypad control block

Numeric keypad control block

1 In the numeric keypad control block, press the [TRANS RATE] button.

2 Press the region selection button for the M/E or PGM/PST bank for which 
you want to set the transition rate, turning it on.

The numeric keypad control block display now shows the selected region 
name and the current transition rate setting for the region.

3 With the numeric keypad, enter the transition rate.

• Enter a value of up to three digits.

EFF
SNAP
SHOT

SHOT
BOX MCRO UNDO

STORE
STATS

MASTR ALL

P-BUS GP1

STORE

RCALL

7 8 9

4 5 6

1 2 3

0

+/-
EFF

TRIM

CLR
AUTO

DISS

TRANS

ENBL
GPI

ENTER

DME
1

DME
2

DME
3

DME
4

M/E
1

USER
1

USER
2P/P

P/P
M/E

1

AUX
1

AUX
2

AUX
3

AUX
4

AUX
5

AUX
6

AUX
7

FMS
1

FMS
2

EDIT
PVW KEY SHIFT

TRANS
RATE

TRANS RATE button

Region selection buttons

Display

Numeric keypad

ENTER button
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• To clear the entry, press the [CLR] button.

4 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.
The transition control block display of the same bank (M/E or PGM/PST) 
also shows the setting.

To enter a difference from the current value
After pressing the [+/–] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or –), press the [+/–] button.

Setting the transition rate by a menu operation

1 In the switcher bank, select first VF7 ‘Misc’, then HF1 ‘Transition.’

The Transition menu appears.

2 Select any transition type in the <Transition Type> group.

3 Turn the knob to set the transition rate.

Displaying the transition rates in a menu and changing the 
settings

For each of the M/E and PGM/PST banks, you can display the transition rate 
and independent key transition rate, and change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 317).

Pattern Limit

When a wipe or DME wipe pattern is selected for the transition, you can 
specify the range of movement of the wipe pattern through the course of the 
transition, for each bank independently.
When the pattern limit function is enabled, carrying out a transition results in 
the following effect for example settings.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition Rate 0 to 999 (frame count)
Executing a Transition
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• When the limit value is set to 50%, the effect at the end of the transition is 

the same as when the fader lever is at the center position in the normal case 
(with the pattern limit function disabled); the wipe pattern does not complete.

• When the limit value is set to 0%, the wipe effect is completely disabled, and 
carrying out the transition produces no change in the image.

• When the limit value is set to the maximum 100%, the image changes in 
exactly the same way as when the pattern limit function is off, but when the 
transition is completed, the cross-point selections on the background A and 
B buses do not interchange.

There are two ways of setting a pattern limit: either by operating the fader lever 
to save the fader position, or by using the Wipe menu or DME Wipe menu to 
access the Edge/Direction menu for the M/E or PGM/PST bank.

Notes

• A pattern limit only applies when a wipe or DME wipe is selected as the 
transition type.

• A pattern limit cannot be applied to an independent key transition (see page 
131).

Transition control block

Setting the pattern limit with the fader lever

1 Move the fader lever to the position corresponding to a particular pattern 
size.

• First make sure that the [PTN LIMIT] button is off.
• To check the pattern size on the preview monitor, first press the [TRANS 

PVW] button, to select the transition preview mode (see page 129).

BKBD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

TRANS PVW button

PTN LIMIT button

LIMIT SET button
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2 Press the [LIMIT SET] button.

This sets the current fader lever position as the pattern limit.

Setting the pattern limit by a menu operation

1 When a wipe is selected as the transition type, in the M/E or PGM/PST 
menu, select first VF5 ‘Wipe,’ then HF4 ‘Edge/Direction.’

When a DME wipe is selected as the transition type, in the M/E or PGM/
PST menu, select first VF6 ‘DME Wipe,’ then HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Press the [Pattern Limit] button, turning it on.

3 Turn the knobs to adjust the following parameters.

a)  0.00%: Executing the transition does not change the video output at all.
b) 100.00%: The transition is the same as when no pattern limit is set, but the cross-point 

button selections of the background A and B buses do not interchange when the transition 
completes.

Executing a pattern limit transition

1 Press the [PTN LIMIT] button, turning it on.

The button you pressed lights amber.

2 Carry out the transition.

The transition progresses as far as the set pattern limit. Even if the 
transition completes, the cross-point button assignments of the background 
A and B buses do not interchange.

3 Carry out the transition once again.

The status before the previous transition is restored.

To cancel the pattern limit
To cancel the pattern limit after completion of step 3 in the previous procedure, 
press the [PTN LIMIT] button, turning it off.
If after carrying out step 2 in the previous procedure, the pattern limit has been 
reached, carry out the following procedure.

Knob Parameter Adjustment Setting values

1 Pattern Limit Pattern limit 0.00 a) to 100.00% b)
Executing a Transition
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1 Press the [PTN LIMIT] button.

The button you pressed lights green.

2 Carry out the transition.

The [PTN LIMIT] button goes off, and the pattern limit state is released.
Depending on the way in which the transition was executed, the action will 
be as follows.
• When you press the [CUT] button, the pattern limit is immediately 

released, and the image switches instantaneously.
• When you press the [AUTO TRANS] button, until the state of the next 

transition, the transition is carried out over the duration given by the 
transition rate.

• When you move the fader lever, the transition is carried out from the 
pattern limit state to the state before the pattern limit transition was 
carried out.
Moving the fader lever even a little synchronizes the fader lever position 
with the transition state, and you can move the fader lever either in the 
forward direction or in the reverse direction.

Depending on the Setup settings, the transition may be executed at the 
instant you press the [PTN LIMIT] button, and the button goes off. In this 
case, execution continues for the time specified by the dedicated transition 
rate in the menu setting, as far as the state of the next transition.

For details of the setting, see “Settings Relating to Keys, Wipes, Frame 
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 
(Volume 3).

To set the transition rate when the pattern limit is released

1 In the <Pattern Limit Release> group of the Edge/Direction menu, select 
one of the following.

Auto Trans Rate: Use the transition rate set in the transition rate control 
block

Independ Trans Rate: Independent transition rate

2 If you selected “Independ Trans Rate” in step 1, adjust the following 
parameter.

Knob Parameter Adjustment Setting values

1 Transition Rate Independent transition rate 0 to 999 (frames)
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Executing an Auto Transition

The following two modes can be used for auto transition.

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.

Auto transition
The transition from the current video to the new video is carried out 
automatically at a constant rate, using the transition effect selected as the 
transition type.
You can set the transition rate in advance. (See “Setting the Transition Rate” 
(page 118).)

Transition control block

To execute a transition on the M/E or PGM/PST bank by a button operation, 
use the following procedure in the transition control block.

To carry out an instantaneous cut transition: Press the [CUT] button.
To carry out a gradual transition: Press the [AUTO TRANS] button.

This executes the transition at the preset transition rate (see page 118).
While the transition is executing, the [AUTO TRANS] button lights 
amber. When it completes the button goes off.

To complete a partially executed transition instantaneously: Press the 
[CUT] button.
The [AUTO TRANS] button goes off.

BKBD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

Fader lever

AUTO TRANS button

CUT button
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Executing a Transition With the Fader Lever (Manual 
Transition)

Using the fader lever, you can manually control the progress of the transition. 
Moving the fader lever from one end of its travel to the other completes the 
transition.

To execute a manual transition with the transition control block fader lever, use 
the following procedure.

To carry out the transition completely: Move the lever over the full range of 
its travel.

To pause a partly executed transition: Stop moving the fader lever.
To resume a paused transition: Resume moving the fader lever.

Combinations of Auto and Manual Transitions

Using the [AUTO TRANS] button, the [CUT] button, and the fader lever, use 
the following procedures.

Moving the fader lever during an auto transition
During an auto transition started by pressing the [AUTO TRANS] button, 
operating the fader lever immediately enables the fader lever, and the [AUTO 
TRANS] button goes off. Thereafter, the fader lever controls the progress of 
the transition.

Executing an auto transition after partly moving the fader lever
• Press the [CUT] button to instantaneously complete the transition.
• Press the [AUTO TRANS] button to complete the rest of the transition at the 

preset transition rate.
If the transition rate is set to 100 frames, and the fader lever has moved 
through 1/4 of the transition, then the remaining 3/4 of the transition is carried 
out in 100 frames.

Non-Sync State

If the fader lever is in an intermediate position when a transition is completed 
as an auto transition, then the lever position no longer agrees with the transition 
state. This is termed a non-sync state.
125Executing a Transition
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In a non-sync state, two lit LEDs indicate the position from which a normal 
transition can be carried out. This is either at one end position or both end 
positions of the fader lever travel.
Moving the fader lever toward the position of the lit LEDs does not carry out a 
transition, but when the fader lever reaches the end position the non-sync state 
is released, and it is now possible to carry out the next transition.

• If the fader lever is moved in the direction away from the lit LEDs, this 
carries out the next transition, over the remaining part of the fader lever 
travel.

• Even in a non-sync state, you can carry out an auto transition by pressing the 
[AUTO TRANS] button. During the auto transition, the indicators show the 
transition progress in the usual way, but when the transition completes, they 
once again indicate the non-sync state.

Fader Lever Operation in Bus Fixed Mode

Flip-flop mode and bus fixed mode
The following describes the difference between flip-flop mode and bus fixed 
mode, taking an M/E bank as an example; the functionality is the same, 
however, on the PGM/PST bank.
Normally, when a background transition is carried out on an M/E bank, the 
signals selected on the A and B rows of cross-point buttons are interchanged at 
the end of the transition. That is to say, except during a transition, the 

Manual transition completed as auto 
transition when moving the fader 
lever upward: Top two LEDs light.

Manual transition completed as 
auto transition when moving the 
fader lever downward: Bottom two 
LEDs light.

Once the fader lever is moved 
to this position, the non-sync 
state ends, and the next 
transition (direction shown by 
the arrow) is possible.
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background output is always from the background A bus. This is called “flip-
flop mode.”
The alternative is known as “bus fixed mode,” in which there is no bus 
interchange. In this mode, when the fader lever is at the top of its travel the 
output from the A bus is always 100%, and when the fader lever is at the bottom 
of its travel the output from the B bus is 100%.

Flip-flop mode and bus fixed mode

In the bus fixed mode there is a fixed relationship between the position of the 
fader lever and the signal output on each bus. Depending on the direction of the 
transition, the fader lever must therefore always be moved in a particular 
direction, as shown in the following table. This does not affect an auto 
transition, which is executed regardless of the fader lever direction.

Fader lever operating direction in bus fixed mode

• When a transition applies to a combination of more than one of the 
background and keys 1, 2, 3, and 4, then the transition for all of these must 
be in the same direction complying with the above table.

• If as a result of an auto transition, for example, the fader lever position does 
not agree with the signal output, this is a non-sync state (see page 125) and 

A

B

BLACK

BLACK

A

B

BLACK

BLACK

A

B

BLACK

BLACK

Buttons lit

Fader 
lever

Flip-flop mode

Bus fixed mode

Next transition Transition direction Fader lever movement

Background A t B Downward

B t A Upward

Keys 1, 2, 3, and 4 On t Off (deletion) Downward

Off t On (insertion) Upward
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LEDs light at both end positions of the fader lever travel. Moving the fader 
lever does not carry out a transition, but when the fader lever reaches the end 
position the non-sync state is released, and it is now possible to carry out the 
next transition. If the fader lever is moved in the direction away from the lit 
LEDs, this carries out the next transition, over the remaining part of the fader 
lever travel. 
Executing a Transition
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Transition Preview

With the preview output of the M/E banks and PGM/PST bank, you can check 
the effect of a transition in advance. To carry out a transition preview, press the 
[TRANS PVW] button in the transition control block.

Carrying out a transition preview

1 In the M/E or PGM/PST bank transition control block, press the [TRANS 
PVW] button.

The [TRANS PVW] button lights green, and the switcher is now in the 
transition preview mode. At this point, the preview output is the same as 
the program output before the [TRANS PVW] button was pressed.

2 Operate the fader lever, or press the [AUTO TRANS] button or [CUT] 
button.

On the preview monitor, you can check the effect of the transition.

To terminate a transition preview
There are three modes for a transition preview. To terminate a transition 
preview, carry out the operation which depends on the mode, and press the 
[TRANS PVW] button, turning it off.
Lock: Toggling the [TRANS PVW] button on and off switches between the 

transition preview mode and the normal mode.
Hold: The preview mode obtains only while the [TRANS PVW] button is held 

down.
One Time: Each time a transition ends, it reverts to the normal mode.
Set the transition preview mode in the following combinations. 

For details, see Chapter 19 “Control Panel Setup (Panel)” (Volume 3).

Transition Preview 
mode

Switcher setup
(Transition menu)
<Transition Preview> group

Panel setup
(Operation >Custom Button 
menu)
<Trans Pvw> group

Lock Normal Lock

Hold Normal Hold

One Time One Time –
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Notes

• During a transition, whether executed with the [AUTO TRANS] button or 
the fader lever, it is not possible to press the [TRANS PVW] button.

• In bus fixed mode (see page 126), transition previews are not available.
Transition Preview
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Independent Key Transitions

What is an independent key transition?
In addition to common transitions, it is possible to carry out independent 
transitions on the keyers of the M/E banks and PGM/PST bank. These are 
called “independent key transitions.”
By carrying out an independent key transition in combination with a common 
transition, different transition types can be used for the background and keys. 
It is also possible to use different transition types for key insertion and key 
deletion by means of a Setup menu setting.

For details of this operation, see “Basic Independent Key Transition 
Operations” (page 134).

Combining other transitions with independent key transitions
When you set a common transition and a key independent transition for the 
same key, you can apply two different effects such as a wipe and mix (dissolve) 
(see page 101) to the key simultaneously.
When carrying out such a combination of transitions simultaneously on a key 
as auto transitions (see page 124), the result depends on the timing of pressing 
the respective [AUTO TRANS] buttons.

Simultaneous execution
If the [AUTO TRANS] buttons for the two transitions are pressed 
simultaneously, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).
Deleting a key with simultaneous transitions: With the key inserted, it is 

deleted simultaneously with the two transitions.
When the common transition completes, even if the independent key 
transition is still not completed, the two end simultaneously.
131Independent Key Transitions
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Deleting a key with simultaneous transitions

Inserting a key with simultaneous transitions: With the key not inserted, it 
is inserted simultaneously with the two transitions. If the common 
transition or independent key transition ends first, the other continues to 
completion.

Inserting a key with simultaneous transitions

Time offset execution
If the [AUTO TRANS] buttons for the two transitions are pressed with a time 
offset, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).
Time offset execution with the key inserted: With the key inserted, it is 

deleted with the two transitions acting with a time offset.
Whichever button is pressed first, when the common transition completes, 
even if the independent key transition is still not completed, the two end 
simultaneously.

Wipe and mix 
(dissolve) are 
carried out 
simultaneously.

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Wipe and mix 
(dissolve) are 
carried out 
simultaneously.

The transitions 
continue until both 
are completed.
Independent Key Transitions
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Example: When the independent key transition [AUTO TRANS] button 

is pressed later

Time offset execution with the key inserted

Time offset execution with the key not inserted: With the key not inserted, 
it is inserted with the transition whose [AUTO TRANS] button is pressed 
first.
Since the key is then in the inserted state, with the transition whose [AUTO 
TRANS] button is pressed later, the key is deleted. When the key is 
completely deleted, both transitions complete.

Time offset execution with the key not inserted

Common transition 
(wipe) start

Independent key 
transition (mix) start

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Common transition 
(wipe) start

Independent key 
transition (mix) 
start

The transition 
completes with the 
key deleted.

Example 1: When the independent key transition [AUTO TRANS] 
button is pressed later

Common 
transition (wipe) 
start

Independent 
key transition 
(mix) start

The transition 
completes with the 
key deleted.

Example 2: When the common transition [AUTO TRANS] button is 
pressed later
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Basic Independent Key Transition Operations

Transition control block

You can set independent transitions for the keyers on the M/E or PGM/PST 
bank.
To execute an independent key transition, press the appropriate button in the 
independent key/downstream key transition execution section of the transition 
control block.
The color with which buttons are lit shows the status, as follows.
Lit green: During a transition
Lit amber: Key inserted
Lit red: Key inserted into final output video
Not lit: Key not inserted
To select the transition type and set the transition rate, use a menu operation.

Note

In an independent key transition, the pattern limit function is not available.

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

DSK1
TRANS

DSK2
TRANS

DSK3
TRANS

DSK4
TRANS

Independent key/downstream key transition execution section
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Setting the Independent Key Transition Type by a Menu 
Operation

You can also select the required independent key transition type by a menu 
operation.

1 In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected appears.

2 Select the required transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.

Setting the Independent Key Transition Rate

There are two ways of setting the transition rate: using the numeric keypad 
control block to enter a numeric value, or using the Key menu to access the 
Transition menu for the M/E or PGM/PST bank.
You can also display the transition rate and independent key transition rate for 
each of the M/E and PGM/PST banks, and change the settings. “Displaying a 
List of Transition Rates and Changing the Settings” (page 317).
When the setup selection is for separate transition rates for inserting or deleting 
a key, you can set both rates independently. For example, with the system in 
the state with the key not inserted, the transition rate setting applies to key 
insertion.

Setting the independent key transition rate in the numeric 
keypad control block

1 In the numeric keypad control block, hold down the [TRANS RATE] 
button, and in the independent key transition control block, press the 
delegation button [KEY1] to [KEY4] ([DSK1] to [DSK4] in the PGM/PST 
bank) for the key for which you want to set the transition rate.

The numeric keypad control block changes to the mode for inputting the 
independent key transition rate, and its display now shows the 
corresponding region name and the current transition rate set for the 
region.
135Independent Key Transitions
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2 With the numeric keypad, enter the transition rate.

• Enter a value of up to three digits.
• To clear the entry value, press the [CLR] button.

For details of frame input mode and timecode input mode, see page 118.

3 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.

To enter a difference from the current value
After pressing the [+/–] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or –), press the [+/–] button.

Setting the independent key transition rate by a menu operation

1 In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected key appears.

2 Select any transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.

3 Turn the knob to set the transition rate.

Displaying the independent key transition rates in a menu and 
changing the settings

For each of the M/E and PGM/PST banks, you can also display the transition 
rate and independent key transition rate, and change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 317).

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frame count)
Independent Key Transitions
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Overview

A key is an effect in which a part of the background image is replaced by an 
image or superimposed text. The signal determining how the background is cut 
out is termed “key source,” and the signal that replaces the cut-out part is 
termed “key fill.”
The system component responsible for processing a key is referred to as a 
keyer.
Each M/E bank and the PGM/PST bank has four keyers, and all of these keyers 
provide the same functions.

Key Types

The key type indicates the manner in which the key source signal is used to cut 
out the background. In each bank, you can use the following key types. You 
can select the key type using the key type selection buttons in the key control 
block, or by a setting in the Type menu for the keyer. (See “Key Type Setting” 
(page 146).)

Luminance key
The background is cut out according to the luminance (Y) of the key source 
signal, and at the same time the key fill signal is cut out and then added to the 
background signal.

Linear key
This is a type of luminance key, but there is a reduced variability in gain, 
allowing more precise adjustment.

Color vector key
The key signal is created from a combination of the luminance and 
chrominance components of the key source signal. When perfect keying is not 
possible with a luminance key, this allows a key signal to be created even if the 
luminance level is low, provided that the colors have high saturation.

Clean mode
In a luminance key, linear key or color vector key, you can enable the clean 
mode. When the clean mode is on, the key source does not affect the key fill, 
which is added unchanged to the background. This improves the keyed image 
Overview
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quality, but means that the part of the key fill signal which is not to be inserted 
must be completely black, or it will color the background. You set the clean 
mode with the Type menu of the respective keyer. (See “Setting the key type in 
a menu” (page 146).)
Note that in the following situations, the clean mode goes off, and cannot be 
turned on.
• When the key type is a pattern key
• When key inversion is on
• When the key fill is a matte
• When the key edge is an outline
• When the key edge is normal with soft edge being on
• When fine key is on
• When the key positioner is on

Chroma key
A key signal based on a particular color is used to cut out the background, and 
the key fill is then inserted. The inserted signal is also referred to as the 
foreground, and the composite image is called a chroma key image.

For details of chroma key composition, see “Chroma Key Composition” (page 
148). For details of video adjustment operations and the adjustment items, see 
“Chroma Key Adjustments” (page 149).

Wipe pattern key
This uses the wipe pattern selected for a transition as the key source.

Foreground Background

Chroma key image
139Overview
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Key wipe pattern key
This uses the wipe pattern selected for an independent key transition as the key 
source.

Note on wipe pattern modifiers
In a wipe pattern key or key wipe pattern key, you can apply various 
modifications, depending on the pattern used, and the modifiers in common 
with a wipe.
However, modifiers which relate to the wipe direction and edge are not 
reflected.

Key Modifiers

Edge modifiers

You can apply borders and other effects to the edge of the key. (See “Key Edge 
Modifications” (pages 158 and 179).)

Name Effect Image

Normal This is the state with no key edge modifiers 
applied.

Border This applies a uniform width border to the 
edge of the key. You can adjust the border 
width and density. You can also enable the 
separate edge function, and adjust the top, 
bottom, left, and right border widths 
separately.
Overview
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Edge type and key fill/key source position
The key edge modification function has two modes: a mode (“key drop ON 
mode”) in which the key fill/key source position moves downward, and a mode 
(“key drop OFF mode”) in which it does not move downward.

Drop 
border 

This applies a border below and to the right 
for example, of the key. You can adjust the 
border width, position, and density.

Shadow This applies a shadow below and to the right 
for example, of the key. You can adjust the 
shadow width, position, and density.

Outline This uses the outline of the original key as 
the key. You can adjust the width and density 
of the outline. You can also enable the 
separate edge function, and adjust the top, 
bottom, left, and right outline widths 
separately.

Emboss This applies an embossing effect to the 
outline of the key. You can adjust the width 
and position of the embossing, and the 
density. You can adjust the density 
separately for key fill and key edge. When 
embossing is on, the Fine Key and zabton 
functions go off.

–

Soft 
edge

This softens the edge of the key. –

Zabton This inserts a translucent pattern behind a 
key. You can adjust the pattern size, 
softness, density and color.

–

Name Effect Image
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Key drop ON mode: The key fill/key source position moves downward by 
eight scan lines or four scan lines. When a drop border or shadow is 
selected, it is possible to apply a border to the top edge of the key.

Key drop OFF mode: The key fill/key source position does not move. When 
a drop border or shadow is selected, it is not possible to apply a border to 
the top edge of the key.

In the key drop ON mode, a menu setting selects between the mode (“4H 
mode”) in which the key fill/key source position is lowered by four scan lines, 
and the mode (“8H mode”) in which the key fill/key source position is lowered 
by eight scan lines.
When Fine Key is on, the edge width is forced to the range 0.00 to 4.00.

Note that in the following situations, the key drop mode is forcibly turned on.
• When the edge type is border, outline, or emboss
• When the edge type is normal with soft edge being on
• When Fine Key is on

Edge fill
When a border, drop border, or shadow modifier is selected, you can select a 
signal to fill these edge effects.
The edge fill may be either the signal from the dedicated color matte generator, 
or the signal currently selected on the utility 1 bus.
In the case of an outline, there is no edge fill signal selection, because the key 
fill signal fills the outline, and the rest of the image remains as the background.
For the emboss effect, in place of the edge fill signal, the emboss fill matte 1 
and emboss fill matte 2 signals are used.

Masks
A mask is used to inhibit the effect of a key over a part of the image. This 
allows parts of the background which would otherwise be keyed to be 
protected, or to correct the key if it is not of the desired shape.

For details of masking operations, see “Masks” (pages 165 and 183).

Key mask and background mask
There are two types of mask: a key mask and a background mask.
Key mask: This masks out a part of the key, which will result in the 

background appearing.
Overview



  C
hapter 4 

K
eys
Background mask: This masks out a part of the background, which will result 
in the key fill appearing.

Main mask and subsidiary (“sub”) mask
Each keyer allows two masks to be used simultaneously, and these are referred 
to as the main mask and the sub mask. The signal that determines the mask 
shape and size is termed the mask source, and different sources are used for the 
main mask and sub mask.
Main mask: This uses the signal from the dedicated box generator provided 

on each keyer, or the signal from the dedicated pattern generator as the 
mask source.
When the box generator is selected, a rectangular mask is formed. You can 
adjust the positions of the four sides of the box separately.
When the pattern generator is selected, you can select the pattern and apply 
modifiers.

Sub mask: This uses the wipe generator signal or the signal selected on the 
utility 1 bus, as the mask source.
When the wipe generator is selected, the patterns and the pattern modifiers 
are the same as in a wipe transition.

Key Memory

The key memory function allows the keyer settings on each cross-point button 
to be automatically stored, so that the next time the same cross-point button is 
selected these settings are recalled automatically.
There are two modes for key memory: simple mode and full mode. 
The parameters stored in each mode are as follows.
Simple mode: key type, clean mode (including the plane setting for chroma 

keying), key position, key inversion, and adjustment values for the 
particular key type (Clip, Gain, Density, Filter, etc. This includes color 
vector key, wipe pattern key, key wipe pattern key, and chroma key. 
However, in the case of a chroma key, it excludes color cancel, Y balance, 
foreground CCR, window, and shadow.)

Key mask

Masked area (box)

Background mask
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Full mode: All settings except transition (the same parameters as simple mode, 
Fine Key, key modifiers, main and sub mask settings, chroma key detailed 
settings, and so on)

For the settings for these modes, see “Settings Relating to Keys, Wipes, Frame 
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 
(Volume 3).

Key Default

With a simple operation you can return the key adjustment values to their 
defaults.
The adjustment values which can be returned to their default values are as 
follows.
• Adjustment values for the particular key type (Clip, Gain, Density, Filter, 

etc.)
In the case of chroma keying, all adjustment values return to their default 
values.

• Key position
• Key inversion
• Clean mode

For details, see “Returning the key adjustment values to their defaults” (page 
186).
For the menu operation to return the key adjustment values to their defaults, 
see “Returning to default state in function groupings” (page 77).
Overview
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Key Setting Operations Using Menus

There are two ways of making key settings: either using menus, or using the 
key control block.
This section describes basic procedures for making key settings using the 
menus, taking the M/E-1 >Key1 menu as an example.
Operations in the Key menus are the same for all banks (M/E-1 to M/E-3 and 
PGM/PST).

For details of the method of using the key control block, see “Key Setting 
Operations With the Key Control Block” (page 175).

Key Setting Menus

The key setting menus for each bank (M/E-1 to M/E-3 and PGM/PST) are as 
follows.

Accessing a key setting menu
For example, to access the M/E-1 >Key1 menu, carry out any of the following 
procedures.
• In the menu control block, select the top menu selection button [M/E 1], then 

press VF1 ‘Key1.’
• In the M/E-1 bank transition control block, press the KEY1 next transition 

selection button twice in rapid succession.
• Press the [KEY1] button in the key delegation row of the M/E-1 bank twice 

in rapid succession.
• In the key control block, press the M/E delegation button [M/E1], then press 

the key delegation button [KEY1] twice in rapid succession.
Any of the above operations displays the M/E1 >Key1 menu.
Note that you can access the DSK menus by pressing the button for the 
corresponding key in the downstream key control block twice in rapid 
succession.

Bank Keys set Menus

M/E-1 Keys 1 to 4 M/E-1 >Key1 to 4

PGM/PST Downstream keys 1 to 4 PGM/PST >DSK1 to 4
145Key Setting Operations Using Menus
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Key Type Setting

Setting the key type in a menu

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Type> group, select the key type.

Luminance: luminance key
Linear: linear key
Chroma: chroma key
Color Vector: color vector key
Wipe Pattern: wipe pattern key
Key Wipe Pattern: key wipe pattern key

For the selected key type, you can now set the parameters.

For an overview of the key types, see “Key Types” (page 138). 

3 Carry out the following settings as required, depending on the key type 
selected in step 2.

To enable clean mode (see page 138) for a luminance key, linear key or 
color vector key: Select [Clean Mode] so that it is set on.
When clean mode is enabled, key fill is added to the background 
without cutting out with key source.

When chroma key is selected: Select [Chroma Adjust] to access the 
Chroma Adjust menu (see page 151), and make the required settings.

When a wipe pattern key is selected: In the M/E-1 >Wipe menu (see 
page 191), select the pattern and set any modifiers, then return to the 
M/E-1 >Key1 menu.

When a key wipe pattern key is selected: In the M/E-1 >Key1 >
Transition >Wipe Adjust menu (see page 216), carry out pattern 
selection and modifier setting, then return to the M/E-1 >Key1 >Type 
menu.

Note

For a wipe pattern selected for a wipe pattern key or key wipe pattern key, 
the [Edge] and [Direction] modifier settings are not available.

4 Set the parameters.
Key Setting Operations Using Menus
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• When a luminance key or linear key is selected

a) Setting this value to 1, produces the “through” state in which no filter is applied. The larger 
the value, the more strongly the filter applies.

• When a chroma key is selected

• When a color vector key is selected

• When a wipe pattern key or key wipe pattern key is selected

5 Make the following settings as required.

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109.59 to –7.31

2 Gain Key sensitivity –100.00 to +100.00

3 Density Key density 0.00 to 100.00

4 Filter Filter coefficient 1 to 9 a)

Knob Parameter Adjustment Setting values

3 Density Key density 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for creating 
luminance signal

+109.59 to –7.31

2 Y Gain Luminance signal sensitivity –100.00 to +100.00

3 C Clip Reference level for creating 
chrominance signal

100.00 to 0.00

4 C Gain Chrominance signal sensitivity –100.00 to +100.00

5 Density Key density 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Luminance signal filter coefficient 1 to 9

2 C Filter Chrominance signal filter 
coefficient

1 to 9

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00
147Key Setting Operations Using Menus



148

   C
hapter 4 

K
eys
To invert the black and white sense of the key source: Press [Key 
Invert], turning it on.

To adjust the horizontal position or key source width for a luminance 
key, linear key, or chroma key: Press [Key Position], turning it on, 
and set the parameters.

To set the key priority: Press [Key Priority] or select VF7 ‘Misc’ and 
HF3 ‘Key Priority’ to access the Key Priority menu.
For details, see “Setting the Key Priority by a Menu Operation” (page 
109).

Chroma Key Composition

Normal mix and additive mix
In creating a chroma key image, either a normal mix or an additive mix can be 
used. To select which, use the Type >Chroma Adjust menu for the keyer.
Normal mix: The foreground is cut out with the key signal, and then combined 

with the background, which has also been cut out with the key signal.
Additive mix: The background, which has been cut out with the key signal, is 

combined with the unshaped foreground. This is effective for a natural-
looking composite when the scene includes glass or other translucent 
objects.

Plane function
In an additive mix, the foreground is not shaped by the key signal, and 
variations in the (blue) background appear in the composite image. To prevent 
this, it is possible to set a particular luminance level for the background, and 
any parts below this level are cut forcibly.

Composing an image by chroma keying
There are two types of composition for chroma keying: normal mix, and 
additive mix.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

2 Select [Chroma] in the <Key Type> group.

It becomes possible to adjust the key density (see page 147).

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal position –4.00 to +4.00

2 Left Key left edge position –4.00 to +4.00

3 Right Key right edge position –4.00 to +4.00
Key Setting Operations Using Menus
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3 Select [Chroma Adjust].

The Chroma Adjust menu appears.

4 Carry out auto chroma key adjustments. 
Also carry out manual adjustments if necessary to obtain an optimum 
chroma key image.

For the adjustment procedures, see page 149.

5 In the <Mix Mode> group, select [Normal Mix] or [Additive Mix] 
depending on the desired type of chroma key composition.

When using an additive mix for chroma keying, the (typically blue) 
background parts of the foreground video must be converted to black. For this, 
use the color cancel function (see page 152).

Using the plane function
In an additive mix, since no key is applied to the foreground, any variations in 
the (typically blue) background may appear in the composite image. To avoid 
this, a particular luminance level can be set for the (blue) background, and 
regions of lower luminance forcibly cut.

1 In the Chroma Adjust menu, set [Plane] on.

2 Adjust the following parameter.

Chroma Key Adjustments

Methods of adjusting the composite obtained from chroma keying include 
automatic adjustment with the auto chroma key function, and manual 
adjustment carrying out the necessary processing separately. The optimum 
results will be obtained by first carrying out adjustments with the auto chroma 
key function, then making any fine adjustments as required.
The following manual adjustments are possible.

Key active
When this function is off, only the foreground is output and you can make 
adjustments of color cancel (see the next paragraph).

Knob Parameter Adjustment Setting values

1 Luminance Luminance level 0.00 to 100.00
149Key Setting Operations Using Menus
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Color cancel
If the foreground image includes shades of the background color, turn this 
function on to remove the color from the foreground image.

Chroma key window
You can adjust the range over which the key signal is determined as matching 
the specified hue. When this adjustment is off the default ranges are used.

Chroma keying generates a key signal based on a particular color (reference 
color) in the foreground (typically a plain blue background), and the “window” 
refers to the range of colors which are regarded as matching this specified 
reference color to create the key signal.
As seen on a vectorscope (that is, in the hue-saturation color space), the range 
for this matching corresponds to a truncated sector. This range is specified by 
two parameters: the “Angle” parameter, which determines the range of the hue 
parameter, and the “Crop” parameter, which determines the degree of 
truncation (see the following figure).

Window adjustment

Y balance
In normal chroma keying, the key signal is based on the chrominance 
component only, and all elements of the foreground with the same hue are 
replaced by the background. Using the Y balance function, you can specify a 
luminance level range within which the key is active, and replace the specified 
part by the background.

Reference color 
specified by Hue 
setting

Range of colors creating the key signal 
(to be replaced by background signal)

Range of colors remaining 
as foreground

a) The Crop and Angle values do not change even if 
you use the auto chroma key function.

Angle a)

Crop a)
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You can use the Y balance function independently on the key signal for the 
composition and the key signal for the color cancel function. When applied to 
the key signal for the composition, this produces the foreground with the color 
cancel effect applied. This can therefore be used to provide an impression of 
smoke, for example.
When the Y balance function is applied to the color cancel key, the relevant 
part is output in its original color without canceling, and therefore it is possible 
to combine colors which are the same color as the background (i.e. typically 
blue) in the foreground.

Chroma key shadow
This function provides a more realistic treatment when the shadow of an object 
in the field of view falls on the blue background. Since parts of the blue 
background darker than a specified intensity are treated as shadows, there is no 
effect on cutting out of the foreground.

Video signal adjustment
You can vary the foreground signal gain, or change the hue. There are separate 
adjustments for the gain of the overall video signal, and Y and C components.

Making auto chroma key adjustments
Auto chroma key is an automatic adjustment function which allows you to 
specify a part of the foreground video (for example, the blue background color) 
and use it as a reference for creating the chroma key image.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type,’ then select [Chroma] in the 
<Key Type> group.

2 Select [Chroma Adjust].

The Chroma Adjust menu appears.

3 Select [Sample Mark] in the <Auto> group.

The foreground video only appears on the monitor, with a white box-
shaped sample selector.

4 Adjust the position and size of the sample selector, to specify the color to 
be used as the basis of chroma keying (typically a blue background).

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00 a)

2 Position V Vertical position –100.00 to +100.00 a)

3 Size Size 1.00 to 100.00
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a) The setting ranges depend on the signal format, screen aspect ratio, and size settings.

5 Select [Auto Start] in the <Auto> group.

This executes an auto chroma key based on the color specified by the 
sample selector, and displays the composite image on the monitor.

Making key active adjustments
When the key active function is on, the composite image is output to the 
monitor, and you can watch the monitor while manually adjusting the keying. 
When the key active function is off, only the foreground image appears. Set 
this off when manually adjusting color cancel (see the next section).

1 In the Chroma Adjust menu, set [Key Active] on.

2 Adjust the following parameters.

Making color cancel adjustments
If the background color is leaking into the foreground video, turning the color 
cancel function on allows you to eliminate this leakage.

1 In the Chroma Adjust menu, turn [Key Active] off.

Only the foreground image appears on the monitor.

2 In the <Color Cancel> group, set [Color Cancel] on.

3 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 0.00 to 100.00

2 Gain Key gain –100.00 to +100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

5 Filter Filter coefficient 1 to 9

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

5 Filter Filter coefficient 1 to 9
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4 Set [Key Active] on.

The chroma key composite image now appears in the monitor.

Making key signal adjustments for color cancel
When the color cancel function is set on, you can adjust the key signal for color 
cancel.

1 In the <Color Cancel> group of the Chroma Adjust menu, set [Color 
Cancel] on.

2 In the <Color Cancel> group, set [Cancel Key] on.

The cancel key is now on, and you can now adjust the key signal for color 
cancel.

3 Make the following settings, as required, in the <Color Cancel> group.

• When setting [Key Position] on and adjusting the color cancel key 
edge position

• When setting [Window] on and adjusting the detection range of the 
color cancel key

For details of the crop and angle parameters, see “Chroma key window” 
(page 150).

Knob Parameter Adjustment Setting values

1 Clip Color cancel key reference level 0.00 to 100.00

2 Gain Color cancel key gain –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 H Phase Move left and right edges of the 
color cancel key simultaneously

Left edge position 
value shown

2 Left Move left edge of the color cancel 
key

–3.00 to +3.00

3 Right Move right edge of the color 
cancel key

–3.00 to +3.00

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00
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• When setting [Y Balance] on and adjusting the ratio in which Y 
balance is added to the color cancel key

Adjusting the window
Setting the window function on allows you to adjust the detection range used 
to determine the key signal. When this function is off, the default range is used 
for the key.

For an overview of the window, see “Chroma key window” (page 150).

After making sure that the values of Clip, Gain, and Hue are adjusted 
appropriately, use the following procedure to make the window adjustment.

1 In the Chroma Adjust menu, set [Window] on.

2 Adjust the following parameters.

Adjusting the Y balance
Setting the Y balance on allows you to specify that, even if the hue is the same, 
only portions of a particular luminance will be replaced by the background.

For an overview of the Y balance, see “Y balance” (page 150).

1 In the Chroma Adjust menu, set [Y Balance] on.

2 Adjust the following parameters.

Adjusting the chroma key shadow
This function allows a shadow falling on the (typically blue) background color 
to be rendered more realistically. Since portions of the (blue) background of 

Knob Parameter Adjustment Setting values

1 Mixture Ratio of Y balance key 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00

Knob Parameter Adjustment Setting values

1 Clip Luminance range 0.00 to 100.00

2 Gain Key gain –100.00 to +100.00

3 Luminance Luminance 0.00 to 100.00
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less than a certain luminance are treated as shadows, there is no effect on 
cutting out of the foreground. 

1 In the Chroma Adjust menu, set [Shadow] on.

2 Adjust the following parameters.

Note

When chroma key shadow is on, key edge is changed to normal, and soft edge 
is switched off.

Adjusting the video signal
You can change the gain of the foreground signal, or vary the Hue. There are 
separate adjustments for the gain of the whole video signal, or Y and C 
individually.

1 In the Chroma Adjust menu, set [FRGD CCR] on.

2 Adjust the following parameters.

Selecting Key Fill and Key Source

Selecting key fill and key source
To select key fill and key source for key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

Knob Parameter Adjustment Setting values

1 Luminance Reference luminance for shadows 0.00 to 100.00

2 Gain Shadow key gain –100.00 to +100.00

3 Density Shadow opacity 0.00 to 100.00

4 Soft Shadow softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of video signal –100.00 to +100.00

2 Y Gain Y signal gain –100.00 to +100.00

3 C Gain C signal gain –100.00 to +100.00

4 Hue Hue offset amount –180.00 to +180.00
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The Type menu appears.

2 In the <Key Fill> group, select either of the following for use as key fill.

Key Bus: signal selected on the key 1 fill bus
Matte: signal from the dedicated color matte generator

3 If you selected [Key Bus] in step 2, press the key delegation button 
[KEY1] in the cross-point control block and select the key fill signal in the 
key row.

4 If you selected [Matte] in step 2, in the same Type menu, press the [Matte 
Adjust] button to display the Matte Adjust menu, then adjust the single-
color or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Fill Matte> group.

Flat Color: Adjust color 1 with the following parameters.

Mix Color: Carry out a color mix. Adjust color 1 and color 2, and select a 
mix pattern (see the next section).

5 In the <Key Source> group, specify the key source selection mode.

Self: The key fill bus signal is automatically selected as the key source.
When the key type is selected as chroma key, select [Self].

Auto Select: The signal allocated, being paired with the key fill bus signal, 
to a cross-point button is automatically selected as the key source. The 
setting of key fill and key source pairs is carried out in the Setup menu. 
(See “Cross-Point Settings (Xpt Assign Menu)” in Chapter 19 
(Volume 3).)

Split: You can select a key source signal independently of the key source 
automatically selected in Auto Select mode.

6 When [Split] was selected in step 5, hold down the [KEY1] button and 
press the appropriate button in the key row to select the key source signal.

To select the video signal assigned to the button, turn off the [KEY] button 
in the AUX bus control block, and to select the key signal, turn on the 
[KEY] button before pressing the button in the key row.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Notes

• Carrying out a [KEY] button operation in the AUX bus control block 
requires the [KEY] button operating mode (Key Source Bus Select 
Mode) to be set. With the factory default setting (Key), the [KEY] button 
is always off, and it is only possible to select a key signal assigned to a 
button as the key source signal.

For details, see “Operation Settings (Operation Menu)” in Chapter 19 
(Volume 3).

• When [Split] is selected, the key memory function (see page 143) is 
disabled.

To select a video signal assigned to a cross-point button
By selecting the key source bus with an auxiliary bus control block AUX 
delegation button, and pressing the cross-point button, it is possible to select 
the video signal assigned to the cross-point button.
(If you press the cross-point button with holding down [KEY], the key signal 
assigned to the cross-point button.)

Note

In the above operation, the following settings must have been made.
• Assigning the key source bus to an AUX delegation button

For details, see “Auxiliary Bus Control Block Settings (Aux Assign Menu)” 
in Chapter 19 (Volume 3).

• Setting the [KEY] button operating mode

For details, see “Operation Settings (Operation Menu)” in Chapter 19 
(Volume 3).

Carrying out a color mix for key fill
When [Matte] is selected for key fill, you can combine color 1 and color 2. For 
the combination, you can use not only a key wipe generator pattern, but also 
the dedicated pattern for key edge color mix.

1 In the <Key Fill> group of the Type menu, select [Matte] and press [Matte 
Adjust].

The Matte Adjust menu appears.

2 Select [Mix Color] in the <Fill Matte> group.

3 Adjust the following parameters.
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4 Select the combining pattern in the <Mix Pattern> group.

Key Wipe: The wipe pattern selected for an independent key transition is 
used for combination. You can change this pattern by pressing [Pattern 
Select] to open the menu for key wipe pattern selection (Pattern Select 
menu), and make adjustments by pressing [Pattern Adjust] to open the 
menu for pattern adjustment (Wipe Adjust menu).

Key Edge Pattern: Combine using the dedicated pattern selected for the 
color mix in the key edge fill. You can change this pattern by pressing 
[Pattern Select] to open the menu for edge color mix dedicated wipe 
pattern selection (Mix Pattern Select menu), and make adjustments by 
pressing [Pattern Adjust] to open the menu for pattern adjustment 
(Matte Adjust menu).

For details, see “Carrying out a color mix for the key edge fill matte” 
(page 162).

5 In the Type menu, adjust color 1 and color 2.

To adjust color 1, select [Color1], and to adjust color 2, select [Color2], 
then adjust the following parameters.

6 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Key Edge Modifications

To modify the key edge of key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 menu, select HF2 ‘Edge.’

The Edge menu appears.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of the edge of the 
pattern

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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2 Select the edge type in the <Edge> group.

For an overview of the key edge modifications, see “Edge modifiers” 
(page 140).

Normal: unadorned edge
Border: edge with border applied
Drop Border: edge with drop border applied
Shadow: edge with shadow applied
Outline: edge used as outline
Emboss: embossing effect applied to edge

If you select [Normal], skip to step 7.

3 Set the border width and other parameters.

When border or outline is selected: The setting parameters depend on 
the key type and whether the separate edge function is enabled or not. 
To enable the separate edge function, press [Separate Edge], setting it 
on.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0.00 
to 4.00.

b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The left, right, top, and bottom border or outline widths can be adjusted 
independently. The separate edge function is only valid when a 
luminance key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0.00 
to 4.00.

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

(0.00 to 100.00) b)

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Top edge width 0.00 to 8.00 a)

2 Left Left edge width 0.00 to 8.00 a)

3 Right Right edge width 0.00 to 8.00 a)

4 Bottom Bottom edge width 0.00 to 8.00 a)

5 Density Density 0.00 to 100.00
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When drop border or shadow is selected: The setting parameter values 
depend on the on/off setting of key drop and the selection of 4H mode/
8H mode (see page 141).

• “Key drop OFF” mode 

• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0.00 
to 4.00.

When emboss is selected:

a) The Density adjustment only affects the key edge. This can be adjusted separately from 
Key Density, and if Key Density is set to 0.00, the embossed edge effect only can be 
applied.

To make edge fill adjustments, carry out the settings in step 6.

4 Select the edge fill signal in the <Edge Fill> group.

Utility 1 Bus: signal selected on the utility 1 bus
Matte: signal from dedicated color matte generator.

It becomes possible to adjust color 1.

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00

2 Position Position 359.99 to 180.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

2 Position Position 359.99 to 0.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 4.00

2 Position Position 359.99 to 0.00

3 Density a) Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
Key Setting Operations Using Menus



  C
hapter 4 

K
eys
When the edge type is outline, in place of the edge fill signal, the selected 
key fill signal fills the outline, and elsewhere remains as the background.

5 Carry out the following operation, depending on the selection in step 4.

When [Utility 1 Bus] is selected: Press the key delegation button 
[UTIL1], turning it on, and select the signal in the key row.

When [Matte] is selected: Press [Matte Adjust] in the same EDGE menu, 
to display the Matte Adjust menu, and adjust a single color or two-
color combination color matte.
You can select whether to use a single color matte or a two-color 
combination color matte in the <Edge Matte> group.

For the color mix operation, see “Carrying out a color mix for the key edge 
fill matte” (page 162).

6 When emboss is selected for the edge type, adjust the color in the <Emboss 
Fill> group.

To adjust matte 1 press [Matte1], and to adjust matte 2 press [Matte2], then 
adjust the following parameters.

7 To make the edge soft, press [Soft Edge] to set it on, and adjust the 
softness.

For a normal edge, when [Soft Edge] is enabled, [Key Drop] is kept on.

8 To make separate fine adjustments to the positions of the left, right, top, 
and bottom of the source edge, press [Fine Key], to set it on, and adjust the 
following parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Top Key top edge position –2.00 to +2.00

2 Left Key left edge position –2.00 to +2.00

3 Right Key right edge position –2.00 to +2.00
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Note

In the emboss function it is not possible to set [Fine Key] on.

• When the edge type is normal, drop border or shadow, enabling the [Fine 
Key] function keeps [Key Drop] on.

• When applying a border to the key edge, enabling the [Fine Key] 
function halves the border width setting range.

Carrying out a color mix for the key edge fill matte
When you select ‘Matte’ for the edge fill of a border, drop border, or shadow, 
you can create a combination of color 1 and color 2 using a wipe pattern 
generated by the dedicated pattern generator.

1 In the <Edge Fill> group of the Edge menu, select [Matte], then press 
[Matte Adjust].

The edge fill Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 Adjust the following parameters.

a) The patterns are the same as standard wipes. (For details, see “Wipe Pattern List” in (page 
353).)

To select the pattern, display the Mix Pattern Select menu by pressing 
[Mix Pattern] in the edge fill Matte Adjust menu. After selecting one of the 

4 Bottom Key bottom edge position –2.00 to +2.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal position Left edge position 
value shown

2 V Phase Key vertical position Top edge position 
value shown

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of pattern edge 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)
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patterns (standard wipe patterns 1 to 24) displayed in the Mix Pattern 
Select menu, you can adjust the following parameters.

4 Adjust color 1 and color 2.

To adjust color 1 press [Color 1], and to adjust color 2 press [Color 2], 
turning it on respectively, and adjust the following parameters.

5 If required, set the pattern modifiers.

• When turning [Position] on and setting the pattern position

a) See page 204.

• When turning [Multi] on and replicating the pattern

a) See page 209.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 208.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of pattern edge 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)
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• When turning [Angle] on in the <Rotation> group and inclining the 
pattern

a) See page 206.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant speed

a) See page 206.

6 To interchange color 1 and color 2, press [Color Invert], turning it on.

Applying the zabton effects

1 In the Edge menu, press [Zabton], turning it on.

2 Adjust the following parameters.

Note

If in the pattern selection described below you select “Mask Pattern,” and 
“Box” for the main mask, the “Size” parameter here cannot be adjusted. 
Set “Size” in the Main Mask menu.

3 To adjust the pattern and color, press [Zabton Adjust].

The Zabton Adjust menu appears.

4 In the <Zabton Pattern> group, select the pattern.

Key Wipe: Use a key wipe.
You can change this pattern by pressing [Pattern Select] to open the 
menu for key wipe pattern selection (Pattern Select menu), and make 
adjustments by pressing [Pattern Adjust] to open the menu for pattern 
adjustment (Wipe Adjust menu).

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Pattern edge softness 0.00 to 100.00

3 Density Density 0.00 to 100.00
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Key Edge Pattern: Use a color mixing pattern for key edge.
You can change this pattern by pressing [Pattern Select] to open the 
menu for edge color mix dedicated wipe pattern selection (Mix Pattern 
Select menu), and make adjustments by pressing [Pattern Adjust] to 
open the menu for pattern adjustment (Matte Adjust menu).

Mask Pattern: Use the main mask Box or Pattern.
You can also press [Pattern Select], and in the corresponding pattern 
adjustment menu, change the pattern.

5 To adjust the color, press [Zabton Color] and adjust the following 
parameters.

Masks

There are two masks, which can be used to mask off unneeded parts of a key 
or background, or to remove defects, and these are known as the main mask and 
subsidiary mask. You can either use the main mask and subsidiary mask 
independently, or at the same time. 

Using the main mask
For example, to use the main mask for key 1 on the M/E-1 bank, use the 
following procedure.

1 In the M/E-1 >Key1 menu, select HF3 ‘Main Mask.’

The Main Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Box: signal from the dedicated box generator
Pattern: signal from the dedicated pattern generator

Knob  Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00
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4 Set the mask source parameters.

• When a box is selected

• When a pattern is selected

a) The pattern is the same as a standard wipe. (See “Wipe Pattern List” in Appendix (Volume 
1) (page 353).)

To select the pattern, display the Mask Ptn Select menu by pressing the 
[Mask Ptn Select] button in the Main Mask menu. 
After selecting one of the patterns (standard wipe patterns 1 to 24) 
displayed in the Mask Ptn Select menu, you can adjust the following 
parameters.

5 To invert the black and white sense of the mask source, press the [Mask 
Invert] button, turning it on.

6 When a pattern is selected as the mask source, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See page 204.

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00

5 Soft Box softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)
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• When turning [Multi] on and replicating the pattern

a) See page 209.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 208.

• When turning [Angle] on in the <Rotation> group and setting the 
angle of the pattern rotation

a) See page 206.

• When turning [Speed] on in the <Rotation> group and setting the 
rate of pattern rotation

a) See page 206.

Using the subsidiary mask
For example, to use the subsidiary mask for key 1 on the M/E-1 bank, use the 
following procedure.

1 In the M/E-1 >Key1 menu, select HF4 ‘Sub Mask.’

The Sub Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Pattern angle –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rate of pattern rotation –100.00 to +100.00 a)
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3 In the <Mask Source> group, select the mask source.

Wipe: wipe pattern selected for a transition
If you select [Wipe], select the pattern and make modifier settings in 
the M/E-1 >Wipe menu (see page 191), then return to this M/E-1 
>Key1 menu.
In the case of a wipe pattern selected for a mask, the modifier [Edge] 
and [Direction] settings are not available.

Utility 1 Bus: signal selected on the utility 1 bus
When you selected [Utility 1 Bus], press the key delegation button 
[UTIL1], turning it on, in the M/E-1 bank and select the signal in the 
key row.

4 Set the mask source parameters.

• When wipe is selected

• When utility 1 bus is selected

5 To invert the black and white sense of the mask source, press the [Mask 
Invert] button, turning it on.

Applying a DME Effect to a Key

Note 

For one M/E bank, DME effects (including DME wipes) can be used in up to 
two places on the dedicated interface and in only one place on the SDI interface 
simultaneously.
When combining the SDI interface with the dedicated interface, you can apply 
DME effects to a maximum of three keys. (Requires a setting in setup.)

For details, see “Interfacing With External Devices (Device Interface Menu)” 
in Chapter 19 (Volume 3).

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Clip Reference level for creating mask 
signal

+109.59 to –7.31

2 Gain Gain –100.00 to +100.00
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Assigning a DME to a key

1 In the M/E-1 >Key1 menu, select HF5 ‘Processed Key.’

The Processed Key menu appears.

2 In the <DME Select> group, select the DME channel (DME1 to DME4) to 
be used.

The lit colors of [DME1] to [DME4] indicate the DME assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

Note

When assigning two to four DME channels to one key, the selected DME 
channels must be successive.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.
The later selection is valid, and the button lights green.

You can check the DME operating status in the Status menu (see page 320).

Selecting the video signal for the DME assigned to a key

For the operating procedure, see“Selecting the video signal for a DME 
assigned to a key” (page 174).

Assigning a DME output signal as a monitor signal

1 In the Processed Key menu, press [Monitor].

The Monitor menu appears.

2 Press [Monitor Set], turning it on.

3 In the <DME Select> group, select the DME channel (DME1 to DME4) to 
be used.

This assigns the selected DME output to DME MON V and DME MON K.
The colors with which [DME1] to [DME4] are lit show the key assignment 
status.
Lit green: DME currently being monitored
Lit amber: DME that can be monitored
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Off: Unassigned DME

Specifying the Key Output Destination

Using the key processed keyer signals (external processed key)
To select the key processed keyer key fill and key source signals on the AUX 
bus or edit preview bus, press [Ext Proc Key] turning it on, in the Processed 
Key menu.
This assigns the key fill and key source signals for M/E-1 key 1 to reentry 
signals PROC V and PROC K.
When a DME is selected on the keyer, the key fill and key source signals to 
which a DME effect is applied are assigned.

Note

You cannot select the PROC V and PROC K signals using the cross-point 
selection buttons of the M/E or PGM/PST bank.

Using the key processed keyer signals or signals to which a DME 
effect is applied in frame memory (frame memory feed)

To use the key processed keyer key fill and key source signals on the frame 
memory source buses, in the Processed Key menu, press [FM Feed]. [Ext Proc 
Key] turns on, and the key fill and key source signals processed on the 
currently selected keyer are automatically assigned to frame memory source 
buses 1 and 2. When a DME is selected on the keyer, the key fill and key source 
signals to which a DME effect is applied are assigned.

Key Modify Clear

A simple button operation or a menu operation returns the key settings to the 
initial status settings.
Press [Default Recall] at the lower left of the menu display, turning it on, then 
press the corresponding VF button (VF1 to VF4) to return the key settings to 
their initial status.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 18 (Volume 3).
For the menu operation to return the key state to that set in initial status, see 
“Returning to default state in function groupings” (page 77).
Key Setting Operations Using Menus



  C
hapter 4 

K
eys
Blink Function

With the blink function, you can obtain the following effects.
Key blink: The key is alternately inserted and deleted at regular intervals. You 

can set the period of blinking, and the proportion of each cycle for which 
the key is inserted.

Edge blink: The key fill and key edge fill signals are interchanged at regular 
intervals. You can set the period of blinking, and the proportion of each 
cycle for which the original state holds.

The blink settings are in the Transition menu for each key. 

Using the blink function
For example, to make the required settings for key 1 on the M/E-1 bank, use 
the following procedure.

1 In the M/E-1 >Key1 menu, select HF6 ‘Transition.’

The Transition menu appears.

2 In the <Blink> group, select [Key Blink] or [Edge Blink] to set it on.

3 Set the blink parameters.

• When key blink is selected

• When edge blink is selected

Video Processing

You can adjust the luminance and hue of the selected key fill signal.
For example, to apply video processing to the signal selected on the M/E-1 
bank key 1 fill bus, use the following procedure.

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which key 
inserted

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which 
original state holds

0.00 to 100.00
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1 In the M/E-1 >Key1 menu, select HF7 ‘Video Process.’

The Video Process menu appears.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults
Press [Unity].

Knob Parameter Adjustment Setting values

1 Video Gain Video gain –200.00 to +200.00

2 Y Gain Luminance gain –200.00 to +200.00

3 C Gain Chrominance gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Luminance black level –7.31 to +109.59
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Key Setting Operations With the Cross-
Point Control Block

You can make a key signal selection using the cross-point control block of the 
M/E-1 or PGM/PST bank including the relevant key.

Applying a DME Effect to a Key

Checking the DME status
As an example, to check the DME status for M/E1 key 1, hold down the key 
row delegation button [KEY1] in the M/E1 bank.
While the button is held down, the [DME1] to [DME4] buttons light, and the 
colors with which they light indicate the status, as follows.
Lit green: A DME is assigned to M/E1 key 1. In the M/E1 independent key 

transition and transition control blocks, the transition type for KEY1 is set 
to a DME wipe.

Lit amber: A DME is assigned to an M/E1 key other than key 1.
In the independent key transition and transition control blocks, the 
transition type for other than key 1 of M/E-1 is set to a DME wipe.

Not lit: No DME is assigned, or a DME wipe is not selected.

You can check the DME operating status in the Status menu (see page 320).

Assigning DMEs to a key
As an example, to assign DME1 and DME2 to key 1, in the cross-point control 
block, hold down the key row delegation button [KEY1] and press the buttons 
([DME1] to [DME4]) for the DME channels to be used.
In this case, press [DME1], followed by [DME2].
The buttons pressed ([DME1] and [DME2]) light green and the DMEs are 
assigned to key 1.

Notes

• If the DME is selected on another keyer, the later selection takes precedence 
and the button lights green.
By a setting in the Setup menu (see “Operation Settings (Operation menu)” 
in Chapter 19 (Volume 3)), you can make the first selection take precedence.
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• For one M/E bank, DME effects (including DME wipes) can be used in up 
to two places on the dedicated interface and in only one place on the SDI 
interface simultaneously.

Ending a DME assignment
As an example, to end the assignment of a DME to key 1, in the cross-point 
control block, hold down the key row delegation button [KEY1] and press the 
DME button ([DME1] to [DME4]) that is lit green.
The button goes off, and this ends the assignment.

Selecting the video signal for a DME assigned to a key
When using the dedicated interface, proceed as follows.

1 In the cross-point control block, press the key row delegation button 
[KEY1].

The assigned DME button lights amber.

2 Press the DME button (one of [DME1] to [DME4]) lit amber, which then 
lights green.

3 To select the video signal for the side of the DME image that is currently 
visible, make the signal selection in the key row.

4 To select the video signal for the side of the DME image that is currently 
not visible (the back side), hold down the DME button (one of [DME1] to 
[DME4]) and make the signal selection in the key row.

When two or more DME channels are assigned, select the video signal for each 
DME in the same way.

When using the SDI interface
For keyer channels 3 and 4, select the video signals on the AUX bus assigned 
in a Setup menu (Engineering Setup >Switcher >Device Interface >DME 
Setting >DME SDI Interface).
In setup (Engineering Setup >Switcher >Device Interface menu), if “Up to 
3Keys” is selected, the second channel video signal is also selected on the AUX 
bus.

For details, see “Interfacing With External Devices (Device Interface Menu)” 
in Chapter 19 (Volume 3).
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Key Setting Operations With the Key 
Control Block

This section describes the basic procedures for key settings using the key 
control block.

Key control block

Operations in the Key Control Block

Parameter adjustment with the knobs
When the button for a function requiring parameter settings is pressed (that is, 
on), you can set the parameters with the four knobs. If there are more than four 
values to be assigned to the knobs, the [MORE] button lights amber. At this 
point, press the [MORE] button, which turns green, to assign the fifth and 
subsequent parameters to the knobs, so that the parameter settings can be made.
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Selecting the bank and keyer
To make key settings, first select the bank (from M/E-1 to M/E-3 and PGM/
PST) and keyer, then assign them to the key control block.
For example, to set key 1 on M/E-1 with the key control block, use the 
following procedure.

1 Using the M/E delegation buttons in the key control block, press the [M/
E1] button, setting it on.

2 Using the key delegation buttons in the key control block, press the 
[KEY1] button, setting it on.

This assigns the key control block to M/E-1 key 1.

Selecting the key type
To select the key type, press one of the key type selection buttons in the key 
control block.
[LUM] button: luminance key
[LIN] button: linear key
[CRK] button: chroma key
[CVK] button: color vector key
[PTN] button: key wipe pattern key

When using a wipe pattern key as the key type, in the <Key Type> group 
of the Type menu for the keyer, select [Wipe Pattern] and make the 
settings.

For an overview of the key types, see “Key Types” (page 138).

The button you pressed lights green, and you can now adjust the parameters 
with the knobs. The display beside each knob shows the first letter of the 
parameter name and the three-digit setting value.

• When the [LUM] or [LIN] button is lit green

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109 to –7

2 Gain Key sensitivity –100 (shown as –00) 
to +100

3 Density Key density 0 to 100

4 Filter Filter coefficient 1 to 9
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• When the [CRK] button is lit green

• When [Key Active] is off, only the parameters Hue and Density are 
displayed.

• When both [Key Active] and [Color Cancel] are off, only the parameter 
Density is displayed.

• When the [CVK] button is lit green

• When the [PTN] button is lit green

Selecting key fill
Select whether to use a color matte as key fill, or the signal on the key fill bus.

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 0 to 100

2 Gain Key sensitivity –100 (shown as –00) 
to +100

3 Hue Hue 0 to 359

4 Density Key density 0 to 100

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for Y signal +109  to –7

2 Y Gain Y signal sensitivity –100 (shown as –00) 
to +100

3 C Clip Reference level for chrominance 
signal

100 to 0

4 C Gain Chrominance signal sensitivity –100 (shown as –00) 
to +100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Y signal filter coefficient 1 to 9

2 C Filter Chrominance signal filter coefficient 1 to 9

4 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Density Key density 0 to 100
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When using a color matte: Press the [MATTE FILL] button, setting it on. The 
button lights green, and you can now set the parameters with the knobs.

When [Mix Color] is selected in the key fill Matte Adjust menu, you can 
further adjust color 2.

When [Mix Color] is on, and the [MORE] button is lit amber

When [Mix Color] is on, and the [MORE] button is lit green

When using the key fill bus signal: Press the [MATTE FILL] button, turning 
it off. 
To select the key fill signal, use the key bus buttons in the cross-point 
control block.

Selecting key source
• To use the key source paired with the key fill signal selected on the key fill 

bus, press the [AUTO SEL] button, turning it on. The pairing of the cross-
point buttons for key fill and key source is carried out in the Setup menu. (See 
“Cross-Point Settings (Xpt Assign Menu)” in Chapter 19 (Volume 3).)

• To select key source independently of the key fill signal selected on the key 
fill bus and paired with key source, hold down the key delegation button 
[KEY1], then press the desired key row button in the cross-point control 
block.

• To use as key source the same signal as the key fill signal selected on the key 
fill bus, select the SELF mode by pressing the [AUTO SEL] button and 
[SPLIT] button simultaneously so that both are off. When chroma key is 
selected as the key type, select the SELF mode.

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100

3 Hue Color 1 hue 359 to 0

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100

3 Hue Color 1 hue 359 to 0

4 Size Pattern size 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Color 2 luminance 0 to 100

2 Saturation Color 2 saturation 0 to 100

3 Hue Color 2 hue 359 to 0

4 Soft Edge softness 0 to 100
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Key Edge Modifications

To apply a modification to the key edge, press one of the edge type selection 
buttons in the key control block.

[BDR] button: border
[DROP BDR] button: drop border
[SHDW] button: shadow
[OUTLINE] button: outline
[EMBOS] button: emboss

For an overview of the edge modifications, see “Edge modifiers” (page 140).

The pressed button lights green, and you can now adjust the parameters with 
the knobs. The display beside each knob shows the first letter of the parameter 
name and the three-digit setting value.

Setting the border parameters
When the [BDR] button is lit green, the parameter settings depend on the key 
type and whether the separate edge function is active. To activate the separate 
edge function, press [Separate Edge], setting it on, in the Edge menu for the 
key.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The border width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

Knob Parameter Adjustment Setting values

1 Width Border width 0 to 8 a)

(0 to 100) b)

4 Density Border density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)
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a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0 to 4.

To adjust the edge fill color
When [BDR] is selected, the [MORE] button lights amber. Pressing the 
[MORE] button to turn it green then allows you to adjust the edge fill color 
parameters with the knobs.

Setting the drop border or shadow parameters
When the [DROP BDR] or [SHDW] button is lit green, the parameter settings 
differ between the “key drop OFF” and “key drop ON” modes (see page 141) 
as shown below. Switching between these two modes is made by turning the 
[KEY DROP] button on or off.

• “Key drop OFF” mode

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0 to 4.

• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0 to 4.

To adjust the edge fill color
When [DROP BDR] or [SHDW] is selected, the [MORE] button lights amber. 
Pressing the [MORE] button to turn it green then allows you to adjust the edge 
fill color parameters with the knobs.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 180

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100
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Setting the outline parameters
When the [OUTLINE] button is lit green, the parameter settings depend on the 
key type and whether the separate edge function is active. To activate the 
separate edge function, press [Separate Edge], setting it on, in the Edge menu 
for the key.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The outline width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 161) is on, the setting value range is 0 to 4.

When [Outline] is selected with separate edge on, the [MORE] button lights 
amber. Pressing the [MORE] button to turn it green then allows you to adjust 
the key fill density parameter with a knob.

Setting the embossing parameters
When the [EMBOS] button is lit green, adjust the following parameters.

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Width Outline width 0 to 8 a)

(0 to 100) b)

4 Density Outline density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)

Knob Parameter Adjustment Setting values

4 Density Outline density 0 to 100
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Selecting a normal edge
When all five edge type selection buttons are off, a normal edge is selected. If 
one of the buttons is lit, press it, turning it off. 

Softening the edge
Press the [SOFT EDGE] button, turning it on. The button lights green, and you 
can now adjust the softness with the knob.

• For a normal edge, when [SOFT EDGE] is enabled, “Key Drop” mode turns 
on.

• When a luminance key or linear key is selected as the key type, and clean 
mode is enabled, enabling [SOFT EDGE] ends the clean mode.

Applying the zabton effects

When the [ZABTN] button is lit green, adjust the following parameters.

Press the [MORE] button lit amber, changing it to green, then adjust the 
following parameters.

Knob Parameter Setting values

1 Width 0 to 4

2 Position 359 to 0

4 Density 0 to 100

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Pattern edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100
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Masks

Using the main mask
In the key control block, press the [MAIN MASK] button, turning it on. 
The parameter settings depend on the mask source selected as [Box] or 
[Pattern] in the <Mask Source> group of the Main Mask menu for the key.

• When box is selected

When box is selected and the [MORE] button is lit amber, there are more 
settings. Press the [MORE] button, so that it changes from amber to green to 
make the extra setting.

• When pattern is selected

a) The pattern is the same as a standard wipe. (See “Wipe Pattern List” (page 353).)

Using the subsidiary mask
In the key control block, press the [SUB MASK] button, turning it on. The 
parameter settings depend on the mask source selected as [Wipe] or [Utility 1 
Bus] in the <Mask Source> group of the Sub Mask menu for the key.

• When wipe is selected

Knob Parameter Adjustment Setting values

1 Top Top position –100 (shown as –00) to +100

2 Left Left position –100 (shown as –00) to +100

3 Right Right position –100 (shown as –00) to +100

4 Bottom Bottom position –100 (shown as –00) to +100

Knob Parameter Adjustment Setting values

1 Soft Box softness 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100
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• When utility 1 bus is selected

Applying a DME Effect to a Key

Note

For one M/E bank, DME effects (including DME wipes) can be used in up to 
two places on the dedicated interface and in only one place on the SDI interface 
simultaneously.
When combining the SDI interface with the dedicated interface, you can apply 
DME effects to a maximum of three keys. (Requires a setting in setup.)

Assigning a DME to a key

1 In the key control block, press the delegation buttons [M/E1] and [KEY1].

2 Using the DME channel selection buttons, select the DME channel (DME1 
to DME4) for applying the effect.

The lit colors of the [DME1] to [DME4] buttons indicate the DME 
assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

Note

When assigning two to four DME channels to one key, the selected DME 
channels must be successive.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.
The later selection is valid, and the button lights green.

You can check the DME operating status in the Status menu (see page 320).

Knob Parameter Adjustment Setting values

1 Clip Reference level for 
creating mask signal

+109 to –7

2 Gain Gain –100 (shown as –00) to +100
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Selecting the video signal for the DME assigned to a key

For the operating procedure, see“Selecting the video signal for a DME 
assigned to a key” (page 174).

Assigning the DME output signal to a monitor signal

1 Holding down the output destination specification button [MON] in the 
key control block, use the DME channel selection buttons to select the 
DME channel (DME1 to DME8) you want to use.

The selected DME output is assigned to DME MON V and DME MON K.

2 To check the DME assignment status, hold down just the [MON] button.

While it is held down, the lit color of the [DME1] to [DME4] buttons 
shows the key assignment status.
Lit green: Shows the DME currently being monitored.
Lit amber: Shows a DME which can be monitored.
Off: DME is not assigned.

Other Key Setting Operations

Using an external processed key
You can select and use the key processed keyer key fill and key source signals 
on the AUX buses.

1 Select the keyer to be allocated.

2 In the key control block, press [PROC KEY], turning it on.

The button lights amber, and on the currently selected keyer, the key fill 
and key source are assigned to reentry signals PROC V and PROC K.

When a DME is selected on the currently selected keyer, the key fill and 
key source signals to which the DME effect is applied are assigned to 
PROC V and PROC K.

Note

You cannot select the PROC V and PROC K signals using the cross-point 
selection buttons of the M/E or PGM/PST bank.
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Using a frame memory feed
When you press the [FM FEED] button in the key control block, it lights 
momentarily amber, then the key fill and key source signals processed in the 
currently selected keyer are assigned to frame memory sources 1 and 2.
If a DME is selected on the currently selected keyer, then the key fill and key 
source signals to which a DME effect is applied are assigned to frame memory 
sources 1 and 2.
Carrying out a frame memory feed causes the [PROC KEY] button to light 
amber.

Using the show key function
While the [SHOW KEY] button is held down, the key-processed key source 
signal appears on the specified output. (Show key mode)
Even when the [SHOW KEY] button is released, for a preset time the show key 
mode is maintained. You can specify the output to which the show key function 
is applied and set the time for which the show key mode is maintained after 
releasing the button in a Setup menu.

For details see “Settings Relating to Keys, Wipes, Frame Memory and Color 
Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 (Volume 3).

Using the auto delegation function
To couple the selection in the key delegation buttons of the independent key 
transition control block so that the key control block delegation selection is 
automatically switched, in the key control block press the [AUTO DELEG] 
button, turning it on.

Returning the key adjustment values to their defaults
Holding down a key type button ([LUM], [LIN], [CRK], [CVK], or [PTN]) 
recalls the key default values (page 144).

Key modify clear
When an M/E delegation button is held down, holding down a key delegation 
button together returns the key settings to the initial status settings.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 18 (Volume 3).
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Key Snapshots

Key settings other than the key on/off status and the key priority can all be 
instantaneously saved in a dedicated register, for recall when required. A key 
snapshot comprises three values: a cross-point button number, key memory full 
mode, and independent key transition, and can be called in any combination.
There are four key snapshot registers for each keyer.

Key Snapshot Operations

Key snapshot operations are carried out in the downstream key control block 
(MKS-8032 DSK Fader Module). Each keyer is provided with four dedicated 
key snapshot registers.

Independent key transition control block (MKS-8032)

DSK1 DSK2 WIPEUNDO

DSK3 DSK4 SHIFT MIX

K-SS

CUT

DME

K-SS
STORE

DSK1
ON

DSK2
ON

DSK3
ON

DSK4
ON

TAKETAKETAKETAKE

Key source name display/key snapshot buttons

Key snapshot setting buttons

Independent key transition type 
selection buttons

Independent key transition execution section

Key delegation buttons
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Saving a key snapshot
For example, the following procedure saves the state of the DSK1 settings.

1 Press the key delegation button [DSK1], turning it on.

2 Press the [K-SS] button, turning it on. 

The system switches to key snapshot mode, and the key source name 
display/key snapshot buttons show the status of registers 1 to 4 for DSK1.
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
For a register holding a snapshot, the register name is shown as up to eight 
characters.

3 Hold down the [K-SS STORE] button, and press the key source name 
display/key snapshot button corresponding to the register in which you 
want to save the snapshot.

The key source name display/key snapshot button which you pressed lights 
yellow.

Note

If you save a key snapshot in a register for which the button is lit orange or 
yellow, the existing contents of the register are overwritten.

Recalling a key snapshot
For example, the following procedure recalls the state of the DSK1 settings.

1 Press the key delegation button [DSK1], turning it on.

2 Press the [K-SS] button, turning it on.

3 Press the key source name display/key snapshot button corresponding to 
the register you want to recall.

The button you pressed lights yellow, and this recalls the key snapshot.
To cancel the recall, press the [UNDO] button.
Key Snapshots
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Overview

A wipe is a transition from the current video stream to a new video stream, 
using a wipe pattern. 
Changing the background by means of a wipe is referred to as a “background 
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition,
and those that can be selected in an independent key transition.

For details of independent key transitions, see page 131.

Types of Wipe Pattern

The patterns that can be used for a wipe are divided into a number of groups, 
as follows. Note that only the standard wipe patterns can be used for an 
independent key transition.

For wipe patterns, see “Wipe Pattern List” in Appendix (Volume 1) (page 
353).

Standard wipe patterns
Patterns consisting of straight lines vertically, horizontally, or diagonally, and 
circular patterns.

Enhanced wipes
More complex shapes such as hearts, stars, and round corners.

Rotary wipes
These patterns involve rotation of the image about a point.

Mosaic wipe pattern
This divides the image into small tiles.

Random and diamond dust wipe patterns
These patterns consist of small random tiles, or fine particles.
Overview
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Basic Procedure for Wipe Settings

You carry out wipe setting operations principally using the Wipe menu for each 
of the M/E-1 to M/E-3 and PGM/PST banks.
This section describes the basic procedures for wipe settings, taking the M/E-
1 >Wipe menu as an example.

For details of independent key transition wipe settings, see “Wipe Settings for 
Independent Key Transitions” (page 216).

Wipe Settings Menu

Accessing the wipe settings menu
To access the M/E-1 >Wipe menu, use either of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF5 ‘Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [WIPE] twice in rapid succession.
Any of the above operations displays the M/E-1 >Wipe menu.

Wipe Pattern Selection

Selecting a wipe pattern by a menu operation

1 In the M/E-1 >Wipe menu, select HF1 ‘Main Pattern.’

The Main Pattern menu appears.

2 Select the wipe pattern group with the pattern group selection button.

Standard: standard wipes
Enhanced: enhanced wipes
Rotary: rotary wipes
Mosaic1 to Mosaic3: mosaic wipes
Random/Dust: random/diamond dust wipes

The patterns from the selected pattern group appear on the screen.

For details of wipe patterns, see “Types of Wipe Pattern” (page 190) and 
“Wipe Pattern List” (page 353).
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3 Press the button to select the desired pattern.

4 The parameters change according to the selected pattern, and you can 
adjust the pattern.

• When a polygon wipe is selected (pattern number 49)

a) A value of –100.00 completely removes the star “rays,” leaving a circle; at +100.00 the 
“rays” are at their sharpest.

• When a mosaic wipe is selected (pattern numbers 200 to 203, 206 to 
213, 224 to 247, 250 to 257, 260 to 269)

• When a karaoke wipe is selected (pattern numbers 220 to 223)

a) At –100.00 tiles appear from the top (or left edge) of the screen; at +100.00 from the 
bottom (or right edge) of the screen.

b) At –100.00 all rows appear simultaneously; at +100.00 until one row of tiles is completely 
displayed, the next row does not start to appear.

• When a random wipe is selected (pattern number 273)

• When a diamond dust wipe is selected (pattern number 274)

Knob Parameter Adjustment Setting values

1 No Number of points 3 to 64

2 Star Rate Angularity of star –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Tile No Number of tiles horizontally 2 to 36

2 V Tile No Number of tiles vertically 2 to 18

Knob Parameter Adjustment Setting values

1 Start Position of start tile –100.00 to +100.00 a)

2 Row No Number of rows of tiles 1 to 36

3 Phase Delay for next row –100.00 to +100.00 b)

Knob Parameter Adjustment Setting values

1 H Size Tile width 0.00 to 100.00

2 V Size Tile height 0.00 to 100.00

3 Volatility Rate of tile generation 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Size Particle width 0.00 to 100.00

2 V Size Particle height 0.00 to 100.00

3 Flash Rate Rate of generation of particles 0.00 to 100.00
Basic Procedure for Wipe Settings



  C
hapter 5 

W
ipes
Note

When Flash Rate is set to 0.00, you cannot change the pattern. In this state, 
adjusting H Size or V Size has no effect on the pattern.

For details of a pattern mix, see the next section.
For details of applying pattern modifiers, see “Setting Wipe Modifiers” 
(page 198).

Pattern Mix

You can create a new pattern by combining two selected patterns (main and 
“sub”).

Note

It is not possible to apply a pattern mix to an independent key transition.

Types of pattern mix
There are four ways in which patterns can be combined in a pattern mix, as 
follows.
Mix: The effect of the sub pattern is applied to the main pattern, modifying the 

outline or nature of the main pattern.
Positive NAM (+Nam): Creates a pattern with an outline which contains all 

points within the outlines of either of the main pattern and the sub pattern.
Negative NAM (–Nam): Creates a pattern with an outline which contains all 

points within the outlines of both of the main pattern and the sub pattern. 
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Morphing: As the transition progresses, the pattern morphs from the main 
pattern, through the “mix” combination, to the sub pattern.

Mix Positive NAM Negative NAM
Basic Procedure for Wipe Settings



  C
hapter 5 

W
ipes
• A value of 0.00 corresponds to the beginning of the transition, and a value of 
100.00 to the end of the transition.

• A negative Start value signifies that the main and sub patterns are already 
combined when the transition starts.

• An End value of 100.00 or more signifies that the main and sub patterns are 
still combined when the transition complete.

• If the Start and End values are the same, the main and sub patterns are 
interchanged instantaneously at the corresponding point in the transition.

• If End is less than Start, as the transition proceeds, it changes from the sub 
pattern to the main pattern.

Dust mix
You can apply the effect of a diamond dust wipe to a selected pattern. You can 
also apply the diamond dust wipe effect to the pattern resulting from a pattern 
mix. (See “Pattern Mix” (page 193).)
When the pattern mix function is off, turning dust mix on results in the main 
pattern and the diamond dust pattern being mixed. This state is the same as a 
pattern mix when the diamond dust pattern is selected for the sub pattern.

10.00

0.00

–10.00

110.00

100.00

0.00 100.00

90.00

Mix ends during 
transition, which 
ends with sub 
pattern at 100%

Main pattern at 100%

Sub pattern at 100%

Parameter settings
Start: Point in the course of the 

transition at which the main pattern 
is at 100%

End: Point in the course of the transition 
at which the sub pattern is at 100%

Transition (0.00 - 100.00)

Start 
value

End 
value

Mix combination of 
main and sub 
patterns already 
begun

Ends with sub 
pattern at 100%

Begins with main 
pattern at 100%

Transition ends 
with main and 
sub patterns 
still in mix 
combination

Mix begins after 
transition starts
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Main and sub modifier link function
When carrying out a pattern mix, it is possible to link the modifier settings for 
the main pattern and sub pattern. There are two modes for this function.

FULL LINK (fully linked) mode
In this mode, all modifier settings are the same for the main pattern and sub 
pattern.
Changing the modifier settings for one pattern automatically changes the 
settings for the other.

SEMI LINK (semi-linked) mode
Only the parameter settings of the modifiers are linked. The modifier on/off 
settings are not linked. When the parameter values for the modifiers of the main 
pattern and sub pattern are different, then after this link mode is selected, 
changing the value of a parameter for one pattern changes the value of the 
parameter for the other pattern to maintain the same difference between the 
two.

Note 

When carrying out a wipe transition using a pattern mix, it is recommended that 
you set the modifier link function to “FULL LINK” mode.
If the link function is off, or SEMI LINK mode is selected, the desired effect 
may not be obtained at the start or end of the transition.

Combining two patterns
You can combine two selected patterns (referred to as main and “sub”) to form 
a new pattern. Select a main pattern in the Main Pattern menu, then use the 
following procedure.

1 In the M/E-1 >Wipe menu, select HF3 ‘Sub Pattern.’

The Sub Pattern menu appears.

2 In the same way as for the main pattern, select the sub pattern.

The patterns that can be selected for the sub pattern depend on the pattern 
selected for the main pattern (see the following table).
Basic Procedure for Wipe Settings
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Possible combinations of main pattern and sub pattern

Yes: Combination possible    No: Combination not possible

3 Select HF2 ‘Pattern Mix.’

The Pattern Mix menu appears.

4 In the <Pattern Mix> group, select the type of pattern mix.

Mix: mix
+Nam: positive Nam
–Nam: negative Nam
Morphing: morphing

For an overview of types of pattern mix, see “Types of pattern mix” (page 
193).

5 Depending on the selection in step 4, set the following parameters.

• When mix, positive Nam, or negative Nam is selected

• When morphing (see page 194) is selected

6 In the <Main/Sub Link> group, make the main/sub modifier link function 
settings. (See “Main and sub modifier link function” (page 196).)

Full: fully linked mode

 Main 
pattern

Sub pattern

Standard Enhanced Rotary Mosaic Random/
diamond 
dust 

Standard Yes Yes No Yes Yes

Enhanced Yes Yes No Yes Yes

Rotary No No No No No

Mosaic Yes Yes No No Yes

Random/
diamond 
dust

Yes Yes No Yes No

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of sub pattern to the 
main pattern

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 Start Point in transition at which main 
pattern is at 100%

–50.00 to +150.00

3 End Point in transition at which sub 
pattern is at 100%

–50.00 to +150.00
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Semi: semi-linked mode

Applying the effect of a diamond dust wipe to the selected 
pattern (Dust mix)

1 In the Pattern Mix menu, press [Dust Mix], turning it on.

2 Set the following parameters as required.

You can also apply the dust mix function to the pattern generated by a 
pattern mix.

Note

When a random/diamond dust wipe (pattern numbers 270-274) is selected, 
the dust mix function is not available.

Setting Wipe Modifiers

You can apply various modifiers to the wipe pattern: setting the wipe direction, 
pattern position, and so on.

Note that the available modifiers may depend on the pattern you are using. For 
details, see “Possible combinations of wipe patterns and modifiers” (page 
215).

Main pattern and sub pattern modifiers
You can make independent settings of the modifiers for the main pattern and 
sub pattern.
• To set the modifiers for the main pattern, in the M/E-1 >Wipe menu, select 

HF5 ‘Main Modify,’ and make the settings in the Main Modify menu.
• To set the modifiers for the sub pattern, select HF6 ‘Sub Modify,’ and make 

the settings in the Sub Modify menu.
Operations in the Main Modify menu and Sub Modify menu are the same.

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of diamond dust 
pattern in mix

0.00 to 100.00

2 H Size Particle width 0.00 to 100.00

3 V Size Particle height 0.00 to 100.00

4 Flash Rate Rate of generation of particles 0.00 to 100.00
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Independently set modifiers for the main pattern and sub pattern
• Positioner
• Rotation
• Aspect ratio
• Pattern replication (MULTI)
• Pairing
• Modulation
• Spring
• Spiral

The following sections show examples of modifying the main pattern.

Specifying the wipe direction (Direction)
You can specify the direction of the wipe: the regular direction is referred to as 
“normal,” and the other direction as “reverse.” You can also select alternating 
directions each time the transition is completed (normal/reverse mode).

To specify the wipe direction in a menu

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction> group, specify the wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the wipe direction with a button in the transition control 
block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
NORM: Normal
NORM/REV: Normal/reverse
REV: Reverse

Normal Reverse
199Basic Procedure for Wipe Settings
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Splitting the wipe pattern (Split)
This splits the pattern, making the parts of the wipe move in opposite 
directions.

The parameter Split No specifies the number of splits.
The parameter Spacing specifies the spacing between adjacent patterns.

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Press [Split], turning it on.

3 Set the following parameters.

Modifying the wipe pattern edge (Edge)
You can apply a border to the pattern, soften the edges, or soften the applied 
border.

Border: You can adjust the border width.

Split onSplit off

Knob Parameter Adjustment Setting values

1 Split No Number of splits 1 to 4 (integer)

2 Spacing Spacing between adjacent 
patterns

0.00 to 100.00

Border Soft Soft border
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Soft: You can adjust the edge softness.
Soft border: You can adjust the border width, and the softness of the inner and 

outer edges of the border.
When a border or soft border is selected, the signal filling the border is called 
edge fill. For the edge fill, you can use a matte generated by the dedicated color 
matte generator, or the signal selected on the utility 2 bus. A matte can include 
color 1 and color 2, and a combination of the two colors (a “color mix”).

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Edge> group, select the edge type.

Border: border
Soft: soft edge
Soft Border: soft border

3 Set the parameters according to the selection in step 2.

• When border is selected

• When soft edge is selected

• When soft border is selected

4 When you selected border or soft border, select the edge fill signal in the 
<Edge Fill> group.

Utility 2 Bus: signal selected on the utility 2 bus
Matte: signal from the dedicated color matte generator

5 Depending on the operation in step 4, carry out the following operation.

When ‘Utility 2 Bus’ is selected: Press the key delegation button 
[UTIL2], turning it on, and select the signal in the key row.

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Outer Soft Border outer softness 0.00 to 100.00
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When ‘Matte’ is selected: In the same Edge/Direction menu, press [Matte 
Adjust] to display the Matte Adjust menu, then adjust the single-color 
or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Edge Matte> group.
Flat Color: Adjust color 1 with the following parameters.

When you select [Mix Color] for a two-color combination, see the next 
paragraph.

Carrying out a color mix for the edge fill matte
When you selected [Matte] for the border or soft border edge fill, you can 
combine color 1 and color 2.
For the combination, you can use not only a normal wipe generator pattern, but 
also the dedicated color mix pattern.

1 In the <Edge Fill> group of the Edge/Direction menu, select [Matte], and 
press [Matte Adjust].

The Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 In the <Mix Pattern> group, make one of the following selections.

Wipe: Use the wipe pattern selected for the transition.
Pattern: Use the dedicated pattern.

4 Depending on the selection in step 3, set the following parameters.

• When Wipe is selected

• When Pattern is selected

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00
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a) The patterns are the same as for a standard wipe. See “Wipe Pattern List” (page 353).

If you selected Pattern, you can also carry out the pattern selection by 
pressing the [Mix Ptn Select] button in the Matte Adjust menu, to display 
the Mix Ptn Select menu. Select any pattern appearing in the Mix Ptn 
Select menu (wipe patterns 1 to 24) by pressing the appropriate button, and 
you can then adjust the following parameters.

5 If you selected Pattern in step 4, if required, the following modifiers can 
be added. After selecting a wipe mix, skip to step 6.

• When turning [Position] on and setting the pattern position

a) See page 204.

• When turning [Multi] on and using replications of the same pattern

a) See page 209.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 208.

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)
203Basic Procedure for Wipe Settings



204

   C
hapter 5 

W
ipes
• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 206.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 206.

6 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on, 
then adjust the parameters.

7 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Setting the wipe position (Positioner)
When you turn on this function, you can move the wipe pattern to any position.

• The parameter H Position controls the horizontal position of the pattern.
A negative value moves the pattern to the left, and a positive value moves the 
pattern to the right.

• The parameter V Position controls the vertical position of the pattern. 
A negative value moves the pattern down, and a positive value moves the 
pattern up.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Positioner onPositioner off
Basic Procedure for Wipe Settings



  C
hapter 5 

W
ipes
You can set the position independently for the main pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Position> group, press [Position], turning it on, and set the pattern 
position.

To return the pattern position to the center of the screen
In the <Position> group, press [Center].

To move the pattern from its current position to the center through 
the course of a transition
In the <Position> group, press [Auto Center], turning it on.

To set the wipe position using the trackball
You can also set the wipe position using the trackball in the device control 
block. 

1 In the device control block, press the [M/E1] or [P/P] button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

2 Press the [MAIN] button or [SUB] button, turning it on.

3 Press the [POS] button, turning Position on.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00

2 Position V Vertical position –200.00 to +200.00

Table 1: Buttons and assigned settings

Button name Setting

MAIN Wipe position for common transition (main pattern)

SUB Wipe position for common transition (sub pattern)

Table 2: Buttons assigned to functions

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the center of the screen.
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4 Move the trackball or joystick, to set the wipe position. By pressing the [X] 
button, turning it on, you can restrict movement to the horizontal direction, 
and by pressing the [Y] button, turning it on, you can restrict movement to 
the vertical direction. 

Rotating the wipe pattern (Rotation)
You can rotate the pattern. There are three rotation modes, as follows.

Angle
This carries out a wipe with the pattern in a fixed angle.

The parameter Angle determines the angle of pattern rotation. 
A value of –100.00 of the parameter Angle corresponds to one whole turn 
counterclockwise; a value of +100.00 corresponds to one whole turn 
clockwise.
With a value of 0.00 there is no rotation.

Speed
Through the course of the transition the wipe pattern rotates at a fixed specified 
speed.

The parameter Speed determines the speed of pattern rotation. 
A value of –100.00 of the parameter Speed corresponds to one turn per second 
counterclockwise; a value of +100.00 corresponds to one turn per second 
clockwise. With a value of 0.00 the pattern is stationary.

Angle off Angle on
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Magnitude
Through the course of the transition the wipe pattern rotates through the 
specified angle. 

The parameter Angle determines an angle of pattern inclination at the 
beginning of the transition.
• A value of –100.00 corresponds to the angle rotated one whole turn 

counterclockwise.
• A value of +100.00 corresponds to the angle rotated one whole turn 

clockwise.
• With a value of 0.00 the pattern is stationary.
The parameter Magnitude determines an angle of pattern rotation through the 
course of the transition.
• A value of –200.00 corresponds to a rotation of two turns counterclockwise.
• A value of +200.00 corresponds to a rotation of two turns clockwise.
• With a value of 0.00 the pattern is stationary.

You can apply rotation independently to the main pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Rotation> group, select the rotation type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a fixed rate.
Magnitude: Rotate through a particular angle during the course of the 

transition.

3 According to the selection in step 2, set the following parameters.

• When Angle is selected

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00
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• When Speed is selected

• When Magnitude is selected

Setting the wipe pattern aspect ratio (Aspect ratio)
You can freely change the aspect ratio of the pattern.

A negative value of the parameter Aspect stretches the pattern vertically; a 
positive value stretches the pattern horizontally.

You can set the aspect ratio independently for the main pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Aspect], turning it on.

3 Set the following parameter.

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

–100.00 to +100.00

2 Magnitude Angle of rotation through course 
of transition

–200.00 to +200.00

Aspect off Aspect on

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00
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Setting the wipe pattern replication (Multi)
The same pattern can be repeated horizontally and vertically or both, up to 63 
times. You can also change the orientation of alternate copies, or change the 
position.

• The parameter H Multi determines the number of pattern replications 
horizontally, and the parameter V Multi determines the number of pattern 
replications vertically.

• The parameter Shift determines the manner of replication.
At a value of –100.00, the pattern of the adjacent odd-numbered column on 
the left lines up with the central coordinate horizontally.
At a value of +100.00, the pattern of the adjacent odd-numbered column on 
the right lines up with the central coordinate horizontally.

For an independent key transition wipe, you can use the “Invert Type” 
parameter to select from the following four types of replication pattern.

1: All replications in the same orientation
2: Even-numbered rows staggered
3: Even-numbered columns and rows inverted
4: Even-numbered columns and rows inverted, and even-numbered rows 

staggered

You can set pattern replication independently for the main pattern and sub 
pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

“Multi” off “Multi” on

1 2 3 4
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2 Press the [Multi] button, turning it on.

3 Set the following parameters.

4 To make more adjustments, press the [Multi Adjust] button.

The Multi Adjust menu appears.

5 Make the following settings, as required.

H Invert: When this is on, alternate tiles are inverted left-to-right.
V Invert: When this is on, alternate tiles are inverted top-to-bottom.
Non-Mask: When this is on, even if the positioner function is used to 

move the pattern position, the pattern is always present on the screen.
Position: By adjusting the following parameters, move the pattern position 

within the divisions determined in step 3.

a) See page 204.

Making a wipe pattern like a Venetian blind (Pairing)
This slits the pattern into multiple strips, making it like a venetian blind.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.
• The parameter Width determines the width of the slits.

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Shift Replication layout –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position of pattern –200.00 to +200.00 a)

2 Position V Vertical position of pattern –200.00 to +200.00 a)

Pairing off Pairing on
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• The parameter H Offset determines the spacing in the horizontal direction.
If a negative value is set, the even-numbered pairs of strip and slit move to 
the left, and the odd-numbered pairs move to the right. (The value –100.00 
represents the maximum movement.)
If a positive value is set, the even-numbered pairs of strip and slit move to 
the right, and the odd-numbered pairs move to the left. (The value +100.00 
represents the maximum movement.)

• The parameter V Offset determines the spacing in the vertical direction.
If a negative value is set, the even-numbered pairs of strip and slit move 
upward, and the odd-numbered pairs move downward. (The value –100.00 
represents the maximum movement.)
If a positive value is set, the even-numbered pairs of strip and slit move 
downward, and the odd-numbered pairs move upward. (The value +100.00 
represents the maximum movement.)

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Pairing> group, select the slit direction.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.

3 Set the following parameters.

Applying modulation to the wipe pattern (Modulation)
The pattern signal can be modulated, giving waves on the horizontal or vertical 
edges, or radially. 
The parameter Shape determines the form of the modulation.
1: sine wave, 2: triangular wave, 3: rectangular wave

Knob Parameter Adjustment Setting values

1 Width Width of the slits 1 to 128 (integer)

2 H Offset Spacing in the horizontal direction –100.00 to +100.00

3 V Offset Spacing in the vertical direction –100.00 to +100.00
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Horizontal modulation
This modulates the pattern, applying waviness in the horizontal direction to 
edges.

The parameter Speed determines the speed of waves.
A value of –100.00 generates the maximum downward speed of waves, and a 
value of +100.00 the maximum upward speed.

Vertical modulation
This modulates the pattern, applying waviness in the vertical direction to 
edges.

The parameter Speed determines the speed of waves.
A value of –100.00 generates the maximum leftward speed of waves, and a 
value of +100.00 the maximum rightward speed.

Fringe
This modulates the pattern, applying waviness in the radial direction to edges.

The parameter Speed determines the speed of waves. 
A value of –100.00 generates the maximum counterclockwise speed of waves, 
and a value of +100.00 the maximum clockwise speed.

You can apply modulation independently to the main pattern and sub pattern.
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1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Depending on the desired effect, in the <Modulation> group select one of 
the following.

H (Horizontal modulation): Modulate the pattern, applying waviness in 
the horizontal direction to edges.

V (Vertical modulation): Modulate the pattern, applying waviness in the 
vertical direction to edges.

Fringe (Radial modulation): Modulate the pattern, applying waviness in 
the radial direction to edges.

3 Set the following parameters.
.

Applying barrel or pincushion distortion to the edge of the wipe 
pattern (Spring)

As the transition progresses, the edge of the pattern is subjected to barrel or 
pincushion distortion.

A negative parameter value produces pincushion distortion, and a positive 
value produces barrel distortion.

You can set the spring function independently for the main and sub patterns.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves –100.00 to +100.00

4 Shape Form of the modulation 1 to 3

Spring off Spring on
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The Main Modify menu appears.

2 Press [Spring], turning it on.

3 Set the following parameters.

Applying a spiral effect to the wipe pattern (Spiral)
This deforms the pattern spirally.

• The parameter Magnitude determines the size and direction of the spiral.
A value of –100.00 represents the maximum movement in the 
counterclockwise direction, and a value of +100.00 represents the maximum 
movement in the clockwise direction.

• The parameter Wave Speed determines the speed of the lateral waves.
A value of –100.00 represents the maximum speed to the left, and a value of 
+100.00 represents the maximum speed to the right.

You can set the spiral function independently for the main and sub patterns.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Spiral], turning it on.

3 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Gain Degree of barrel distortion –100.00 to +100.00

Spiral off Spiral on

Knob Parameter Adjustment Setting values

1 Magnitude Size and direction of the spiral –100.00 to +100.00

2 Wave Speed Speed of the lateral waves –100.00 to +100.00
Basic Procedure for Wipe Settings



  C
hapter 5 

W
ipes
Possible combinations of wipe patterns and modifiers

Yes: Can be used    No: Cannot be used

a) Not patterns 1 to 16, 19, and 20
b) Not patterns 300 to 303
c) Not patterns 100 to 103, 150, 151, 516, 518, 604, and 606
d) Not patterns 1 to 8, 17, and 18
e) Not patterns 220 to 223
f) Not patterns 19 and 20
g) But patterns 21, 23 and 24 are possible
h) But patterns 21 and 23 are possible

Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then 
press VF5 ‘Wipe’ to return the wipe settings to their initial status.

For details of the menu operation to return the wipe state to that set in initial 
status, see “Returning to default state in function groupings” (page 77).

Modifiers Type of wipe

Standard Enhanced Rotary Mosaic Random/
diamond dust

Direction Yes Yes Yes Yes Yes

Split Yes Yes No Yes No

Edge Yes Yes Yes Yes Yes

Positioner Yes a) Yes b) Yes c) No No

Rotation Yes Yes Yes c) No No

Aspect ratio Yes d) Yes No No No

Pattern 
replication

Yes Yes Yes Yes e) No

Pairing Yes f) Yes No No No

Modulation
(H/V)

Yes Yes Yes No No

Modulation 
(Fringe)

No g) Yes No No No

Spring No g) Yes No No No

Spiral No h) Yes No No No
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Wipe Settings for Independent Key 
Transitions

You carry out independent key/downstream key transition wipe setting 
operations using the Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see “What is an independent 
key transition?” (page 131).

This section describes the independent key transition wipe settings, taking the 
M/E-1 >Key1 >Transition >Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition Wipe 
Settings

Accessing the independent key transition wipe settings menu
As an example, to access the M/E-1 >Key1 >Transition >Wipe Adjust menu, 
carry out the following operation.
• In the menu control block, select the top menu selection button [M/E 1] and 

select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1, then press [Wipe Adjust].

Carrying out the above operation displays the M/E-1 >Key1 >Transition 
>Wipe Adjust menu (which will be referred to below as simply the Key1 Wipe 
Adjust menu).

Selecting the independent key transition wipe pattern
You select the independent key wipe pattern from the list of patterns displayed 
in the menu.

Note 

In an independent key transition, you can only use the standard wipe patterns 
(pattern numbers 1 to 24).

To select a wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.

1 In the Key1 Wipe Adjust menu, select [Pattern Select].
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The Pattern Select menu appears.

2 Press the button for the desired pattern.

Setting Independent Key Transition Wipe Modifiers

Available modifiers
You can use the following modifiers with an independent key transition wipe.
Note that the available modifiers may depend on the pattern you are using.
• Direction
• Edge
• Positioner
• Rotation
• Aspect ratio
• Pattern replication

Setting the wipe direction (Direction)
In the <Direction> group of the Key1 Wipe Adjust menu, make any of the 
following selections.
Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

Softening the wipe pattern edge (Soft edge)

1 Press [Soft] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

Setting the wipe position (Positioner)
There are two methods of setting the wipe position: using the device control 
block, or in a menu.

To set the wipe position using the trackball
You can also set the wipe position using the trackball in the device control 
block.

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00
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1 In the device control block, press the [M/E1] or [P/P] button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

2 Press one of the buttons in Table 1 above, to select the wipe position to 
which the operation applies. Multiple selection is possible.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X] 
button, turning it on, you can restrict movement to the horizontal direction, 
and by pressing the [Y] button, turning it on, you can restrict movement to 
the vertical direction. 

To set the wipe position by a menu operation

1 Press [Position] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

a) See page 204.

Table 1: Buttons and assigned settings

Button name Setting

K1 CB1 Wipe position for independent key 1 transition

K2 
CB2

Wipe position for independent key 2 transition

K3 Wipe position for independent key 3 transition

K4 Wipe position for independent key 4 transition

Table 2: Buttons assigned to functions

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the center of the screen.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)
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To move the pattern from its current position to the center through 
the course of a transition
Press [Auto Center] in the <Position> group, turning it on.

Rotating the wipe pattern (Rotation)

1 In the <Rotation> group of the Key1 Wipe Adjust menu, select the rotation 
type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a speed rate.
Magnitude: Rotate the pattern through a fixed angle during the course of 

the transition.

2 According to the selection in step 1, set the following parameters.

• When Angle is selected

a) See page 206.

• When Speed is selected

a) See page 206.

• When Magnitude is selected

a) See page 207.

Setting the wipe pattern aspect ratio (Aspect ratio)

1 Press [Aspect] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

–100.00 to +100.00 a)

2 Magnitude Angle of rotation through course 
of transition

–200.00 to +200.00 a)
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a) See page 208.

Replicating the wipe pattern (Multi)

1 Press [Multi] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

a) See page 209.

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)
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Wipe Snapshots

You can snapshot and save a wipe pattern together with the current settings of 
its modifiers and pattern limit in a dedicated register for recall when required.
There are 10 wipe snapshot registers on each M/E bank and the PGM/PST 
bank. 
Use the menu to save and recall wipe snapshots. 

Wipe Snapshot Operations With the Menus

Menus used
As an example, when operating on M/E-1, select M/E-1 >Wipe >Wipe 
Snapshot.
The Wipe Snapshot menu appears.

Button displays
In setup you can select whether the memory recall buttons show the pattern 
number or register name.

See “Operation Settings (Operation Menu)” in Chapter 19 (Volume 3).

Memory recall buttons
221Wipe Snapshots



222

   C
hapter 5 

W
ipes
Saving a wipe snapshot from the menu

1 Set up the wipe you want to save.

2 In the Wipe Snapshot menu, press [Store], lighting it amber.

3 Press the memory recall button for the register in which you want to save.

Notes

• If you press a button which is already lit, this overwrites the contents of 
the register.

• When both the main pattern and sub pattern are selected for a pattern 
mix, the button in the memory recall section shows only the main 
pattern.

Recalling a wipe snapshot from the menu
In the Wipe Snapshot menu, press the memory recall button for the wipe 
snapshot you want to recall.
This recalls the wipe snapshot, and the button you pressed lights amber.
In the upper left is shown the currently recalled register name or number.

Note

The Flexi Pad and menu settings are linked.
A setting in setup determines whether register names or pattern numbers 
appear.

Deleting a wipe snapshot from the menu

1 In the Wipe Snapshot menu, press [Delete].

2 Press the memory recall button for the wipe snapshot you want to delete.

This deletes the wipe snapshot.
Wipe Snapshots
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Overview

A DME wipe is a wipe transition that uses a DME effect to change from one 
video image to the next.
There are two types of DME wipe: those which can be selected for a normal 
transition, and those which can be selected for an independent key transition.

For details of independent key transitions, see page 131.

Note

To carry out DME wipes requires the BKDS-9470 DME Board Set or the 
MVE-8000A/9000 Multi Format DME Processor.

Types of DME Wipe Pattern

The patterns used for a DME wipe fall into two broad classes.
Preset patterns: predetermined fixed patterns
User programmable DME patterns: patterns which you can create using 

keyframe effects

DME wipe execution mode and pattern numbers that can be used
There are three DME wipe execution modes, depending on the number of 
DME channels available: one-channel mode, two-channel mode and three-
channel mode. The pattern numbers that can be used in these modes are as 
follows.

DME wipe pattern groups
The patterns used in DME wipes fall into the following groups.

For each group (excluding user programmable DMEs), for schematic patterns 
and numbers, see “DME Wipe Pattern List” in Appendix (Volume 1) (page 
359). The black part of the pattern represents the old video, and the white part 
the new video, with the wipe taking place in the direction of the arrow.

Execution mode Preset pattern numbers 
that can be used

User programmable DME pattern 
numbers that can be used

One-channel mode 1000 series 1901 to 1999

Two-channel mode 2000 series 2901 to 2999

Three-channel mode 3000 series 3901 to 3999
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Slide: The new video slides in over the old video.

(Pattern numbers: 1001 to 1008 (one-channel mode), 2601 to 2608 (two-
channel mode))

Squeeze: The new video appears squeezed over the old video, and 
progressively expands to cover it.
(Pattern numbers: 1021 to 1031 (one-channel mode), 2621 to 2628 (two-
channel mode))

Split: The old video splits, and the new video appears in the gap.
(Pattern numbers: 1011 to 1013 (one-channel mode))

Door: The new video moves like a door closing, and progressively covers the 
old video.
(Pattern numbers: 1041 to 1048 (one-channel mode))

Flip tumble: The old video rotates about an axis and is replaced by the new 
video. During the transition, the signal from the utility 2 bus of the M/E 
bank appears as the background.
(Pattern numbers: 1101 to 1104, 1109, 1110, 1121, 1122, 1124, 1131 to 
1133, 1135 (one-channel mode))

Mirror: The new video appears over the old video as a mirror effect slides in 
all four directions.
(Pattern numbers: 1355 to 1358 (one-channel mode))

Sphere: The new video appears wrapped around a sphere over the old video, 
then returns to the original video while unwrapping.
(Pattern number: 1365 (one-channel mode))

Character trail: The new video appears with a trail over the old video. Next 
this gradually returns to the original from the periphery.
(Pattern numbers: 1371, 1372 (one-channel mode))

Wave: The new video appears with a wave-like effect over the old video. Next 
this returns to the original video as the effect reduces.
(Pattern numbers: 1378, 1379 (one-channel mode))

Ripple: The new video appears over the old video like outwardly moving 
ripples.
(Pattern number: 1381 (one-channel mode))

Page turn: The old video moves like a page turning, and the new video appears 
behind it.
(Pattern numbers: 1301 to 1313, 1315 to 1318, 1341 to 1345 (one-channel 
mode), 2701 to 2713, 2715 to 2718, 2741 to 2745 (two-channel mode))

Page roll: The new video unrolls like a scroll over the old video. This is a type 
of page turn.
(Pattern numbers: 1321 to 1333, 1335 to 1338, 1346 to 1350 (one-channel 
mode), 2721 to 2733, 2735 to 2738, 2746 to 2750 (two-channel mode))

Frame in-out: Completed in two transitions. In the first transition, the new 
video appears, then on the second transition the new video goes out and the 
old video returns.
(Pattern numbers: 1201 to 1208, 1221 to 1224 (one-channel mode), 2851 
to 2854, 2861 to 2864 (two-channel mode))
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Picture-in-picture: The one-channel mode and two-channel mode differ as 
follows.
In one-channel mode, this completes in two transitions. In the first 
transition, the old video shrinks, and the new video appears behind it.
In the second transition, the old video expands again until it is its original 
size.
(Pattern number: 1251 (one-channel mode))
In two-channel mode, in the first half of the transition, the old video 
shrinks, and the new video appears. In the second half of the transition, the 
new video expands, and the old video disappears. You can move the 
pattern from the current position by a relative amount. During the 
transition, the signal from the utility 2 bus of the M/E bank appears as the 
background.
(Pattern numbers: 2651 and 2652 (two-channel mode))

2D trans: The new video appears over the old video, while undergoing 
expansion, two-dimensional rotation and translation.
(Pattern numbers: 1051 to 1058, 1061 to 1064, 1068 (one-channel mode))

3D trans: In one-channel mode, the new video appears over the old video, 
while undergoing expansion, three-dimensional rotation and translation.
(Pattern numbers: 1071, 1072, 1074, 1076, 1077, 1088, 1091 to 1094 (one-
channel mode))
In two-channel mode, the old video changes to the new video while both 
undergo expansion, three-dimensional rotation and translation.
(Pattern numbers: 2631 to 2634, 2642, 2644 (two-channel mode))

Sparkle: The new video appears over the old video with a nonlinear effect 
applied, such as broken glass, explosion, or melt. Next this returns to the 
original video as the effect gradually reduces.
(Pattern numbers: 1391, 1393, 1394, 1396, 1398, 1399 (one-channel 
mode))

Split slide: The new video appears in strip form while sliding interleaved in the 
opposite direction over the old video.
(Pattern numbers: 1384 to 1389 (one-channel mode))

Mosaic: In the first half of the transition, a mosaic is gradually applied to the 
old video, then at the 50% point the inner image changes to the new video. 
In the second half, the mosaic effect on the new video is gradually reduced, 
returning to the original image at 100%.
(Pattern number: 1701 (one-channel mode))

Defocus: In the first half of the transition, the old video is gradually defocused, 
then at the 50% point the inner image changes to the new video. In the 
second half, the defocusing effect on the new video is gradually reduced, 
returning to the original image at 100%.
(Pattern number: 1702 (one-channel mode))

Brick: In two-channel mode, a brick such that the side surface is visible slides 
in over the old video, then rotates so that the new video can be seen.
(Pattern numbers: 2801 to 2804, 2811 to 2814 (two-channel mode))
Overview
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In three-channel mode, a brick appears over the old video as the image is 
expanding and rotating, and switches to the new video.
(Pattern number: 3601 (three-channel mode))

User programmable DME: Using a DME keyframe effect created with a 
keyframe operation, this executes a DME wipe.
(Pattern numbers: 1901 to 1999 (one-channel mode), 2901 to 2999 (two-
channel mode), 3901 to 3999 (three-channel mode))

For details of creating keyframe effects, see “Creating User 
Programmable DME Patterns” (page 251).

Note

In an independent key transition, the following patterns can be used.

User programmable DME in transition mode
For the transition mode set when creating a keyframe effect for a user 
programmable DME pattern, the following can be used.
• Single: single transition mode
• Flip tumble (Flip Tumble): flip tumble transition mode
• Dual: dual transition mode
• Picture-in-picture (PinP): one-channel and two-channel picture-in-picture 

transition mode
• Compress: a type of picture-in-picture, in which the new image is the 

background, and the currently visible image shrinks, and then expands to its 
original size. (See example in the next item.)

• Frame in-out (Frame I/O): frame in-out transition mode. When the first 
transition completes, if you move the position of the image, you can move it 
both horizontally and vertically.

• Frame in-out H (Frame I/O H): a type of frame in-out mode, which is 
specified when creating a transition effect in the horizontal direction.
The image movement is reflected at both the transition start point and end 
point. (See page 229.)
The operation is carried out according to DME wipe patterns 1202, 1203, or 
1204.

• Frame in-out V (Frame I/O V): a type of frame in-out mode, which is 
specified when creating a transition effect in the vertical direction.
The image movement is reflected at both the transition start point and end 
point. (See page 230.)

Execution mode DME wipe patterns that can be used

One-channel mode Slide, split, squeeze, door, 2D trans, 3D trans, frame in-out, 
page turn, page roll, mirror, sphere, character trail, wave, ripple, 
split slide, sparkle, user programmable DME

Two-channel mode Page turn, page roll
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Transition mode “Compress”
The change in the image when the transition mode is set to “Compress” is as 
follows, in comparison to the case of “Picture-in-picture.”
• Example of the image change in the transition mode “Picture-in-

picture” (one-channel mode)

• Example of the image change in the transition mode “Compress”

Transition mode “frame in-out”
In this mode, when the first transition has completed, you can move the image 
with the positioner in both horizontal and vertical directions, but the image 
position at the transition start point and end point does not change.
The description is of an example of creating an effect such as the following.

Second strokeFirst stroke

First stroke Second stroke

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background A

Effect execution
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At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Transition mode “frame in-out H”
This mode is specified when creating a transition effect in the horizontal 
direction.
In this mode, when the first transition has completed, you can move the image 
with the positioner in both horizontal and vertical directions. The image at the 
transition start point and end point also moves.
The description is of an example of creating an effect such as the following.

At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background A

Effect execution
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Transition mode “frame in-out V”
This mode is specified when creating a transition effect in the vertical 
direction.
In this mode, in the state at completion of the first transition, you can move the 
image with the positioner in both horizontal and vertical directions. The image 
at the transition start point and end point also moves.
The description is of an example of creating an effect such as the following.

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background AEffect execution
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At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Signals forming part of the background for a DME wipe
For a two-channel mode page turn, page roll, brick, frame in-out, and so on, the 
part of the pattern shown in gray (see page 367) is filled with the signal selected 
on the DME external video bus.
For three-channel mode brick, the part of the pattern shown in dark gray is 
filled with the DME external video signal, and the light gray portion with the 
signal selected as follows.

For a DME dedicated interface
The signal selected on the utility 1 bus.

For an MVE-8000A or MVE-9000 SDI interface
Signal selected on the AUX bus assigned in the Engineering Setup >Switcher 
>Device Interface >DME Type Setting >DME SDI interface menu. (The AUX 
bus is determined by which DME channel is being used.)

Note

For the SDI interface on the MVE-8000A or MVE-9000, in some cases the 
AUX bus is used in place of the DME external bus. 

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution
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For details, see “Interfacing With External Devices (Device Interface Menu)” 
in Chapter 19 (Volume 3). 

DME Wipe Pattern Variation and Modifiers

You can modify the selected DME wipe pattern in the same way as an ordinary 
wipe pattern, as follows.

For the setting operations, see “Setting DME Wipe Modifiers” (page 238).

Direction: You can set the DME wipe direction to normal, reverse, or 
alternating normal/reverse (see page 238), except for a key transition, 
which is always in normal/reverse mode. However, a key transition can 
only be specified when the following patterns are selected, and when other 
patterns are selected, this is fixed, as normal/reverse.
Patterns: 1204, 1207, 1221 to 1224

Edge: You can apply a border or soft border (see page 239). 
In the case of those user programmable DME patterns for keys in which an 
edge has already been applied to the effect, the behavior is as follows.
• When the DME wipe edge setting is on, only part of the edge applied in 

the effect is enabled, and that portion can be adjusted (page 239).
• When the DME wipe edge setting is off, the edge applied in the effect is 

enabled as is.
Positioner: You can move the DME wipe pattern or center of the effect to an 

arbitrary position. Using the position select function, you can also 
instantaneously move the pattern.
• 1031

When this pattern number is selected, with the progress of the transition 
the pattern center automatically moves initially from the set position 
toward the center of the screen (see page 240). In other words, the effect 
obtained is the same as in a normal wipe with the positioner set to 
“AUTO CENTER”.

• 1201 to 1208, 1221 to 1224, 1251
When these pattern numbers are selected, you can set the pattern position 
when the first transition completes.

• 1381, 1391, 1393, 1394, 1396
When these pattern numbers are selected, you can set the center of the 
transition effect.

• 2651, 2652
When these pattern numbers are selected, you can move the pattern for 
each channel, or with values relative to the current position the two 
channels simultaneously.

• 2801 to 2804, 2811 to 2814
When the these pattern numbers are selected, you can set the vertical 
position as the brick slides in.
Overview
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• 2851 to 2854, 2861 to 2864

When these pattern numbers are selected, you can set the pattern position 
for each channel setting when the first transition completes.

Pattern limit: You can restrict the range of the transition as desired. However, 
this is not available for a DME wipe in the independent key transition 
control block. 

For more details, see “Pattern Limit” (page 120).

Size: This can only be used when one of the following pattern numbers is 
selected.
• 1201 to 1208, 1221 to 1224, 1251
• 2651, 2652, 2851 to 2854, 2861 to 2864 

You can set the size of the image.
Crop: You can crop the image. It is also possible in 16:9 mode to crop both 

sides, to convert the image to a 4:3 aspect ratio. For the execution of a 
DME wipe crop transition, you can select from the following three 
possibilities.
• Cut
• Last 5%
• Linear
When [Last 5%] is selected, you can set the [Release Transition] as 
follows. 
• Last 30%
• Last 5%
• Off

Note

When pattern numbers 1701 and 1702 are selected, crop cannot be used.

Relation Between DME Wipes and Other Effects

The relations between DME wipes and other effects are as follows.

Relation to ordinary wipes
• DME wipes do not use the wipe generator built into the switcher. Therefore, 

during the execution of a DME wipe, you can still use a pattern produced by 
the wipe generator as the source for a pattern key or mask.

• A DME wipe pattern cannot be used as the source for a pattern key or mask.
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Relation to processed keys
When using the DME for a processed key, if you select a DME wipe, an 
available DME is automatically allocated to the DME wipe. If all of the DME 
channels are in use, then it is not possible to select a DME wipe.
If in a Setup menu a setting has been made for DME allocation, that Setup 
menu setting takes precedence (see “Setting the assignments of DME channels 
to use on the individual M/E banks” in Chapter 20 (Volume 3).

Number of DME wipes that can be used simultaneously on a 
single M/E bank

DME wipes can be used in five places, including the four independent key 
transitions. 
When the DME dedicated interface is used, a maximum of two DME wipes can 
be used simultaneously, and when the SDI interface is used, only one DME 
wipe can be used at one time.

Note

When combining the SDI interface with the dedicated interface, it may be
possible to use up to three wipes simultaneously.

For details, see “Interfacing With External Devices (Device Interface Menu)” 
in Chapter 19 (Volume 3). 
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Basic Procedure for DME Wipe Settings

You carry out DME wipe setting operations principally using the DME Wipe 
menu for each bank.
This section describes the basic procedures for DME wipe settings, taking the 
M/E-1 >DME Wipe menu as an example.

For details of independent key transition DME wipe settings, see “DME Wipe 
Settings for Independent Key Transitions” (page 246).

Notes

• To carry out DME wipes requires the BKDS-9470 DME Board Set or the 
MVE-8000A/9000 DME Processor.

• For one M/E bank, DME effects (including external processed keys) can be 
used in up to two places on the DME dedicated interface and in only one 
place on the SDI interface simultaneously.

DME Wipe Settings Menu

Accessing the DME Wipe menu
To access the M/E-1 >DME Wipe menu, use either of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF6 ‘DME Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [DME] twice in rapid succession.
Either of the above operations displays the M/E-1 >DME Wipe menu.

DME Wipe Pattern Selection

Selecting a DME wipe pattern by a menu operation

1 In the M/E-1 >DME Wipe menu, select HF1 ‘1ch’ for one-channel mode, 
HF2 ‘2ch’ for two-channel mode or HF3 ‘3ch’ for three-channel mode.

2 Select the desired DME wipe pattern group with one of the following 
buttons.

• Slide/Squeeze: slide and squeeze
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• Split/Door: split and door
• Flip Tumble: flip tumble
• Mirror/Sphere: mirror and sphere
• Character Trail: character trail
• Wave/Ripple: wave and ripple
• Page Turn/Roll: page turn and page roll
• Frame I/O/P in P: frame in/out and picture-in-picture
• 2D Trans/3D Trans: 2D trans and 3D trans
• Sparkle/Split Slide: sparkle and split slide
• Mosaic/Defocus: mosaic and defocus
• Brick: brick
• User Program: user programmable DME

Selectable DME wipe pattern groups in one-channel mode: All of the 
above groups except for Brick.

Selectable DME wipe pattern groups in two-channel mode: Slide/
Squeeze, Page Turn/Roll, Frame I/O, PinP, 3D Trans, Brick and User 
Program.

Selectable DME wipe pattern groups in three-channel mode: User 
Program and Brick.

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 224) and “DME Wipe Pattern List” (page 359).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Note

For a key transition, the page turn, page roll and picture-in-picture cannot 
be used.

Adjusting DME wipe pattern parameters
Of the DME wipe patterns, the following have parameters that can be adjusted.

When Brick (for two channels) is selected (pattern numbers 2801 
to 2804, 2811 to 2814)

Knob Parameter Adjustment Setting values

1 Side V Size X Horizontal magnification 0.01 to 8.00

2 Side V Size Y Vertical magnification 0.01 to 8.00

3 Height Height of brick 0.01 to 100.00

4 Center X Horizontal center position –100.00 to +100.00 a)

5 Center Y Vertical center position –100.00 to +100.00 b)
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a) The horizontal center position of the video pasted on Side V. At –100.00 the center is at the left 

edge of the screen, and at +100.00 the center is at the right edge of the screen.
b) The vertical center position of the video pasted on Side V. At –100.00 the center is at the bottom 

edge of the screen, and at +100.00 the center is at the top edge of the screen.

When Frame in-out (for two channels) is selected
• Pattern numbers 2851 to 2854

• Pattern numbers 2861 to 2864

When Brick (for three channels) is selected (pattern number 3601)

a) Shared with knob 3 for parameter group 2
b) The horizontal center position of the video pasted on Side V. At –100.00 the center is at the left 

edge of the screen, and at +100.00 the center is at the right edge of the screen.
c) The vertical center position of the video pasted on Side V. At –100.00 the center is at the bottom 

edge of the screen, and at +100.00 the center is at the top edge of the screen.

Knob Parameter Adjustment Setting values

5 Delay Timing for video selected on 
a utility bus to appear on the 
screen

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Rot X Rotation about the Y axis 
(horizontal direction)

–100.00 to +100.00

2 Rot Y Rotation about the X axis 
(vertical direction)

–100.00 to +100.00

3 Rot Z Rotation about the Z axis –100.00 to +100.00

5 Delay Timing for video selected on 
a utility bus to appear on the 
screen

–100.00 to +100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Side V Size X Side V horizontal 
magnification

0.01 to 8.00

2 Side V Size Y Side V vertical 
magnification

0.01 to 8.00

3 Height Height of brick 0.01 to 100.00 a)

4 Side V Center X Side V horizontal center 
position

–100.00 to +100.00 b)

5 Side V Center Y Side V vertical center 
position

–100.00 to +100.00 c)
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a) Shared with knob 3 for parameter group 1
b) The horizontal center position of the video pasted on Side H. At –100.00 the center is at the left 

edge of the screen, and at +100.00 the center is at the right edge of the screen.
c) The vertical center position of the video pasted on Side H. At –100.00 the center is at the bottom 

edge of the screen, and at +100.00 the center is at the top edge of the screen.

Setting DME Wipe Modifiers

You can apply various modifiers to the DME wipe pattern: setting the DME 
wipe direction, pattern position, and so on.

For an overview of the DME wipe modifiers, see “DME Wipe Pattern 
Variation and Modifiers” (page 232).

Specifying the DME wipe direction (Direction)
You can specify the DME wipe direction (normal/reverse).

To specify the DME wipe direction in a menu

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction>group, specify the DME wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Side H Size X Side H horizontal 
magnification

0.01 to 8.00

2 Side H Size Y Side H vertical 
magnification

0.01 to 8.00

3 Height Height of brick 0.01 to 100.00 a)

4 Side H Center X Side H horizontal center 
position

–100.00 to +100.00 b)

5 Side H Center Y Side H vertical center 
position

–100.00 to +100.00 c)
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To specify the DME wipe direction with a button in the transition 
control block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
NORM: Normal
NORM/REV: Normal/Reverse
REV: Reverse

Modifying the DME wipe pattern edge

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Edge> group, select the edge type.

Border: border
Soft Border: soft border

4 Set the parameters according to the selection in step 3.

• When border is selected

• When soft border is selected

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00
239Basic Procedure for DME Wipe Settings



240

   C
hapter 6 

D
M

E
 W

ipes
Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Setting the DME wipe position (Positioner)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Position> group, press [Position], turning it on.

4 Set the following parameters.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Displaying and moving the position of the DME wipe pattern 
(position select)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

Knob Parameter Adjustment Setting values

1 H Horizontal position –200.00 to +200.00

2 V Vertical position –200.00 to +200.00
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In the <Position Select> group, the one of the [Top Left], [Top Right], 
[Bottom Left], and [Bottom Right] buttons that is on indicates the current 
display position of the DME wipe pattern.

2 In the <Position> group, press [Position], turning it on.

3 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

In one-channel mode: press [1st Ch], turning it on.
In two-channel mode: from the <Ch Select> group, select the 

corresponding channel. You can select more than one channel at the 
same time.

4 To move the position of the DME wipe pattern, press the button where you 
want to move to, turning it on.

The DME wipe pattern displayed on the screen moves to the position of 
the specified button.

Setting relative positions to move the DME wipe pattern
In two-channel mode, use the following procedure. 

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 In the <Ch Select> group, select the target channels.

3 Press [Position] in the <Position> group, turning it on.

4 Set the following parameters.

For details of the method of DME wipe pattern selection, see “DME Wipe 
Pattern Selection” (page 235).

Setting the DME wipe pattern size (Size)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

Knob Parameter Adjustment Setting values

4 Relative H Relative movement in the 
horizontal direction

–400.00 to +400.00

5 Relative V Relative movement in the vertical 
direction

–400.00 to +400.00
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The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 Press [Size], turning it on.

4 Set the following parameters.

a) The effect size when [Size] is off is taken as 100.00%.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Adjusting the DME wipe pattern cropping

Note

When pattern numbers 1701 and 1702 are selected, crop cannot be used.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time. Some patterns need no selection which is fixed in the 
<Ch Select> group.

3 In the <Crop Mode> group, press [Crop], turning it on.

4 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 a)
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Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

In 16:9 mode, to crop to 4:3 aspect ratio
In the <Crop Mode> group, press [4:3], turning it on.

To set the action when a DME wipe crop transition is executed

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: in the <Ch Select> group, press [1st 
Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select 
the corresponding channels. You can select more than one channel at 
the same time.

3 In the <Crop Mode> group, press [Crop] or [4:3 Crop] (to crop from 16:9 
to 4:3 aspect ratio), turning it on.

4 In the <Crop Mode> group, press [Remove From Begin].

The Remove From Begin menu appears.

5 In the <Crop Transition> group, select the execution mode for the DME 
wipe crop transition.

Cut: Cut mode. The cropping does not change during the transition, but at 
the end point of the transition the cropping is removed (enlarges).

Last 5%: The cropping is maintained for the first 95% of the transition, 
and is progressively removed during the last 5% of the transition 
(enlarges).

Knob Parameter Adjustment Setting values

1 Top Crop the top of the image –100.00 to +100.00

2 Left Crop the left of the image –100.00 to +100.00

3 Right Crop the right of the image –100.00 to +100.00

4 Bottom Crop the bottom of the image –100.00 to +100.00
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Linear: The cropping is removed linearly through the whole course of the 
transition (enlarges).

Setting the timing of transition completion
When the execution mode for a DME wipe crop transition is set to [Last 5%], 
you can select the timing of transition completion from 70% ([Last 30%]), 95% 
([Last 5%]), and 100% ([Off]).

1 In the M/E 1 >DME Wipe menu, select HF5 ‘Modify’.

The Modify menu appears.

2 In the <Crop Mode> group select [Remove From Begin].

The Remove From Begin menu appears.

3 In the <Release Transition> group, select the timing of transition 
completion.

Last 30%: The transition completes at the end of 70% of the transition 
execution time. The transition has a dead zone from 70% to 95% of the 
transition time.

Last 5%: The transition completes at the end of 95% of the transition 
execution time. When the transition completes, the cropping is 
removed during the last 5%.

Off: The transition completes at the end of the transition execution time. 
During the last 5% of the transition, the transition and cropping 
removal proceed together.
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DME Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then 
press VF6 ‘DME Wipe’ to return the DME wipe settings to their initial status.

For details of the menu operation to return the DME wipe state to that set in 
initial status, see “Returning to default state in function groupings” (page 77).
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DME Wipe Settings for Independent Key 
Transitions

You carry out independent key/downstream key transition DME wipe setting 
operations using the DME Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see page 131.

This section describes the independent key transition DME wipe settings, 
taking the M/E-1 >Key1 >Transition >DME Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition DME 
Wipe Settings

Accessing the independent key transition DME wipe settings 
menu

As an example, to access the M/E-1 >Key1 >Transition >DME Wipe Adjust 
menu, carry out the following operation.
• In the menu control block, select the top menu selection button [M/E 1], and 

select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1. Next, press [DME Wipe Adjust].

Carrying out the above operation displays the M/E-1 >Key1 >Transition 
>DME Wipe Adjust menu (which will be referred to below as simply the Key1 
DME Wipe Adjust menu).

Selecting the independent key transition DME wipe pattern
You select the independent key DME wipe pattern from the list of patterns 
displayed in the menu. 

To select a DME wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.

1 In the <Pattern Select> group of the Key1 DME Wipe Adjust menu, press 
[1ch] for one-channel mode or [2ch] for two-channel mode.

The Pattern Select menu appears.

2 Select the desired DME wipe pattern group with one of the following 
buttons.
DME Wipe Settings for Independent Key Transitions



  C
hapter 6 

D
M

E
 W

ipes

In two-channel mode, only Page Turn and Page Roll are selectable.
• Slide/Squeeze: slide and squeeze
• Split/Door: split and door
• Mirror/Sphere: mirror and sphere
• Character Trail: character trail
• Wave/Ripple: wave and ripple
• Page Turn/Roll: page turn and page roll
• Frame I/O: frame in/out
• 2D Trans/3D Trans: 2D Trans and 3D Trans
• Sparkle/Split Slide: sparkle and split slide
• User Program: user programmable DME

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 224) and “DME Wipe Pattern List” (page 359).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Setting Independent Key Transition DME Wipe 
Modifiers

You can add modifiers such as pattern position and size for an independent key 
transition DME wipe.

For introductory information, see “Setting the DME wipe position 
(Positioner)” (page 240) and “Setting the DME wipe pattern size (Size)” (page 
241).

Setting the DME wipe position (Positioner)
For applicable pattern numbers, see page 232.

1 In the <Position> group of the Key1 DME Wipe Adjust menu, press 
[Position], turning it on.

2 Set the following parameters.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Knob Parameter Adjustment Setting values

1 H Horizontal position –200.00 to +200.00

2 V Vertical position –200.00 to +200.00
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Setting the DME wipe pattern size (Size)
For applicable pattern numbers, see page 233.

1 In the Key 1 DME Wipe Adjust menu, press [Size], turning it on.

2 Set the following parameter.

a) The effect size when [Size] is off is taken as 100.00%.

Cropping a key DME wipe

1 In the <Crop Mode> group of the Key1 DME Wipe Adjust menu, press 
[Crop], turning it on.

2 Set the following parameters.

To crop to 4:3 in 16:9 mode
In the <Crop Mode> group, press [4:3 Crop], turning it on.

To set the operation for DME wipe crop transition execution

1 In the <Crop Mode> group of the Key1 DME Wipe Adjust menu, press 
[Crop], turning it on.

2 In the <Crop Mode> group, press [Crop] or [4:3 Crop] (to crop to 4:3 in 
16:9 mode), turning it on.

3 In the <Crop Mode> group, press [Remove From Begin].

The Remove From Begin menu appears.

For subsequent operations, see step 5 of “To set the action when a DME 
wipe crop transition is executed” (page 243).

Knob Parameter Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 a)

Knob Parameter Adjustment Setting values

1 Top Cropping of the top of the image –100.00 to +100.00

2 Left Cropping of the left of the image –100.00 to +100.00

3 Right Cropping of the right of the image –100.00 to +100.00

4 Bottom Cropping of the bottom of the 
image

–100.00 to +100.00
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To set the timing of transition completion

1 In the <Crop Mode> group of the Key1 DME Wipe Adjust menu, press 
[Crop], turning it on.

2 In the <Crop Mode> group, press [Remove From Begin].

For subsequent operations, see “Setting the timing of transition 
completion” (page 244).

Applying a border to a key DME wipe
In the <Edge> group of the Key1 DME Wipe Adjust menu, press [Border], 
turning it on.

For subsequent operations, use the same process as in step 4 of “Modifying the 
DME wipe pattern edge” (page 239).
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DME Wipe Snapshots

You can snapshot and save a DME wipe pattern together with the current 
settings of its modifiers and pattern limit in a dedicated register for recall when 
required.
There are 10 DME wipe snapshot registers for each of the M/E and P/P banks. 
Use the menu to save and recall these registers 

DME Snapshot Operations With the Menus

In the same way as for wipe snapshots, you can save, recall, and delete DME 
snapshots.

For details of the operating procedures, see “Wipe Snapshot Operations With 
the Menus” (page 221).
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Creating User Programmable DME Patterns

With a user programmable DME, you can use DME effects created through the 
use of keyframes for a transition on the switcher system.
Note the following points when creating a keyframe effect for use as a user 
programmable DME pattern.

Register numbers and pattern numbers
When saving a keyframe effect as a user programmable DME pattern, specify 
the register number that corresponds to the pattern number as shown in the 
following table.

For details of registers and keyframe effects, see Chapter 13 “Keyframe 
Effects” (Volume 2), respectively.

Keyframe effects in the global channel
When the effect with the same number as the reference channel is present on 
the DME global (GLBL) channel, executing the user programmable DME will 
also execute the effect on the global channel simultaneously.
When executing a user programmable DME, take note of whether the effect is 
present on the global channel.

User Programmable DME Transition Mode

To create a user programmable DME, it is necessary to set the transition mode 
(the way in which the effect moves). To set the transition mode, use the Key 
Frame >DME User PGM menu.

For details of the operating procedures, see “Transition Mode Settings for 
User Programmable DME” in Chapter 13 (Volume 2).

Execution mode Register number Pattern number

One-channel mode 101 to 199 1901 to 1999

Two-channel mode 201 to 299 2901 to 2999

Three-channel mode 301 to 399 3901 to 3999
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The following transition modes are available.

a) Transition according to DME wipe patterns 1202, 1203, or 1204
b) Transition according to DME wipe pattern 1201
c) Transition according to DME wipe pattern 1251

For details, see “Overview” (page 224).

Note

For the following group of effects available in two-channel mode, no user 
programmable DME wipe patterns can be created.

Page turn, Page roll, Frame in-out, Brick

Notes on creating keyframe effects
When creating a keyframe effect to be used as a user programmable DME 
pattern, note the following, depending on the transition mode used.

Notes on single transition mode (one-channel mode)
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the last keyframe to be a full-size image.
• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 

select [Single].

Notes on flip tumble (one-channel mode)
• Create the first keyframe image at full size. In the <Back> group of the DME 

>Input/Output >Video/Key menu, depending on the direction of the rotation 
you want during the transition, press [H Invert] or [V Invert], turning it on.

Channels Transition mode Effect group

One-channel mode Single transition mode Slide, Split, Door, Page turn, 
Page roll, Squeeze, Mirror, 
Sphere, Character Trail, Wave, 
Ripple, 2D Trans, 3D Trans, 
Sparkle, Split Slide

Flip Tumble Flip Tumble, Mosaic, Defocus

Frame in-out Frame in-out

Frame in-out H a) Frame in-out

Frame in-out V Frame in-out

Picture-in-picture b) Picture-in-picture

Compress c) Picture-in-picture

Two-channel mode Dual transition mode Slide, Squeeze, 3D Trans

Two-channel picture-in-picture Picture-in-picture
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• Create the last keyframe with the image inverted so the back side is visible, 

and with the size at full size.
• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 

select [Flip Tumble].

Notes on frame in-out (one-channel mode)
Create a minimum of three keyframes.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the first transition to end such that the image can be seen within the 

screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O].

Notes on Frame in-out H (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• As the state after completion of the first transition, move the image 

horizontally to make it visible within the screen. At this time, press the 
[PAUSE] button in the keyframe control block, turning it on, to set a pause 
for the keyframe.

• For the last keyframe move the image horizontally to place it outside the 
screen area or set the image size to zero, so that the image is not visible 
within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O H].

Notes on frame in-out V (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• As the state after completion of the first transition, move the image vertically 

to make it visible within the screen. At this time, press the [PAUSE] button 
in the keyframe control block, turning it on, to set a pause for the keyframe.

• For the last keyframe move the image vertically to place it outside the screen 
area or set the image size to zero, so that the image is not visible within the 
screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O V].

Notes on picture-in-picture (one-channel mode)
Create a minimum of three keyframes.
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• Either create the first keyframe image outside the screen area, or set the 
image size to zero so that it cannot be seen within the screen.

• Create the first transition to end such that the image can be seen within the 
screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [P In P].

Notes on compress (one-channel mode)
Create a minimum of three keyframe points.
• Create the first keyframe with the image at full size.
• In the state at completion of the first transition, create the image to be visible 

within the screen. At this time, press the [PAUSE] button in the keyframe 
control block, turning it on, to set a pause for the keyframe.

• For the last keyframe, once again set the image size to full size.
• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 

select [Compress].

Notes on dual transition mode (two-channel mode)
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• Create the last keyframe for each channel as follows.
Channel 1: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.
Channel 2: create the image full-size.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [Dual].

Notes on picture-in-picture (two-channel mode)
Create a minimum of three keyframes.
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
In the Global Effect >Ch1 to Ch4 >Combiner menu, when setting the priority 
of channel 1 and channel 2, set the channel 1 priority higher.

• In the intermediate part of the transition, create the two images so that both 
are visible within the screen. In the Global Effect >Ch1 to Ch4 >Combiner 
menu, when setting the priority of channel 1 and channel 2, set the channel 2 
priority higher.
Creating User Programmable DME Patterns
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It is recommended to make the priority settings at a keyframe point at which 
the two images are not overlapping.

• During the course of a transition, there is a “dead zone” corresponding to the 
intermediate point of the whole effect (see following figure), during which 
the image does not change. Therefore, it is necessary to create the effect so 
that the image in the intermediate part of the transition is the keyframe for 
the mid-point of the whole effect. The range of this “dead zone” corresponds 
to the central one-third of the range of the transition indicator. This also 
applies to an auto transition. 

• Create the last keyframe for each channel as follows.
Channel 1: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
Channel 2: create the image full-size.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [P In P].

A B C

Keyframe effect

First keyframe Last keyframe 

Mid-point of effect

Change in image through transition

Image at point C 
appears

Image at point B 
appears 
(dead zone)

Image at point A 
appears

Transition indicator
Fader lever
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Overview

Frame memory is a function whereby a frame of input video can be frozen and 
written to memory, for further use as material for editing. 
You can also play recorded frame memory clips (movies).

Frame capacity
The memory capacity for freeze images is a maximum of 444 frames.

For details of operating procedures, see “Still Image Operations” (page 261).

Types of image and terminology used
The following types of image are handled in frame memory.
Freeze image: An input image that has been frozen, but not saved to memory.
Still image: A freeze frame that has been saved to memory as a file. Each file 

(still file) holds just one still image.
Frame memory clip: A clip consists of a sequence of still images, which 

appears as a movie on playback. In this manual this is also referred to 
simply as a “clip.” The files (still files) constituting clips are referred to as 
a “clip file.”

When the above distinctions are not being made, an image is simply referred 
to as an “image.”

Use of frame memory
There are eight frame memory channels, FM1 to FM8, and each channel 
independently allows a freeze image to be saved or recalled.
By allocating FM1 to FM8 to cross-point buttons you can use the still image 
output or clip output from each channel as input material.

Correspondence between input and output
There are two buses for capturing frame memory material: the frame memory 
source 1 bus and the frame memory source 2 bus.
These input buses are used by allocation to one of the pairs of output, FM1&2, 
FM3&4, FM5&6, and FM7&8. You can freeze a frame in each channel 
separately, or freeze in the two channels simultaneously.
The source buses allocated to FM1 to FM8 are as follows.
Overview
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Pair mode
By enabling the pair mode, you can link FM1 and FM2, FM3 and FM4, FM5 
and FM6, and FM7 and FM8. For example, when a freeze or image processing 
is carried out on FM1, the same operation is carried out on FM2. The same 
applies to the other pairs. When a pair of images are captured in pair mode, the 
image frozen in FM1 (3, 5, or 7) is referred to as the main file and the other 
frozen in FM2 (4, 6, or 8) is referred to as the sub file. 

Pair files and single files
A file that can be recalled in pair mode is termed a “pair file.” A pair file can 
be created by setting pair mode and capturing an image, or by using the 
coupling function (see page 298) to combine two single files.
A file other than a pair file is termed a “single file.” A single file can be created 
by switching off pair mode and capturing an image, or by using the separation 
function (see page 299) to split a pair file.

Operation modes
The frame memory has the following operation mode. 
V/K mode: When the pair mode is active, the key signal is automatically 

selected on frame memory source bus 2. This is convenient for handling 
the video and key signals together in frame memory. For example, when 
you select a video signal on frame memory source bus 1, the key signal 
assigned to it is automatically selected on frame memory source bus 2. You 
can also use the signal automatically selected on frame memory source bus 
2 as a key signal when processing keyframe memory 1.

To change the pair mode or operation mode, use the Frame Memory menu.

Frame memory folders
Still images and clips can be managed in a maximum of twelve groups.
Such a group is called a “frame memory folder.” Folders can be added or 
deleted, and can be given a name of up to 8 characters.

Input Frame memory source bus 1 Frame memory source bus 2

Output FM1 FM2

FM3 FM4

FM5 FM6

FM7 FM8
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Notes

• When the system is powered off, the folder names are deleted. The folder 
names need to be saved on media.

• The following names cannot be used for folders. 
Flash1, Flash2
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

A folder named “Default” is provided, and this folder cannot be renamed or 
deleted.

• Still images and clips in different frame memory folders cannot have the 
same name.
Overview
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Still Image Operations

The frame memory functions provides the following still image file functions.
• Freezing an input image
• Saving a still image
• Recalling a still image
• Processing an image
• Image output
• Continuously capturing images (record)
• Recalling a continuous sequence of images (animation)

For an overview of frame memory concepts, see “Overview” (page 258).

Note

During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 287), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Preparations

Allocating the frame memory outputs (FM1 to FM8) to cross-
point buttons

To output a frame memory image to a monitor, for example, the output signal 
from the frame memory (FM1 to FM8) must be allocated to a cross-point 
button. Carry out this allocation in the Setup menu.

Accessing the Frame Memory menu
Most frame memory operations are carried out using the Frame Memory menu.
To access the Frame Memory menu, use either of the following procedures.
• In the menu control block, select the top menu selection button [FRAME 

MEM].
• Press the cross-point button to which the frame memory output is allocated 

twice in rapid succession.
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Interpreting the Frame Memory Menu

The menu screen consists of the following principal parts.
The frame memory selection area display is the same for all except the Pattern 
Adjust/Pattern Select/Field Invert/File (excluding Pair Recombination menu)/
Folder/External HDD menus.

Frame Memory menu

a Auto store status display
Depending on the setup settings, this appears when the auto store function is 
enabled.

2 Display of available image capacity

4 Pair selection button

6 File selection area

3 Target FM 
selection 
buttons

5 Pair button

1 Auto store status display

Frame memory 
selection area

7 Frame 
memory 
folder 
selection 
area

8 Direct 
Recall 
button
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b Display of available image capacity
This shows the remaining number of frames. When no more frames can be 
stored, in pair mode “1” or “0” appears in red, and in single mode “0” appears 
in red.

c Target FM selection buttons

Press one of these to select which of the selected outputs (FM1 and FM2 in the 
example shown) the operation applies to.
The following information appears on the button.

Status display
File name (e.g. image001) and thumbnail: when a file is output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Composite: when a composite image is processed
Record: when continuously capturing images (record)

Still/duration display
When a still image is selected, “Still” is shown. When a clip is selected, a 
duration indication such as “00:00:10” is shown.

Reposition/Lock status display
This shows “R” when the reposition function (see page 278) is on, and shows 
“L” when the lock function (see page 279) is on.

Status display

Still/duration display Reposition/Lock status display

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected
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d Pair selection button
Select the pair to be displayed in the target FM selection buttons.
(in the following figure, the pair of FM1 and FM2 is selected.)

The following information appears on the button.

Status display
For a pair, shows the status for the reference.
Thumbnail: when a file is output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Compos: when a composite image is processed
Record: when continuously capturing images (record) 

e Pair button
Press this button, turning it on, to enable pair mode.

f File selection area 
You can select from the displayed still image files or clip files.

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected

Status display
Still Image Operations
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Thumbnail indications
Still image files and clip files: Still image files are displayed as gray buttons 

and clip files are displayed as yellow buttons.
Single files and pair files: Single files are displayed with shadow and pair files 

are displayed with no shadow.
Selected file: Pale blue border. When more than one file is selected, only the 

first is pale blue, and the remainders are amber. If the pair file was selected, 
each press switches the front and the back.

File information detail display
For the selected file, this shows the file name, “P” if a pair file, and the 
duration.

g Frame memory folder selection area
Select the frame memory folder to be displayed.

h Direct Recall button
Toggle on and off the direct recall mode in which pressing a thumbnail 
immediately recalls the file.

Selecting an Input Image

For the input image to frame memory, you can use either the signal selected on 
one of the two frame memory source buses or a dedicated color matte signal.

Selected file.
When a pair file is selected each press switches the front and the back.

File information detail display
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When using the signal on frame memory source bus 1 or 2 for the input image, 
select the signal as described below.

For the method of using a color matte signal, see “Freezing an image and 
writing it to memory” (page 268).

Selecting the signal on a frame memory source bus
As an example, to select a signal on frame memory source bus 1, use the 
following procedure.

1 Using the bank selection buttons in the auxiliary bus control block, select 
the desired bank.

2 In the auxiliary bus control block, press the AUX delegation button to 
which frame memory source bus 1 is allocated, turning it on.

 For allocation of buses to the AUX delegation buttons, see “Assigning a 
Bus to an AUX Delegation Button” in Chapter 19 (Volume 3).

3 In the key row of the bank selected in step 1, select the signal to be used 
for the input image.

To select a signal with a key or DME effect applied on the frame 
memory source bus
In the key control block or in the M/E-1 >Key1 >Processed Key menu, press 
the [FM FEED] button.
This automatically assigns the key fill and key source signals being keyed by 
the currently selected keyer to frame memory source buses 1 and 2.
When DME is selected on the keyer, the key fill and key source signals to 
which a DME effect is applied are assigned.

Selecting Outputs and Target Frame Memory

Selecting outputs (FM) and target frame memory
The following description applies to the case of settings for FM1&2, but the 
procedures are similar for the other cases.

1 In the Frame Memory menu, press one of VF1 to VF4, and select the 
required HF menu.

The current status of frame memory appears. (See page 262).
Still Image Operations
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2 From the pair selection buttons, press the buttons corresponding to FM1 

and FM2.

This assigns the signals to FM1 and FM2.
To the right of the target FM selection buttons, the FM1 and FM2 output 
status appears (see page 263).

3 If required, press [Pair], to select the FM operation mode (pair mode).

On: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) as a pair.
Off: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) individually.

For more details, see “Pair mode” (page 259).

Note

In the Pair Recombination menu, the [Pair] operation is not possible.

4 Press the target FM selection button [FM1] or [FM2] (see page 263) to 
select the FM operations apply to.

When [Pair] is On: Whichever of FM1 and FM2 you press, the pair is 
selected.

When [Pair] is Off: One of the targets must be selected. However, in the 
Clip >Play menu you can also select both FM1 and FM2.

Selecting a frame memory folder
Press a button in the frame memory folder selection area (see page 265).
By pressing [More] to switch the display, you can select from a maximum of 
12 folders.
Thumbnails of the files within the selected folder appear.

Capturing and Saving an Input Image

As the input material for the frame memory, you can use the signal selected on 
the frame memory source bus. For this signal you can use video processing 
(video levels or hue value adjustment) or masking.

Allocating a frame memory source bus signal to one of FM1 to FM8, then 
carrying out a freeze captures a still image in the corresponding frame memory 
output image, and saves it in temporary memory.
For a freeze, an image can be captured either as video frame (a “frame freeze”) 
or a video field (“field freeze”).
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Note

When the system is powered off, any freeze images written to temporary 
memory are lost.

Freezing an image and writing it to memory
To freeze the signal selected as input material, and write it to memory, use the 
following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and HF2 ‘Freeze/Store.’

The Freeze/Store menu appears.

2 Select the target frame memory.

For the procedure, see “Selecting outputs (FM) and target frame 
memory” (page 266).

3 To enable V/K mode, press [V/K Mode] turning it on.

4 Press a button in the frame memory folder selection area, to select the 
folder to hold the freeze image.

For details of the selection method, see page 267.

Note

The folder selected here is the destination folder for writing the freeze 
image.
It is not possible to change the selection of this folder after the following 
step 5.

An orange bar appears on the selection button for the destination folder.

5 Press [Freeze Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, a freeze is now possible.

6 If necessary, make the video process settings (see page 270) or mask 
settings (see page 271) for application to the selected signal.

7 In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.
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After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.

Notes

• All freeze images written to temporary memory are lost when the system 
is powered off.

• If you change the frame memory to use as in step 2 before saving the 
freeze images written to temporary memory, all the freeze images in 
temporary memory are lost, unless the auto store function has been 
enabled in setup. With the auto store function enabled, the freeze images 
written to temporary memory are saved automatically when the frame 
memory selection is changed.

Saving a freeze image (Store)
You can save an image in temporary memory which has been placed with the 
freeze function as a file in memory. You can save a single image in a single file 
and apply a name of up to eight characters to the file.

Note

When the system is powered off, all the files saved in memory are erased.

To save a captured still image in a file, use the following procedure in the Still 
>Freeze/Store menu.

1 Press [Store].

The keyboard window (see page 84) appears.

2 In the keyboard window, enter the file name (maximum 8 characters).

Note

The following names cannot be used:
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2,
COM3, COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8,
LPT9

3 In the keyboard window, press the [Enter] button.

This saves the still image file in memory.

The destination folder is the folder selected in step 4 of “Freezing an image 
and writing it to memory.”
If the entered folder name already exists, a message to confirm overwriting 
appears.
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When the system is powered off, the file saved in memory is erased.

When the system is powered off, the file saved in memory is erased. 
However, you can recall a backed up file in the Frame Memory menu.

For details, see “File Backups” (page 301), and “Restoring backed up 
files” (page 302).

To carry out a freeze and store simultaneously (Freeze and Store)
Press [Freeze & Store], turning it on.
In this state, if you press [Frame] or [Field], this carries out a freeze, and 
simultaneously stores in a still image file.

Setting video processing
To set video processing for the signal selected on a frame memory source bus, 
use the following procedure in the Still >Freeze/Store menu.

1 In the <Video Process> group, press [Video Process], turning it on.

2 Use the knobs to adjust the following parameters.

To return the settings to the default values, press [Unity] in the <Video 
Process> group.

Note

When a pair setting is active, it is coupled to the video process on/off 
setting, but the above parameter settings are only valid for frame memory 
source bus 1. The pair setting cannot be used to set the frame memory 
source bus 2. If you want to set video process for frame memory source bus 
1 only with the pair setting when old settings for frame memory source bus 
2 remain, return the frame memory source bus 2 settings to their default 
values. When setting video process for the frame memory source bus 2, 
disable the pair setting.

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of the video signal –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Y signal black level –7.31 to +109.59
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Setting a mask

Masks can be set separately for frame memory source buses 1 and 2. To apply 
a mask to the signal selected on frame memory source bus 1, for example, use 
the following procedure in the Still >Freeze/Store menu.

1 Press [Box Mask] turning it on.

2 Use the knobs to adjust the following parameters.

3 To link the masks on frame memory source buses 1 and 2, press [Mask 
Link], turning it on.

Recalling Still Images

You can recall an image file saved in memory, and allocate to any of the FM1 
to FM8 outputs.

Recalling a still image
To recall a still image file saved in memory using the thumbnails, and assign it 
to an FM output, use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and HF1 ‘Recall.’

The Recall menu appears.
• When [Pair] is on, only pair files (pairs of main file and sub file) are 

displayed.

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00
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• When [Pair] is off, both single files and pair files appear.

2 In the frame memory selection area, select the FM to be assigned. (See 
page 267.)

3 If [Direct Recall] is on, press and turn it off.

4 Select the desired folder in the folder selection area.
By pressing [More] to switch the display, you can select from a maximum 
of 12 folders.

Thumbnails of the files within the selected folder appear.

5 Using the arrow keys or turning the knob, scroll the file thumbnail display.

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards

Main file

Sub file

Single file
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6 Press the thumbnail of the clip you want to recall.

7 Press [Recall].

This recalls the still image file, which is assigned to the FM you selected 
in step 2.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press [Direct Recall].

2 Press the thumbnail for the file you want to recall.

This immediately recalls the file.

To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], turning it on.

Image Processing

You can combine the background image (a still image file allocated to any of 
FM1 to FM8, a freeze image written to temporary memory, or a black signal) 
and the input signal.
The following types of processing are available.
Pattern key: Using the signal from a dedicated pattern generator, you can cut 

out the background image and insert the signal selected on the frame 
memory source bus or a color matte signal. You can adjust the size and 
position of the pattern, and add modifiers.

External key: When processing an image in FM1 (3, 5, 7), you can use the 
signal selected on the frame memory source bus 2 to cut out the 
background image, and fill with the signal selected on the frame memory 
source bus 1, or a color matte signal.
When processing an image in FM2 (4, 6, 8), you can use the signal selected 
on the frame memory source bus 2 to cut out the background image, and 
fill with a color matte signal (always white).

Note

An external key can only be used when the pair mode is enabled (see page 
259).

MIX: Mix the background image with the signal selected on the frame memory 
source bus or color matte signal. The mix ratio can be set.
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NAM: Non-additive mix the background image with the signal selected on the 
frame memory source bus or color matte signal.

Combining the background image and input signal

1 In the Frame Memory menu, select VF1 ‘Still’ and HF3 ‘Composite.’

The Composite menu appears.

2 In the frame memory selection area, select the FM to be assigned. (See 
page 267.)

3 To select V/K mode, press [V/K Mode], turning it on.

4 Press a button in the frame memory folder selection area, to select the 
folder to hold the freeze image.

For details of the selection method, see page 267.

Note

The folder selected here is the destination folder for writing the freeze 
image.
It is not possible to change the selection of this folder after the following 
step 5.

An orange bar appears on the selection button for the destination folder.

5 Press [Edit Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, and the combining of the background signal (the 
signal providing the background for combination) and the input signal (the 
signal providing the foreground for combination) is now possible.

Note

The input signal is lowered by one line, but when you apply a freeze, the 
freeze image is returned to the correct position.

6 To use a color matte signal for the input signal, press [Frgd Color], turning 
it on.
Even when pair mode is enabled, you can make separate settings for each 
FM.

7 Turn the knobs to adjust the following parameters.
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8 If you turned [Frgd Color] off in step 6, if required press [Input Adjust] to 
display the Input Adjust menu, and make the video process (see page 270) 
and mask (see page 271) settings for the input signal.

9 To set the background signal to black, press [Bkgd Black], turning it on.

Notes

• When the background signal is originally black, [Bkgd Black] remains 
on. 

• When the background signal is a freeze image (an image frozen, but not 
saved), turning [Bkgd Black] on erases the unsaved freeze image and, as 
a result, [Bkgd Black] remains on. 

10In the <Type> group, set the type of combination (see page 276).

11In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.

Notes

• All freeze images written to temporary memory are lost when the system 
is powered off.

• If you change the frame memory to use as in step 2 before saving the 
freeze images written to temporary memory, all the freeze images in 
temporary memory are lost, unless the auto store function has been 
enabled in setup. With the auto store function enabled, the freeze images 
written to temporary memory are saved automatically when the frame 
memory selection is changed.

Saving a processed freeze image
To save a processed freeze image as a file, in the Still >Composite menu use 
the following procedure.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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1 Press [Store].

The keyboard window appears.

2 In the keyboard window, enter the file name (maximum eight characters).

3 In the keyboard window press [Enter].

This saves the freeze image as a still image file in memory.
The destination folder is the folder selected in step 4 of “Combining the 
background image and input signal” (page 274).
If the entered folder name already exists, a message to confirm overwriting 
appears.

Selecting the way in which images are combined
To select the way in which the background image and input signal are 
combined (see page 273), use the following procedure.

1 In the <Type> group of the Still >Composite menu, select one of the 
following methods of combination.

• Pattern Key: pattern key
• Ext Key: external key

(This can only be selected when the pair mode is enabled. The signal 
selected on the frame memory source 2 bus is used as the key signal.)

• Mix: mix
• Nam: non-additive mix
If none of the above is selected, image combination is not carried out.

2 Depending on the selection in step 1, set the following parameters.

• When [Pattern Key] is selected

a) The patterns are the same as for a standard wipe. See “Wipe Pattern List” in Appendix 
(Volume 1) (page 353).

• When [Ext Key] is selected

Knob Parameter Adjustment Setting values

1 Size Size of pattern 0.00 to 100.00

2 Soft Edge softness of pattern 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Clip Reference level for key 
signal generation

+109.59 to –7.31

2 Gain Key sensitivity –100.00 to +100.00
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• When [Mix] is selected

3 When you selected a pattern key, press [Pattern Adjust].

The Pattern Adjust menu appears. In the menu, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See page 204.

• When turning [Multi] on and replicating the pattern

a) See page 209.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 208.

• When turning [Rotation Angle] on and inclining the pattern

a) See page 206.

To select the pattern, display the Pattern Select menu by pressing [Pattern 
Select] in the Pattern Adjust menu. You can change the pattern selected in 
step 2 here. After selecting one of the patterns (wipe patterns 1 to 24) 
displayed in the Pattern Select menu, you can adjust the following 
parameters.

Knob Parameter Adjustment Setting values

1 Mix Rate Mix proportion 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00 a)

2 Position V Vertical position –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of 
pattern horizontally

1 to 63

2 V Multi Number of repetitions of 
pattern vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)
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4 When you selected a pattern key or external key, if required press [Key 
Invert] in the Still >Composite menu to invert the key.

Image Output

There are two functions related to image output: the reposition function for 
moving the output image, and the lock function for fixing the output image.

Moving the output image (reposition function)
For up to two channels of FM1 to FM8 (one from FM1, FM3, FM5 and FM7 
and the other from FM2, FM4, FM6 and FM8), you can move the output image 
with respect to the screen. The area of the screen around the image that has 
been moved is filled with black. There are two ways of carrying out this 
repositioning.
Normal mode: Movement in the horizontal direction is in two-pixel 

increments.
Black and white mode: Movement in the horizontal direction is in one-pixel 

increments, and for each pixel moved the color is inverted.

Note

It is not possible to save an image moved with the reposition function directly 
to frame memory.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF1 
‘Reposition.’

The Reposition menu appears. In this menu, you can also enable the V/K 
mode (see page 268).

2 In the frame memory selection area, select the FM output (see page 267).

3 In the <Reposition> group, select the movement mode.

Normal: Move in normal mode.
Black&White: Move in black & white mode.

4 With the knobs, adjust the parameters to move the image.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00
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a) See page 204.

The surroundings of the moved image on the screen are filled with black.

5 To return the image moved by the reposition function to the center 
position, in the <Reposition> group press [Center].

Fixing the output image selection (lock function)
For the output of each of FM1 to FM8, this fixes the image at the current 
output. When this lock is enabled, even if the output is recalled in a snapshot 
or keyframe, the images output to FM1 to FM8 are preserved.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF2 
‘Lock.’

The Lock menu appears.

2 In the frame memory selection area, select the FM output. (See page 267.)

3 Press [Lock], turning it on.

This fixes the currently selected frame memory output image.
To release the lock, set [Lock] to off.

Continuously Capturing Still Images (Record)

You can continuously capture (freeze) a sequence of input video frames and 
store the sequence of the still images over a specified time interval.
The name of each image recorded in this way consists of a first character string 
followed by a second string.
First character string: A common part of name assigned to all the still images 

captured in one record operation. This string includes a maximum of four 
characters, which can be specified using a menu before carrying out the 
capture. The first string is automatically used as the clip name when the 
images are treated as a frame memory clip. 

Second character string: A four-digit number (0000 or greater), which is 
incremented each time a still image is captured.

Knob Parameter Adjustment Setting values

1 Position H Move in horizontal direction –200.00 to +200.00 a)

2 Position V Move in vertical direction –200.00 to +200.00 a)
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Note 

When using the record function to continuously capture frames, it is not 
possible to use the mask function.

Continuously freezing input images and writing to memory

1 In the Frame Memory menu, select VF1 ‘Still’ and HF4 ‘Animation 
Record.’

The Animation Record menu appears.

2 Select the desired frame memory.

For details of the operating procedures, see “Selecting outputs (FM) and 
target frame memory” (page 266).

3 To use V/K mode, press [V/K Mode], turning it on.

4 Press a button in the frame memory folder selection area, to select the 
folder to hold the freeze image.

For details of the selection method, see page 267.

Note

The folder selected here is the destination folder for writing the freeze 
image.
It is not possible to change the selection of this folder after the following 
step 5.
An orange bar appears on the selection button for the destination folder.

5 Press [Record Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, the recording function is now possible.

6 Input the file name if required.

Pressing [File Name] displays the keyboard window and you can enter the 
first character string (up to four characters) of the file name.

7 Set the recording time if required.

Pressing [Duration] displays the numeric keypad window, in which you 
can enter the recording time in the form of timecode.
If you set the recording time to zero, this uses all frame memory in which 
storing is possible for recording.
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8 If required, set video processing for the selected signal.

For details of the operating procedures, see “Setting video processing” 
(page 270).

9 Press [Record], to start recording.

When the recording time is set, recording stops once the time has elapsed.

10Press [Stop] to stop recording.

Even if the recording time is set, you can still stop recording before the set 
time has elapsed.

Recalling a Continuous Sequence of Still Images 
(Animation)

You can use a continuous sequence of images captured with the record function 
as keyframes to create an effect. By executing this effect you can recall the 
continuous sequence (animation).

Notes 

• For example, to create an effect using FM1, FM1 must be assigned to a user 
region. 

• To execute the effect, you must assign the user region to which FM1 is 
assigned to a region selection button in the numeric keypad control block. 
(For details of assigning to region selection buttons, see Chapter 19 
“Control Panel Setup (Panel)” (Volume 3).)

In the Frame Memory menu, effect creation follows the image file names. Of 
the eight characters in the file names, if files have the same characters except 
for  the last three characters they are treated as an image file group, and the 
effect is created with the last three (numeric) characters in sequence.

Note 

When creating the effect in pair mode (see page 259), the files used must be 
main files and sub files with the same last three (numeric) characters in the file 
name.

To recall a continuous sequence of still images, create an effect in the user 
region with the still image files as a keyframe, and run the created effect.
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Creating an effect with still image files as a keyframe

1 In the Frame Memory menu, select VF1 ‘Still’ and HF5 ‘Create Key 
Frame.’

The Create Key Frame menu appears.
• A thumbnail appears for each group of files having the same characters, 

except for the last three characters, in the file name.
• When [Pair] is on, only pair files (each pair comprising a main file and 

a sub file) appear.
• When [Pair] is off, both single files and pair files all appear.

2 In the frame memory selection area, select the frame memory to be 
assigned.

This creates the effect in the user region to which the selected frame 
memory is assigned.

For details of the operating procedures, see “Selecting outputs (FM) and 
target frame memory” (page 266).

3 Select the desired folder in the folder selection area.
By pressing [More] to switch the display, you can select from a maximum 
of 12 folders.

Thumbnails of the files within the selected folder appear.

4 Turn the knob to select the register number in the user region.

Note

To search for an empty register in the user region, use the numeric keypad 
control block (see step 3 of “Recalling a Register” in Chapter 13 (Volume 
2)).

5 Use the arrow keys or turn the knobs to scroll the thumbnail display of the 
files.

6 Select the thumbnail of the files to be used for the keyframe.

Knob Parameter Adjustment Setting values

5 Register Effect register number 1 to 99

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards
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7 If necessary, turn the knob to check the animation effect in the thumbnail 

display.

8 Using the region selection buttons in the numeric keypad control block or 
the Multifunction Flexi Pad control block, select one of the regions (User1 
to User8) to which the frame memory output signals have been assigned.

9 Carry out either of the following.

• To clear the effect register selected in step 4, and create a new effect: 
press [Create Key Frame].

• To add to the end of the effect register selected in step 4, press [Append 
Key Frame].

A confirmation message for creating the effect appears.
If there is an inappropriate condition for creating the effect, an error 
message appears.

For details of error messages, see “Error Messages” in the Appendix 
(Volume 3).

10Press [OK].

This creates the effect in the selected user region register.

To cancel creating the effect
Press [Cancel].

Notes

• The effect is built with the selected files, in increasing order of the last three 
characters of the file name. If you do not want to include some of these files 
in the effect, first delete or rename them.

• A maximum of 99 keyframes can be included in a single effect.

Recalling a sequence of still images
Run the effect created by the foregoing procedure.
The procedure for doing this is the same as for any other effect.

For details, see “Executing Effects” in Chapter 13 (Volume 2).

Knob Parameter Adjustment Setting values

3 Viewer Animate thumbnail display 
of files

00:00:00 and upwards
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Frame Memory Clip Function

What is a “frame memory clip”?
Movies can be read into frame memory, and recalled and played back. A movie 
held in frame memory is called a “frame memory clip.”
A frame memory clip can be named using up to four characters. (For details of 
frame memory clip names, see “Continuously Capturing Still Images 
(Record)” (page 279).)

Frame memory clip settings
For frame memory clips, you can make the following settings using a menu or 
device control block (trackball/search dial/joystick).
• Start point 
• Stop point 
• Loop On/Off
The above settings can be saved in a snapshot register as snapshot attributes, 
and recalled.
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Frame Memory Clip Operations

For an overview of frame memory clip concepts, see “Frame Memory Clip 
Function” (page 284).

Note

During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 287), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Preparations for Operation

The preparations for using a frame memory clip (hereafter, a “clip”) are the 
same as for a still image operation. See “Preparations” (page 261) and 
“Selecting Outputs and Target Frame Memory” (page 266).

Recalling Clips

Recalling a clip
You can recall a clip from each of frame memories 1 to 8.

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF1 ‘Recall.’

The Recall menu appears. (See following figure)
• When [Pair] is set to On, only pair files (sets of main file and sub file) 

are shown.
• When [Pair] is set to Off, both of single files and pair files are shown.
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2 In the frame memory selection area, select an assigned target FM. (See 
page 266)

3 If [Direct Recall] is on, press the button, turning it off.

4 In the folder selection area, select the desired folder.

By pressing [More] to switch the displays, you can select from a maximum 
of 12 folders.
Thumbnails of the files within the selected folder appear.

5 Using the arrow keys or turning the knob, scroll the file thumbnail display.

6 Press the thumbnail of the clip you want to recall.

7 Press [Recall].

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards

Target selection buttons

Pair selection buttons

Clip file selection area

Frame memory 
selection area

Frame memory 
folder selection area

Direct Recall button
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This recalls the clip file, which is assigned to the FM you selected in step 2.
In pair mode, if a clip is selected, the main file is output to FM1, and the 
sub file to FM2. In single mode, when only one of FM1 and FM2 is 
selected, the front file on the thumbnail is output.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press [Direct Recall].

2 Press the thumbnail for the file you want to recall.

This immediately recalls the file.

To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], turning it on.

Clip Playback

You can play a recalled clip by a menu operation or by using the device control 
block.

Note

With a pair file recalled, it is possible to set [Pair] to Off and carry out a single 
file operation, but if you then set [Pair] to On again, the output of frame 
memory may be black. In such cases it is necessary to recall the pair file once 
more.

Playing a clip using the menu

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF2 ‘Play.’

The Play menu appears. The status of the clip shown in the current target 
FM selection buttons appears here.
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2 When [Pair] is Off, press a target FM selection button to select the target.

3 To set loop playback, press [Loop], turning it on.

4 To start playback, press [Play]. During playback, to stop, press [Stop].

To cue up
Press [Cue].

To play the image at the beginning of the clip (Clip Begin)
Press [Rewind].

To play the image at the end of the clip (Clip End)
Press  [FF].

Playback start point 
(pale blue bar)

Current position 
(red bar)

Playback end point 
(yellow bar)

Status buttons
These show the timecode values for 
the start point, current position, and 
end point.
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To specify the playback start point
To set the current position as the playback start point, in the <Start TC> group, 
press [Set]. To set a different position, press the [Start] status button, and enter 
a timecode value from the numeric keypad window.

To specify the playback stop point
Start playback, and at the desired position press the [STOP] button to stop 
playback, then in the <Stop TC> group, press [Set]. To set to any position, 
press the [Stop] status button, and enter a timecode value from the numeric 
keypad window.

To change the current position
To change the current position, press the [Current] status button, and enter a 
timecode value from the numeric keypad window.

Using the device control block (MKS-8036A Search Dial Module, 
option) to play back clips

Note

A frame memory clip must first be recalled with a menu operation.

1 With the device selection buttons, select the frame memory clip to be 
played (FM1 CLIP to FM8 CLIP).

If the pair mode is on, both main and subsidiary FMs light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], [JOG], [CUE], 
[REW], [FF], and [ALL STOP] buttons.

For details of the buttons in the device control block (MKS-8036A search 
dial module, option), see “Device Control Block (MKS-8036A Search Dial 
Module, Option)” (page 62) in Chapter 2.

To specify the playback start point
To make the current position the playback start point, press the [START TC] 
button. To set a different position, press the [SET START TC] button, then 
enter the timecode from the numeric keypad control block.

To specify the duration
Press the [SET DUR] button, and enter a timecode from the numeric keypad 
control block. If the playback start point is already set, this automatically sets 
the playback stop point. If the playback stop point is already set, this 
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automatically sets the playback start point. (The duration setting is not 
displayed in the device control block.)

To specify the playback stop point
Start playback, and at the desired position press the [STOP] button to stop 
playback, then press the [STOP TC] button. To set to any position, press the 
[SET STOP TC] button, and enter a timecode from the numeric keypad control 
block.

To carry out the variable speed playback
Use the search dial.

For details on using the search dial, see “Controlling the Tape/Disk 
Transport” in Chapter 12 (Volume 2).

To apply a loop to a frame memory clip
Press the [LOOP] button.

Using the device control block (MKS-8031TB trackball module, 
option) to play back clips

Note

A frame memory clip must first be recalled with a menu operation.

1 Press the [DEV] button in the region selection buttons, and select the frame 
memory clip for playback (FM1 CLIP to FM8 CLIP).

If the pair mode is on, both main and subsidiary FMs light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], [JOG], [CUE], 
[REW], [FF], and [ALL STOP] buttons.

For details of the buttons in the device control block (MKS-8031TB trackball 
module, option), see “Device Control Block (MKS-8031TB Trackball Module, 
Option)” (page 59) in Chapter 2.

For details of the playback start point, stop point, and duration settings, see the 
previous item, “Using the device control block (MKS-8036A Search Dial 
Module, option) to play back clips” (page 289).

To carry out the variable speed playback
Press any of the [SHTL], [JOG], and [VAR] buttons, then turn the Z-ring or 
move the joystick. The image changes in the forward direction when you turn 
the Z-ring clockwise, and in the reverse direction when you turn it 
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counterclockwise. Move the joystick to the right for the forward direction and 
to the left for the reverse direction.
When you pressed the [JOG] button: Playback is at a speed corresponding 

to the turning speed of the Z-ring or the movement speed of the joystick.
When you pressed the [SHTL] button: Playback is at a speed corresponding 

to the rotation angle of the Z-ring or amount of movement of the joystick.
When you pressed the [VAR] button: Playback is at a speed corresponding 

to the rotation angle of the Z-ring or amount of movement of the joystick, 
in the range –1 to +3 times normal speed.

Clip Creation

You save a movie as a clip.

Note

If the number of frame memory clips exceed 100 single files (50 pair files), an 
error appears.

Using the menu to record clips

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF3 ‘Record.’

The Record menu appears.
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2 With [Pair] off, press the operation target selection button, to select the 
operation target.

3 In the folder selection area, select the folder containing the clip to be 
recorded.

4 To set the clip name, press [Name].

A keyboard window appears.

5 Enter the clip name, and press Enter.

6 To start recording, press [Record Start].

7 To end recording, press [Record Stop].

To set the clip duration

1 Press [Clip Duration].

A numeric keypad window appears.

2 Enter a timecode value or number of frames, and press Enter.

Frame memory 
selection area

Operation target 
selection buttons

Pair selection 
buttons

Folder selection 
area
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This confirms the clip duration.

Creating and Handling Frame Memory Folders

You can create, rename, and delete frame memory folders.

Creating a new folder

1 In the Frame Memory menu, select VF5 ‘Folder.’

The Folder menu appears. The status area shows a list of the current folder 
settings.

2 Select [New].

A keyboard window appears.

3 Enter the folder name, and press Enter.

This confirms the folder name.

Changing the folder name

1 In the Frame Memory >Folder menu, select the folder with the arrow keys 
or by turning the knobs.

2 Press [Rename].

A keyboard window appears.

3 Enter the new folder name, and press Enter.

Note

The following names cannot be used for folders:
Default, Flash1, Flash2
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2,
COM3, COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8,

Knob Parameter Adjustment Setting values

1 No. Folder selection 1 to 12

2 Num Number of files to select 
consecutively from selected file

1 to 12
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LPT9

This changes the folder name.

Deleting a folder

1 In the Frame Memory >Folder menu, select the folder with the arrow keys 
or by turning the knobs.

To select all folders, select [All].

2 Press [Delete].

A confirmation message appears.

3 To carry out the deletion select [Yes], and to cancel the deletion select 
[No].

Note

It is not possible to delete the default folder (named “Default”).

Clip Output

As for still image operation, you can use the reposition and lock functions.

For details of the operation, see “Image Output” (page 278).

Knob Parameter Adjustment Setting values

1 No. Folder selection 1 to 12

2 Num Number of files to select 
consecutively from selected file

1 to 12
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Clip Transition Operations

A frame memory clip (movie) is played back, linked to a transition using a mix 
(dissolve) or wipe.

The following restrictions apply to the use of a clip transition.
• Key frame capture is not possible.
• It is not possible to apply a pattern limit.
• Transitions executed in two strokes, such as a preset color mix with the 

stroke mode set to Normal, or a DME wipe with a picture-in-picture pattern, 
will not execute correctly.

• It is not possible to vary the transition rate of a clip transition.
• Transition preview cannot be used.
• No instantaneous state of a clip transition can be saved as a snapshot.
• When recalling a snapshot including a clip transition during executing 

another clip transition, the follow-on transition does not operate properly. Be 
sure to complete the transition before recalling a snapshot.

Note

When a clip transition is selected as the transition type, if one of the wipe 
direction selection buttons in the transition control block is lit, it indicates the 
direction of clip playback.

Setting a clip transition
The following example describes the case of a clip transition using FM 1&2 
Clip on the M/E-1 bank.

Note

To use a clip transition effectively, the image from the frame memory clip 
being played back during the clip transition should be seen in the M/E-1 
program output. For example, inserting a key using frame memory output 1 and 
frame memory output 2.

1 Display the M/E-1 >Misc >Transition menu, and in the <Transition Type> 
group select “FM1&2 Clip.”

2 Press [Clip Transition].

The Clip Transition menu appears.
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3 Press the [Clip] button.

The Clip menu appears, and the status area shows a list of clips.

4 Select the clip to use in the clip transition.

5 Return to the Clip Transition menu, and in the <BKGD Transition Type> 
group, select the background transition type.

Note

For details of the background transition selected here, see the various 
adjustments in the M/E-1 >Misc >Transition menu.

6 In the <Select> group, press [BKGD Transition].

7 Use either of the following methods to set the background transition start 
point independently of the clip playback timing.

• Move the fader lever to the desired position, and in the <BKGD 
Transition Set Timing> group press [Start].

Clip display area

Background transition display area Clip transition display area
Clip Transition Operations
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• Turn knob 1 to set the number of frames. (The left end of the reference 

axis (see following figure) is the position of frame 0.)

8 Using either of the following methods, set the end point of the background 
transition.

• Move the fader lever to the desired position, and in the <BKGD 
Transition Set Timing> group press [Stop].

• Turn knob 2 to set the number of frames.

9 If Wipe or DME Wipe is selected in the <BKGD Transition Type> group, 
in the <BKGD Transition Direction> group, select the background 
transition direction.

10In the <Select> group, press [FM 1&2 Clip].

11Using either of the following methods, set the start point of the clip.

• Move the fader lever to the desired start point, and in the <Clip 
Transition Set Timing> group press [Start].

• Turn knob 1 to set the number of frames. (The left end of the reference 
axis (see previous figure) is the position of frame 0.)

Note

It is not possible to set the end point.

12In the <Clip Transition Direction> group, select the playback direction of 
the clip.

To reset the start point and end point
Press [Timing Reset].
The background transition start point and end point, and the clip start point are 
all reset.

Position of frame 0 Reference axis
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Image Data Management

You can carry out the following operations on the files in which images are 
saved.
• Pair file processing
• Move
• Delete
• Rename
• Backup
• Restore

Note

During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 287), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Pair File Processing

You can create a pair file from two single files. In the reverse direction, you 
can split a pair file into two single files.
Couple: You can create a pair file from two single still image files or clip files.
Separate: You can also separate a pair file into two single still image files or 

clip files.

Creating a pair file from two single files

Note

Carrying out the following operation automatically switches [Pair] to On.

The following description applies to the case of FM1&2, but the procedures are 
similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame Memory >Clip 
>Recall menu, recall the two single files you want to convert to a pair file, 
to FM1 and FM2.

2 In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Pair 
Recombination.’
Image Data Management
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The Pair Recombination menu appears.

3 Press [Couple].

This converts the files output to FM1 and FM2 to a pair.

Splitting a pair file into two single files

Note

Carrying out the following operation automatically switches [Pair] to Off.

The following description applies to the case of FM1and FM2, but the 
procedures are similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame Memory >Clip 
>Recall menu, recall the pair file.

2 Select the folder in which the file to be moved is stored.

3 In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Pair 
Recombination.’

The Pair Recombination menu appears.

4 Press [Separate].

The FM1 and FM2 pair file is split into separate single files.

Moving Files

1 In the Frame Memory menu, select VF4 ‘File’ and HF5 ‘Move.’

The Move menu appears. The status area shows files to be moved in the 
upper area, and destination files in the lower area.

2 Select the folder which contains the file to be moved.

3 Using any of the following methods, select the file to be moved.

• Press the arrow keys to scroll the display.
• Press directly on the thumbnail in the status area.
• Turn the knobs.

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards
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4 Select the destination folder and file.

5 Press [Move].

6 To confirm the move press [Yes], and to cancel press [No].

Deleting Files

1 In the Frame Memory menu, select VF4 ‘File’ and HF5 ‘Delete.’

The Delete menu appears. In the status area, whether pair mode is on or 
off, all of the saved files appear as thumbnails.

2 Select the folder which contains the file to be deleted.

3 Using either of the following methods, select the file to be deleted. If 
necessary, press the arrow keys to scroll the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

• To delete all files, press [Select All], turning it on.
• When a clip thumbnail is selected, the still image files making up the clip 

are also selected for deletion.

4 If necessary, turn the knob to check the contents of the frame memory clip 
through the thumbnail display.

5 Press [Delete].

A message for confirming the deletion appears.

6 To confirm the deletion press [Yes], and to cancel press [No].

2 Num Selection of number of files in 
sequence

1 and upwards

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

2 Num Selection of number of files in 
sequence

1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer For a movie, the current frame 
position. For a still image, no effect.

00:00:00 and 
upwards
Image Data Management
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Renaming Files

1 In the Frame Memory menu, select VF4 ‘File’ and HF6 ‘Rename’

The Rename menu appears. In the status area, whether pair mode is on or 
off, all of the saved files appear as thumbnails.

2 Using either of the following methods, select the file to be renamed. If 
necessary, press the arrow keys to scroll the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

3 If necessary, turn the knob check the contents of the frame memory clip 
through the thumbnail display.

4 Press [Rename].

A keyboard window appears.

5 Enter the new name, then press [Enter] in the keyboard window.

Note

The following names cannot be used:
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

This renames the file.

File Backups

To back up a file saved in memory to hard disk, use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF7 ‘Backup/Restore.’

The Backup/Restore menu appears.

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer For a movie, the current frame 
position. For a still image, no effect.

00:00:00 and 
upwards
301Image Data Management



302

   C
hapter 7 

Fram
e M

em
ory
2 Press [Backup].

This backs up the saved file.

Restoring Files

Restoring backed up files
To recall files backed up on the hard disk, use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF7 ‘Backup/Restore.’ 

The Backup/Restore menu appears.

2 Press [Restore].

This recalls the backed up file.
Image Data Management
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Color Background

The dedicated generators generate color signals, and these can be used as color 
backgrounds in video effects.

Color background selection
There are two color backgrounds, color background 1 and color background 2, 
which you use by assigning to cross-point buttons.

Color combinations (“color mix”)
The color generators can output the result of combining two colors, which are 
color 1 and color 2.
Using a pattern from a dedicated pattern generator, color 1 and color 2 can be 
combined in the boundary region, forming a color gradation. This is referred to 
in the menu system as “color mix.”
You can also apply modifiers to the selected pattern.
When the “color mix” function is not used, the result is a flat color, and color 
1 is always output.

You carry out color background settings in the Color Bkgd menu. This section 
describes the settings menu for color background 1 as an example.

Color Background Settings Menu

Accessing the Color Bkgd1 menu
Use either of the following operations.
• In the menu control block, select the top menu selection button [COLOR 

BKGD], and press VF1 ‘Color Bkgd1.’
• Press a cross-point button assigned to color background 1 twice in rapid 

succession.
The above operation displays the Color Bkgd1 menu.

Basic Color Background Setting Operations

Making a single-color matte (Flat Color)
If you are not using the “color mix” function to combine two colors, use the 
following procedure.
Color Background
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1 In the <Matte> group of the Color Bkgd 1 menu, press [Flat Color], turning 
it on.

You can now adjust color 1.

2 Set the following parameters.

Making a color combination (color mix)
To combine color 1 and color 2, use the following procedure.

1 In the <Matte> group of the Color Bkgd1 menu, press [Mix Color], turning 
it on.

2 Set the following parameters as required.

a) The patterns are the same as for a standard wipe. See “Wipe Pattern List” (page 353).

You can also carry out the pattern selection by pressing the [Mix Ptn 
Select] button, to display the Mix Ptn Select menu. Select any pattern 
appearing in the Mix Ptn Select menu (standard wipe patterns 1 to 24), and 
you can then adjust the following parameters.

3 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on, 
then adjust the parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softening of edge 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00
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4 If required, set the pattern modifiers.

• When turning [Position] on and setting the pattern position

a) See page 204.

• When turning [Multi] on and using replications of the same pattern 

a) See page 209.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 208.

• When turning [Pairing] on and making a wipe pattern like a 
Venetian blind

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 206.

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Width Width of the slits 1 to 128 (integer)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)
Color Background
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• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 206.

• When selecting H (horizontal) or V (vertical) in the <Modulation> 
group and applying waviness to the pattern
(The modulation is always a sine wave.)

5 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves –100.00 to +100.00
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Copy and Swap

You can copy and swap the settings among the M/E-1 and PGM/PST banks or 
between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E-1 to M/E-3, and PGM/PST banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition control block
• Matte data (color 1, color 2, and how to compose them)
• Color settings
• DME channel settings

You can carry out copy operations with a simple button operation. Swap 
operations, and copy operations on DME data can only be done with a menu 
operation.

M/E copy and M/E swap
You can copy and swap the overall bank settings between the M/E-1 and PGM/
PST banks.

Note

If a DME is being used on the source M/E bank, then if for example there are 
insufficient DME channels, it may not be possible to select the DME.
There are no such restrictions on a swap.

Keyer copy and keyer swap
You can carry out copy and swap operations among the keyers listed in the 
following table.

Target bank Target data

M/E-1
PGM/PST

Bank settings excluding the following data items:
• Setup data
• Snapshots
• Keyframe effects
• Key snapshots
• Key memory
Copy and Swap
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Note

If a DME is being used on the source keyer for a copy or either keyer for a 
swap, then if for example there are insufficient DME channels, or the limit on 
using DME channels within an M/E bank is exceeded, it may not be possible 
to select the DME.

Wipe copy and wipe swap
You can copy and swap the wipe settings between the banks.

Wipe copy and wipe swap in the independent key transition 
control block

You can copy and swap the wipe settings among the keyers listed in the 
following table.

DME wipe copy and DME wipe swap
You can copy and swap the DME wipe settings between the banks listed in the 
following table.

Target bank Target keyer Target data

M/E-1 Keys 1 to 4 Key settings excluding the following data 
items:
• Setup data
• Key snapshots
• Key memory

PGM/PST Downstream keys 1 to 4

Target bank Target data

M/E-1
PGM/PST

Wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition wipe settings.

Target bank Target keyer Target data

M/E-1 Keys 1 to 4 Wipe settings in the independent key 
transition control block.

PGM/PST Downstream keys 1 to 4

Target bank Target data

M/E-1
PGM/PST

DME wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition DME wipe settings.
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DME wipe copy and DME wipe swap in the independent key 
transition control block

You can copy and swap the DME wipe settings among the keyers listed in the 
following table.

Matte data copy and swap
You can copy or swap the matte data among the color generators listed in the 
following table.

Color data copy and swap
You can copy or swap the color data among the color generators listed in the 
following table.

Target bank Target keyer Target data

M/E-1 Keys 1 to 4 DME wipe settings in the independent 
key transition control block.

PGM/PST Downstream keys 1 to 4

Target bank Target keyer and data

M/E-1
PGM/PST

• Keys 1 to 4
• Downstream keys 1 to 4

• Matte data for key fill
• Matte data for key edge fill

Matte data for wipe border edge

Color background • Matte data for color background 1
• Matte data for color background 2

Target bank Target keyer and data

M/E-1
PGM/PST

• Keys 1 to 4
• Downstream keys 1 to 4

• Colors 1 and 2 for key fill
• Colors 1 and 2 for key edge fill
• “Zabton” color data

Colors 1 and 2 for wipe border

Color data for preset color mix

Color background • Colors 1 and 2 for color background 1
• Colors 1 and 2 for color background 2

Frame memory • FM1 color
• FM2 color

DME ch1 to ch4 • Background
• Border
• Sepia
• Light
• Shade
• Drop shadow (other than DME ch4)
• Trail
Copy and Swap



  C
hapter 8 

C
olor B

ackgrounds, C
opy and S

w
ap, and O

ther S
ettings
DME channel copy and swap
You can copy and swap the channel data among DME channels 1 to 4.
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Copy and Swap Operations

Copy and Swap Menu Operations

Accessing the Copy/Swap menu
In the menu operation section top menu selection buttons, press the [Copy/
Swap] button, then press VF1 ‘Copy/Swap.’ The Copy/Swap menu appears.
Here a copy/swap operation on wipe data is described by way of example, 
using the Copy/Swap >Wipe menu, but the same general procedure applies to 
all of the following menus.
• M/E: Copying and swapping M/E data
• Key: Copying and swapping key data
• Wipe: Copying and swapping wipe data
• DME Wipe: Copying and swapping DME wipe data
• Matte: Copying and swapping matte data
• Color: Copying and swapping color data
• DME: Copying and swapping data by DME channels

For an overview of the concepts involved, see “Copy and Swap” (page 308). 
For details of color corrector copy and swap, see Chapter 9 “Color 
Corrector” (page 327).

Note

To use DME requires the BKDS-9470 DME Board Set or the MVE-8000A/
9000 Multi Format DME Processor.

Copying and swapping wipe data
As an example, to copy or swap wipe data, use the following procedure.

1 In the Copy/Swap menu, select HF3 ‘Wipe.’

The Copy/Swap >Wipe menu appears.
The status area shows lists for the copy/swap source on the left, and the 
copy/swap destination on the right.

2 In the <Data Select> group, select either of the following.

Wipe: The operation applies to wipes in the transition control block.
Key Wipe: The operation applies to wipes in the independent key 

transition control block.
Copy and Swap Operations
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3 Using any of the following methods, select the data to be copied or 
swapped.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs to make the setting.

a) Transition control block wipe data
b) Independent key transition control block wipe data

For details of the data affected, see “Copy and Swap” (page 308).

4 To copy, press [Copy], and to swap, press [Swap].

This carries out the copy or swap.

To undo a copy or swap 
Press [Undo], to return to the state before the copy or swap was carried out.

Copy by Button Operation

You can copy key data by a simple button operation.

Basic button operation
The basic button operation is to hold down the copy source button, then press 
the destination button.
You can undo the last operation using [Undo] in the menu (see page 313).

Keyer copy button operation
Use the key delegation buttons in the respective banks.

To copy from M/E-1 key 1 to P/P downstream key 2
Hold down the M/E-1 key delegation button [KEY1] and press the P/P key 
delegation button [DSK2].

Knob Parameter Adjustment Setting values

1 Left No Select data for copy/swap 
source

1 to 4 a)

1 to 16 b)

2 Right No Select data for copy/swap 
destination

1 to 4 a)

1 to 16 b)
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Misc Menu Operations

In the Misc menu, you can carry out the following operations.
• Enabling and disabling operation from an external device, System Manager, 

or an editing keyboard.
• Switching the safe title function on or off for each switcher output.
• Displaying the transition rate, independent key transition rate, and fade-to-

black transition rate for each of the M/E and PGM/PST banks, and changing 
the settings.

Port Settings for Control From an External Device

Enabling or disabling control from an external device

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears with the status area 
showing the settings of the following ports.
• Switcher Remote 1 to Remote 4 ports (RS-422A, D-sub 9-pin)
• Switcher GPI port (parallel, 25-pin) 
• DME1/DME2 Editor ports (RS-422A, D-sub 9-pin)
• DME1/DME2 GPI ports (parallel, 25-pin)

2 In the <Switcher> or <DME> group, press on the name of the port for 
which you want to disable control from an external device, turning it off. 
To re-enable control for the port, press on its name once more.

Notes

• It is not necessary to make any settings for DME2.
• For the AUX bus operation from the Remote1 to Remote4 ports of the 

switcher, the setting (Enable/Disable/Manual) in the Setup menu takes 
precedence. Only when the setting is “Manual,” the settings made in the 
Port Enable menu apply.

For details, see “Interfacing With External Devices (Device Interface 
Menu)” in Chapter 19 (Volume 3).
Misc Menu Operations
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DME override

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 In the <DME Override> group, select the DME override mode.

DME Override: When a switcher snapshot or effect using a DME is 
recalled, forcibly select the DME that was used when saving.

On Air Protect: The operation is the same as the DME override function, 
except that a DME being used by an M/E bank or P/P bank that is on 
air will not be forcibly selected.

Note

If effects using the same DME channel are selected simultaneously in two 
or more regions, the DME is selected with the order of precedence P/P >M/
E1 >M/E2 >M/E3.

Enabling or disabling control from System Manager
By installing the BZPS-8000 System Management Software (System 
Manager), you can use a computer connected on a network for management of 
some switcher data and control operations.
To enable or disable this function, use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 Press [System Manager].

Each time you press the button toggles between enable and disable.

Editing Keyboard Settings

Note 

The following operations are only possible when a license for the BZS-8050 
Editing Control Software is activated. For details of license registration, see 
“Installation and Device Setup (Install/Unit Config Menu)” in Chapter 18 
(Volume 3).
315Misc Menu Operations



316

   C
hapter 8 

C
olor B

ackgrounds, C
opy and S

w
ap, and O

ther S
ettings
Enabling or disabling control from the editing keyboard

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF2 ‘Plug-In Editor.’

The Misc >Enable >Plug-In Editor menu appears.

2 In the <Control From Plug-In Editor> group, press [Editor Enable].

Each time you press the button toggles between enable and disable.

To enable control of the preview bus only
When control from the editing keyboard is disabled (when [Editor Enable] is 
set to Disable), to enable control of the preview bus only, press [PVW Bus 
Enable] in the <Control From Plug-In Editor> group.

Safe Title Settings

Switching the safe title function on or off

1 In the menu control block, press the top menu selection button [MISC] and 
select VF2 ‘Safe Title.’

The Misc >Safe Title menu appears.

2 Using any of the following methods, select the signal to which the settings 
apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

Notes

• It is not possible to change the setting for the output for which the safe 
title is set off in a Setup menu.

• The safe title function cannot be used for output signals for which 
through mode is set to Enable in a Setup menu.

For more information about the Setup menu settings referred to above, see 
“Signal Input Settings (Input Menu)” and “Signal Output Settings (Output 
Menu)” in Chapter 20 (Volume 3).

Knob Parameter Adjustment Setting values

1 Output Signal to which the settings 
apply

1 to 48
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3 Press [Safe Title] to set it on or off.

Displaying a List of Transition Rates and Changing the 
Settings

In the Transition menu, for each bank you can display a list of the M/E (or 
PGM/PST) transition rates and independent key (or DSK) transition rates, and 
change the settings.
These settings are linked to the other transition rate setting operations.

Displaying the Transition menu
In the menu control block, press the top menu selection button [MISC], then 
select VF3 ‘Transition.’
The Misc >Transition menu appears.

About the Transition menu display
The display of the independent key transition rate in the Misc >Transition 
menu depends on the selection in the <Key Transition> group of the 
Engineering Setup >Switcher >Transition menu for each of the M/E and PGM/
PST banks.

When [Same] (On direction and Off direction settings the same) is selected 
in the <Key Transition> group: Only “Key” (or “DSK” in the PGM/PST 
bank) appears.

When [Independ] (On direction and Off direction settings independent) is 
selected in the <Key Transition> group: “Key(On)” and “Key(Off)” 
each appear. In the case of the PGM/PST bank, “DSK(On)” and 
“DSK(Off)” appear.

For more details, see “Settings Relating to Video Switching (Transition 
Menu)” in Chapter 20 (Volume 3).

Setting the transition rate in the Transition menu
For example, to make the settings for the M/E-1 bank, use the following 
procedure.

To set the M/E transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press 
[Transition].

2 Turn the knob to set the number of frames.
317Misc Menu Operations
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Note 

When a clip transition is selected as the transition type, it is not possible to 
change the transition rate in this menu.

To set the independent key transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press 
[Key]. 
To set the key On direction or Off direction independently, press Key(On) 
or Key(Off).

2 Turn the knobs to set the number of frames.

To set the fade-to-black transition rate in the Transition menu

Note 

This function is not available with the CCP-9000.

1 In the Misc >Transition menu, press [FTB].

2 Turn the knob to set the number of frames.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frames)

Knob Parameter Adjustment Setting values

1 Key1 Trans Rate Key 1 transition rate 0 to 999 (frames)

2 Key2 Trans Rate Key 2 transition rate 0 to 999 (frames)

3 Key3 Trans Rate Key 3 transition rate 0 to 999 (frames)

4 Key4 Trans Rate Key 4 transition rate 0 to 999 (frames)

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frames)
Misc Menu Operations
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AUX Menu Operations

AUX Bus Settings

Making video process settings for an AUX bus

1 In the Aux/Mon >Aux Bus menu, using any of the following methods, 
select the AUX bus to which the settings apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults, press [Unity].

Knob Parameter Adjustment Setting values

1 AUX Bus AUX bus selection 1 to 48

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Luminance signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –7.31 to +109.59
319AUX Menu Operations
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Status Menu

The Status menu shows the following information.
• Operating status of the DME

Viewing the DME operating status
To view the DME operating status, press the top menu selection button 
[STATS] in the menu control block.
This selects VF1 ‘DME Status’ and the Status menu appears.

For each DME channel, you can see how the DME is being used in the 
corresponding operation block.
The display background color also indicates the following differences in the 
way in which a DME is being used.
Blue: The DME is currently being used in other than the final program output.
Red: The DME is currently being used in the final program output.

DME status display
Status Menu
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Router Control Menu Operations

Using the Router >Router Control >Router Control menu, you can carry out 
router switching operations.

Checking the List of Inputs for Each Destination

You can check the list of signals currently input for each destination.
In the menu control block, press the top menu selection button [RTR], then 
select VF1 ‘Router Control’ and HF1 ‘Router Control.’
The following menu appears, and the left side of the status area shows a list for 
destination assignments.

If in the Assign >RTR Mode Setting menu, [Inhibit] is set to On for a 
destination, the corresponding line appears in gray. Also, if [PROT] (protect) 
is set to ON for a source, using a BKSR3xxx or R1xxx series Router remote 
control, a padlock icon appears.
The right side of the status area shows the level assignment status to the Level 
1 to Level 4 buttons.

Selecting the level
In the Level Button No group at the lower right in the above illustration, press 
the selected level for switching.
321Router Control Menu Operations
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Switching the Source for Each Destination

You can switch the source for each destination with a menu operation.

For the assignment of destinations and sources to buttons, use the Setup 
>Panel >Aux Assign >RTR Mode Setting menu.  For details, refer to “Using 
the Auxiliary Bus Control Block for Router Control” in Chapter 19 (Volume 3).

1 Press [Change Xpt].

The Router >Router Control >Router Control >Change Xpt menu appears.
Destination Select buttons appear in groups of 16.
Source Select buttons appear by group (maximum 24 buttons).

2 Press one of the Destination Select buttons, to select the destination for 
which you want to switch the source.

To change the group
Press one of the [1-16], [17-32], [33-48], and [49-64] buttons.

3 Press one of the Source Select buttons, to select the source you want to 
switch.

To change the group
Press one of the [1-24], [25-48], ... [97-120], and [121-128] buttons.
Router Control Menu Operations
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Video Process

The term “video process” is applied to adjustments to the luminance and hue 
of the input video signal.
There are two types of adjustment, depending on the application:
• Adjustment of an individual primary input signal
• Image effects on a particular bus

Note

These types of adjustment may be carried out independently. However, since 
they are implemented by the same hardware, if the same signal is subjected to 
processing twice, there may be limitations on the range of effects obtained in 
the final result.

Video Process Adjustments of a Primary Input Signal

For each of primary inputs 1 to 80, you can switch video process adjustments 
on or off, and can adjust the parameters (Video Gain, Y Gain, C Gain, Hue 
Delay, and Black Level) in the Setup menu. The adjustments do not, however, 
apply to the output video on the MON (monitor) bus.

For details of the settings, see “Signal Input Settings” in Chapter 20 (Volume 
3).

Video Process Adjustments on a Particular Bus

Buses to which the adjustments apply
For each of the following buses, you can switch video process adjustments on 
or off, and adjust the parameters.
• Following buses in the M/E-1and PGM/PST banks

– Key fill buses for keys 1 to 4
– Background A and background B buses
– Utility 1 and utility 2 buses

• Frame memory source 1 and frame memory source 2 buses
• Aux 1 to 48 buses
These settings also apply to keyframes and snapshots.
323Video Process
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Making the adjustments
Adjust VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, and HUE DELAY 
in the following menus.

Video Process Memory

When using video process adjustments for an image effect on a bus, this 
function saves the final values for each pair number for the signals. The video 
process on/off setting is not saved.
When you change the adjustments the values are automatically saved, and 
these last values are recalled when the pair number is selected.
In other words, by switching video process memory on, regardless of the video 
process information for each bus, you can carry out video process adjustments 
for each input signal.
The parameters saved are as follows.

VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, HUE DELAY

Switch the video process memory on or off in the Setup menu.

For details of setting operations, see “Settings Relating to Keys, Wipes, Frame 
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 
(Volume 3).

Applicable bus Menu used for operation See page

M/E-1 bank Key fill buses for keys 
1 to 4

M/E-1 menu page 171

Background A and B 
buses

Video Process menu page 325

Utility 1 and 2 buses

PGM/PST bank Key fill buses for 
DSK1 to DSK4

PGM/PST menu page 171

Background A and B 
buses

Video Process menu page 325

Utility 1 and 2 buses

Frame memory source 1 and 2 buses Frame Memory menu page 270

Aux 1 to 48 buses AUX/MON menu page 319
Video Process
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Video Process Settings

This section describes operations on the M/E-1 and PGM/PST background A 
and B buses, and utility buses 1 and 2.
For these operations, use the Misc >Video Process menu in the respective 
operating bank.

For video process settings on other buses, see the following.

• Settings for a particular input signal: “Signal input settings” in Chapter 20 
(Volume 3)

• Key fill bus settings: “Video Processing” (page 171)
• Settings for frame memory source buses 1 and 2: “Setting video processing” 

(page 270)
• Settings for Aux 1 to 48 buses: “Making video process settings for an AUX 

bus” (page 319)
• Overview of video process: “Video Process” (page 323)

This section describes an example on the background A bus of the M/E-1 bank. 
For the background B bus or utility bus 1 or 2, make the adjustment with a 
similar procedure.

Making video process settings for each bus

1 In the menu control block, press the top menu selection button [M/E1] and 
select VF7 ‘Misc’ and HF2 ‘Video Process.’

2 In the <Bkgd-A> group, press [Video Process], turning it on.

3 Adjust the following parameters.

To return the parameter settings to the defaults, press [Unity] in the 
<Bkgd-A> group.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Luminance signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –7.31 to +109.59
325Video Process Settings



326

   C
hapter 8 

C
olor B

ackgrounds, C
opy and S

w
ap, and O

ther S
ettings
Video Process Settings
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Preparations

The color corrector enables video signal color correction (black balance/white 
balance adjustment, gamma correction, knee correction, etc.).

Note

To use the color corrector, the BZS-9420 Color Corrector Software is required. 
To use the software, you need to obtain a further installation key.

For details on obtaining an installation key, see “Making Settings Required to 
Use the Software” in Chapter 18 (Volume 3).

Assigning the color corrector input buses to AUX delegation 
buttons

There are two inputs for capturing material to the color corrector: the CCR1 
bus and the CCR2 bus.

For details of the input assignment operation, see “Auxiliary Bus Control 
Block Settings (Aux Assign Menu)” in Chapter 19 (Volume 3).

Selecting the color correction input signal
After assigning CCR1 and CCR2 to AUX buses, use the following procedure.

1 Press the AUX delegation buttons assigned to CCR1 (or CCR2).

2 In the cross-point button row, select the signal to which you want to apply 
color correction.

Note

The signals you can select on the CCR1 and CCR2 buses are limited to the 
primary inputs and frame memory outputs (FM1 to FM8). However you 
can make all the internal signals of the switcher selectable by a setting in 
the Setup menu. 

For details, see “Selecting the Bank to Make the Settings” in Chapter 20 
(Volume 3).

Selecting the color corrector output signal
By assigning the signal output from the color corrector to a cross-point button, 
you can make that signal available on that button.
Preparations
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For details of the assignment process, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 19 (Volume 3).

Accessing the CCR menu
For color correction operations, use the CCR menu.
To access the CCR menu, in the menu control block, press the top menu 
selection button [CCR].
The following description uses CCR1 as an example. To apply color correction 
to CCR2, replace VF1 ‘CCR1’ by VF2 ‘CCR2,’ and follow the same 
procedure.
329Preparations
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Overall Color Corrector Operations

Enabling Color Corrector

To enable the functions of color corrector 1, for example, use the following 
procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and any HF.

2 In the <CCR> group, press [CCR], turning it on.

This enables the functions of color corrector 1.

Returning all color corrector settings to their defaults

1 In the <CCR> group, press [Unity].

A confirmation message appears.

2 Press [Yes].

This returns all color corrector settings to their defaults, whether [CCR] is 
on or off.

Copy and Swap Operations

Copying color corrector data

1 In the CCR menu, press VF3 ‘Copy/Swap.’

The Copy/Swap menu appears.
The status area shows a copy source list on the left and a copy destination 
list on the right.

2 Using any of the following methods, select the copy source data and copy 
destination data.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.
Overall Color Corrector Operations
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3 Press [Copy].

This carries out the copy.

Swapping color corrector data
Refer to the procedure described in the previous item “Copying color corrector 
data.” In step 3, press [Swap] instead of [Copy].

To undo copy or swap 
In the Copy/Swap menu, press [Undo].
The state before carrying out the copy or swap is restored.

Knob Parameter Adjustment Setting values

1 Left No Select copy source data 1 or 2

2 Right No Select copy destination 
data

1 or 2
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Color Corrector Functions

This section describes the color corrector functions.
For each of the following operations, it is possible to copy or swap data 
between two color correctors (CCR1 and CCR2).

Input Video Processing Operations

Carry out the following corrections to a YUV signal before conversion to an 
RGB signal.
• Overall gain adjustment of the video signal
• Gain adjustment of the Y signal
• Gain adjustment of the C signal
• Hue delay
• Black level adjustment

To apply input video processing effects, use the following procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and HF1 ‘Input Process.’

The Input Process menu appears.

2 In the <Input Process> group, press [Input Process], turning it on.

3 Adjust the following parameters.

To return the parameters to their default settings
Press [Unity] in the <Input Process> group.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –116.90 to +116.90
Color Corrector Functions
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Primary Color Correction Operations

Carry out the following corrections to each of the R, G, and B signals.
Black balance adjustment: setting the output level for a 0% level input signal.
White balance adjustment: setting the output level for a 100% level input 

signal.
Gamma correction: adjusting the curvature of the gamma curve.
Knee correction: adjusting the position of the maximum point of the gamma 

curve.

It is also possible to mask part of the region to be corrected.

Applying primary color correction

1 In the CCR menu, press VF1 ‘CCR1’ and HF2 ‘Primary CCR.’

The Primary CCR menu appears.

2 In the <Primary CCR> group, press [Primary CCR], turning it on.

3 In the <Primary CCR Adjust> group, select the setting item.

Black: black balance adjustment
White: white balance adjustment
Gamma: gamma correction
Knee: knee correction

Output level

Black balance adjustment

White balance adjustment

Input level

Unadjusted signal

Input level

Output level

Knee correction

Gamma 
correction

Adjusted signal
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4 Depending on the selection in step 3, adjust the following parameters.

• When Black or Gamma is selected

• When White is selected

• When Knee is selected

To return the parameters to their default settings
In the <Primary CCR> group, press [Unity].

Masking a part of the primary color correction
Here the procedure for mask 1 operation is described by way of example. You 
can carry out mask 2 operation in a similar way.

1 In the <Primary Mask> group of the Primary CCR menu, press [Mask1], 
turning it on.

2 Press [Mask1 Adjust].

The Mask1 Adjust menu appears.

3 In the <Mask Source> group, select the mask source.

Box: signal from dedicated box generator
Pattern: signal from dedicated pattern generator

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment –100.00 to +100.00

2 Green Green signal adjustment –100.00 to +100.00

3 Blue Blue signal adjustment –100.00 to +100.00

4 All Simultaneous RGB adjustment Red value is shown

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment 0.00 to 200.00

2 Green Green signal adjustment 0.00 to 200.00

3 Blue Blue signal adjustment 0.00 to 200.00

4 All Simultaneous RGB adjustment Red value is shown

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment 20.00 to 75.00

2 Green Green signal gain 20.00 to 75.00

3 Blue Blue signal gain 20.00 to 75.00

4 All Simultaneous RGB adjustment Red value is shown
Color Corrector Functions
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4 Depending on the selection in step 3, adjust the following parameters.

• When Box is selected

• When Pattern is selected

For the pattern selection, you can also press [Mask Ptn Select] in the 
Mask1 Adjust menu, then use the Mask Ptn Select menu.
Press any of the displayed patterns (standard wipe patterns 1 to 24) to 
select it, then you can adjust the following parameters.

5 When selecting the pattern as a mask source, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See “Setting the wipe position (Positioner)” (page 204).

• When turning [Multi] on and replicating the same pattern

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00

5 Soft Degree of softness of box 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softness of pattern 
edge

0.00 to 100.00

5 Pattern Pattern number 1 to 24

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softness of pattern 
edge

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63
335Color Corrector Functions
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a) See “Setting the wipe pattern replication (Multi)” (page 209).

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See “Setting the wipe pattern aspect ratio (Aspect ratio)” (page 208).

• When turning the [Angle] on in the <Rotation> group and slanting 
the pattern

a) See “Angle” (page 206).

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a fixed rate

a) See “Speed” (page 206).

6 To invert the mask source, return to the Primary CCR menu and press 
[Mask Invert], turning it on.

Note

The mask function is common to the primary color correction, secondary color 
correction luminance processing, and spot color adjustment functions. For 
example, if in primary color correction you set mask 1 to a box, then in 
secondary color correction set mask 1 to a pattern, this also changes the setting 
in primary color correction to the pattern.

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Aspect aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)
Color Corrector Functions
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Secondary Color Correction Operations

For the six colors R (red), G (green), B (blue), Y (yellow), C (cyan), and M 
(magenta), adjust the luminance and saturation, and also the hue within a range 
of ±30 degrees of the center value for each color.
You can mask a part of the region to be corrected.

Note

When spot color adjustment is enabled in the setup settings, this function is 
disabled.

For details, see “Switching the Color Correction Function” in Chapter 18 
(Volume 3).

Applying secondary color correction

1 In the CCR menu, select VF1 ‘CCR1’ and HF3 ‘Secondary CCR.’

The Secondary CCR menu appears.

2 In the <Secondary CCR> group, press [Secondary CCR], turning it on.

3 In the <Secondary CCR Adjust> group, select the color for which you 
want to make the setting.

4 Adjust the following parameters.

To return the parameter settings to their default values
In the <Secondary CCR> group press [Unity].

Masking a part of the secondary color correction
In the <Secondary Mask> group, press [Mask1] or [Mask2], turning it on, then 
carry out the same operation as described under “Masking a part of the primary 
color correction” (page 334).

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 Saturation Saturation 0.00 to 200.00

3 Hue Delay Hue delay –180.00 to +180.00
337Color Corrector Functions
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RGB Clip Operations

For each of the R, G, and B signals, you can make dark clip and white clip 
adjustments.

Making RGB clip adjustments

1 In the CCR menu, press VF1 ‘CCR1’ and HF4 ‘RGB Clip.’

The RGB Clip menu appears.

2 In the <RGB Clip> group, press [RGB Clip], turning it on.

3 In the <RGB Clip Adjust> group, select the item you want to adjust.

Dark: dark clip adjustment
White: white clip adjustment

4 Adjust the following parameters.

a) When Dark is selected
b) When White is selected

To return the parameters to their default settings
In the <RGB Clip> group, press [Unity].

Luminance Processing Operations

After converting a signal to which RGB color correction has been applied to a 
YUV signal, divide the luminance levels into three regions, referred to as Dark, 
Middle, and Bright, and apply video signal adjustments to these regions.

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment –50.00 to +149.99 a)

–49.99 to +150.00 b)

2 Green Green signal adjustment –50.00 to +149.99 a)

–49.99 to +150.00 b)

3 Blue Blue signal adjustment –50.00 to +149.99 a)

–49.99 to +150.00 b)

4 All Simultaneous RGB adjustment Red value is shown
Color Corrector Functions
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There are three modes for luminance processing, as follows.
Tint mode: adding a specified color to the original video signal.
Color Modify mode: adjusting the original video signal.
Y Modify mode: adjusting the output levels of the input luminance signal.

• White balance adjustment: setting the output level for an input 
luminance signal at the 100% level.

• Black balance adjustment: setting the output level for an input 
luminance signal at the 0% level.

• Y lift correction: adjusting the curvature of the curve.
• Y dark correction: adjusting the position of the maximum point of the 

curve.

It is also possible to mask part of the region to be corrected.

Applying luminance processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF5 ‘Luminance Process.’

Under Dark point Middle/Dark point Bright/Middle point Over Bright point

Dark Middle Bright

Input signal 
luminance level

Output signal 
luminance level

Black balance adjustment

White balance adjustment

Input signal 
luminance 
level

Unadjusted signal

Input signal 
luminance 
level

Output signal luminance level

Y Dark

Adjusted signal

Y Lift
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The Luminance Process menu appears.

2 In the <Luminance Process> group, press [Luminance Process], turning it 
on.

3 In the <Mode> group, specify the adjustment mode.

Tint: add a specified color to the original video signal.
Color Modify: adjust the original video signal.
Y Modify: adjust the output levels of the input luminance signal.

When tint mode or color modify mode is selected, skip to step 4.
When Y modify mode is selected, adjust the following parameters.

4 In the <Bound> group, make the settings for the three regions (Dark, 
Middle, and Bright).

• [Level] parameters: set the boundaries of the three regions.

• [Soft] parameters: set the degree of boundary softness of the three 
regions.

Knob Parameter Adjustment Setting values

1 White White balance adjustment 0.00 to 200.00

2 Black Black balance adjustment –100.00 to +100.00

3 Y Lift Curvature of curve –100.00 to +100.00

4 Y Dark Position of maximum point of 
curve

–7.31 to +109.59

Knob Parameter Adjustment Setting values

1 Over B Level Luminance level of the Over 
Bright point

50.00 to 150.00

2 Mid B Level Luminance level of the Bright/
Middle point

10.00 to 120.00

3 Dark Mid 
Level

Luminance level of the Middle/
Dark point

–20.00 to +90.00

4 Under D 
Level

Luminance level of the Under 
Dark point

–50.00 to +50.00

Knob Parameter Adjustment Setting values

1 Over B Soft Degree of softness at Over Bright 
point

15.00 to 70.00

2 Mid B Soft Degree of softness at Bright/
Middle point

15.00 to 42.50

3 Dark Mid 
Soft

Degree of softness at Middle/Dark 
point

15.00 to 42.50
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5 In the <Luminance Process Adjust> group, press [Dark], [Mid], or 
[Bright], and adjust the following parameters for the three regions.

• In tint mode

• In color modify mode

To return the parameters to their default settings
In the <Luminance Process> group, press [Unity].

Masking a part of luminance processing
In the <Luminance Mask> group, press [Mask1] or [Mask2], turning it on, then 
carry out the same procedure as in “Masking a part of the primary color 
correction” (page 334).

Spot Color Adjustment

You can change the color of a specified color region to a different color, 
without affecting other regions. You can also mask part of such a region.
Then for the region other than the region whose color you have changed, you 
can make the following corrections.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

4 Under D Soft Degree of softness at Under Dark 
point

15.00 to 70.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 C Gain Chrominance signal gain 0.00 to 200.00

3 Hue Delay Hue delay –180.00 to +180.00
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Note

When secondary color correction is enabled in the setup settings, this function 
is disabled.

For details, see “Switching the Color Correction Function” in Chapter 18 
(Volume 3).

Adjusting the color of the specified region (key)

1 In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot CCR/Output.’

The Spot CCR/Output menu appears.

2 In the <Spot CCR> group, press [Spot CCR], turning it on.

3 In the <Auto> group, press [Sample Mark], turning it on.

Note

When [Sample Mark] is on, the effects of color adjustment outside the 
region of spot color adjustment (see page 343) and output video processing 
(see page 344) are temporarily disabled.
Turning [Sample Mark] off restores the former state.

4 Adjust the parameters so that the color you want to change is included 
within the sample mark.

5 In the <Auto> group, press [Auto Start], to adjust the key automatically.

Note

This automatic adjustment does not carry out key gain adjustment. If 
required, adjust the key gain as shown in step 6.

6 Press [Key Adjust], and adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00

2 Position V Vertical position –100.00 to +100.00

3 Size Size 1.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance –7.31 to +109.59

2 Saturation Saturation 0.00 to 100.00
Color Corrector Functions
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7 Press [Window], turning it on, to adjust the key detection range for spot 
color adjustment.

8 In the <Spot CCR> group, press [Spot CCR] to display the parameters, and 
adjust the replacement color.

.

To return the parameters to their default settings
In the <Spot CCR> group, press [Unity].

Masking a part of the spot color adjustment
In the <Spot CCR Mask> group, press [Mask1] or [Mask2], turning it on, then 
carry out the same procedure as in “Masking a part of the primary color 
correction” (page 334).

Adjusting the color outside the spot color adjustment region

1 In the Spot CCR/Output menu, press [Outer Out Proc] in the <Outer Out 
Proc> group, turning it on.

2 Adjust the following parameters.

3 Hue Hue 359.99 to 0.00

4 Gain Key gain –100.00 to +100.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00
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344
To return the parameters to their default settings
In the <Outer Out Proc> group, press [Unity].

Output Video Processing Operations

Carry out the following corrections are available on the YUV signal.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

Applying output video processing effects

1 In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot CCR/Output.’

The Spot CCR/Output menu appears.

2 In the <Output Process> group, press [Output Process], turning it on.

3 Adjust the following parameters.

To return the parameters to their default settings
In the <Output Process> group, press [Unity].

YUV Clip Operations

For each of the luminance and color difference signals, the following 
processing is available.

5 Black Level Black level –116.90 to +116.90

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –116.90 to +116.90
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White clip: setting the maximum level of the luminance signal.
Dark clip: setting the minimum level of the luminance signal.
Positive clip: setting the maximum amplitude in the positive direction of the 

color difference signal.
Negative clip: setting the maximum amplitude in the negative direction of the 

color difference signal.

Applying YUV clip processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF7 ‘YUV Clip.’

The YUV Clip menu appears.

2 In the <YUV Clip> group, press [YUV Clip], turning it on.

3 In the <YUV Clip Adjust> group, select the target for adjustment.

Luminance: settings for the luminance signal.
Chroma: settings for the color difference signal.

4 Depending on the selection in step 3, adjust the following parameters.

• When Luminance is selected

• When Chroma is selected

To return the parameters to their default settings
In the <YUV Clip> group, press [Unity].

Knob Parameter Adjustment Setting values

1 White Clip White clip adjustment –6.85 to +109.13

2 Dark Clip Dark clip adjustment –6.85 to +109.13

Knob Parameter Adjustment Setting values

1 U Posi Clip Positive clip adjustment for U 
signal

–113.39 to +113.39

2 U Nega Clip Negative clip adjustment for U 
signal

–113.39 to +113.39

3 V Posi Clip Positive clip adjustment for V 
signal

–113.39 to +113.39

4 V Nega Clip Negative clip adjustment for V 
signal

–113.39 to +113.39
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Simple P/P Software

Overview

By installing the BZS-9250 Simple P/P Software in the DVS-9000/9000SF 
Switcher Processor, you can use a separate program/preset function without 
using the M/E hardware.

Getting access to the software
To use the Simple P/P Software, you are required to enter an install key which 
validates the software. (If the software has been factory installed, the install key 
is not required.)
For the method of obtaining an install key, contact your Sony representative. 
On that occasion, you may be required to submit the unique device ID of the 
switcher you are using. You can check the unique device ID in the Install menu 
of the switcher. For details of operating procedures, see “Installation and 
Device Setup (Install/Unit Config Menu)” in Chapter 18 (Volume 3).

Restrictions on Use

Since this software is a simple version of the program/preset function, there are 
some restrictions on use. The following lists the points at which operation is 
different from a normal program/preset function. For details of the normal 
operations, set the relevant sections of this manual.

Restrictions on using a downstream key
• DSK3 and DSK4 cannot be used.

For the key priority, set priority 1 or priority 2.
• The following downstream key types cannot be used.

– Chroma key
– Color vector key
– Wipe pattern key
– Key wipe pattern key

• When using a matte as the key fill for a downstream key, a mix color cannot 
be used.

• It is not possible to modify a downstream key edge. The edge blink also 
cannot be used.

• For a downstream key, main mask and sub-mask cannot be used.
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• A processed key cannot be used. Therefore, it is not possible to apply a DME 

effect to a downstream key.
• As an independent key transition type, wipe and DME wipe cannot be used.

Restrictions on executing transitions in the transition control 
block

• DME wipes cannot be used. 
• Wipes can be used, but there are restrictions on use. For details, see the next 

item, “Restrictions when using wipes.”

Restrictions when using DME wipes
• The wipe patterns that can be used are standard wipes (pattern numbers 1 to 

24) only.
• A pattern mix cannot be used.
• A split (splitting the wipe pattern) cannot be used.
• When a border or soft border is selected for a wipe edge, the signal to be 

inserted in the edge (edge fill) is restricted as follows.
– The utility 2 bus cannot be selected.
– When using a matte, a mix color cannot be used.
– Even if the wipe border width is set to the same numeric value for M/E and 

Simple P/P, the same image is not obtained.
• The following wipe modifiers cannot be used:

– Replication “Shift” and Multi Adjust menu adjustments
– Pairing
– Modulation
– Spring
– Spiral

• Changing modifier parameter settings changes the wipe pattern size.

Restrictions on utility buses
The utility 1 and utility 2 buses cannot be used.

Assignment of signals to output connectors

Connectors to which the P/P row output signal assignment is fixed
The assignment of the following signals to output connectors OUT17 to OUT2
2 is fixed. 

Output 
connector

Fixed assigned outputs

Standard mode Multi-program mode DSK mode a)

OUT17 Program P/P OUT1 b) Program 1

OUT18 Program P/P OUT1 b) Program 2
349Simple P/P Software
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a) In DSK mode, the backgrounds that can be selected in the PGM Config menu are restricted to 
background 1 and background 2.

b) Depends on the setting in the Engineering Setup >Switcher >Config >M/E Output Assign menu. 
OUT5 and OUT6 cannot be used.

Connectors for which a P/P row output signal can be selected
For an edit preview bus or AUX bus assigned to output connector OUT23 or 
OUT24, you can select a P/P row output signal. 
If these buses are assigned to other than OUT23 or OUT24, then it is not 
possible to select a P/P row output signal. (Assigning these buses to the two 
connectors is recommended.)

Logical assignment of the physical PGM/PST
In the Engineering Setup >Switcher >Config >Logical M/E Assign menu, it is 
not possible to assign the physical PGM/PST as a logical PGM/PST.
In the <Logical M/E to Physical P/P> group, you can select from M/E-1, M/E-
2, and M/E-3.

Configuration of the switcher bank outputs
If Multi Program mode is selected in setup (M/E Config in the Switcher 
>Config menu), then for Bkgd in the PGM Config menu, it is only possible to 
select Clean.

OUT19 Preview P/P OUT2 b) Key preview 1

OUT20 Clean P/P OUT3 b) Key preview 2

OUT21 Key preview P/P OUT4 b) Clean 1

OUT22 Preset Preset Clean 2

Output connector Assignable bus

OUT23 Edit preview bus

OUT24 AUX bus

Output 
connector

Fixed assigned outputs

Standard mode Multi-program mode DSK mode a)
Simple P/P Software
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Wipe Pattern List

Standard Wipes

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

17 18 19 20

21 22 23 24
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Enhanced Wipes

26 27 29 49

300 301 302 303

304
Wipe Pattern List
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Rotary Wipes

100 101 102 103

104 105 106 107

150 151 156 158

160 162 516 518

604 606 624 661
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Mosaic Wipes

200 201 202 203

206 207 208 209

210 211 212 213

220 221 222 223

224 225 226 227

228 229 230 231

232 233 234 235
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236 237 238 239

240 241 242 243

244 245 246 247

250 251 252 253

254 255 256 257

260 261 262 263

264 265

268 269

266 267
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Random/Diamond Dust Wipes

270 271 272 273

274
Wipe Pattern List
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DME Wipe Pattern List

DME Wipe Patterns Available in One-Channel Mode

Slide

Split

1001 1002 1003 1004

1005 1006 1007 1008

1011 1012 1013
359DME Wipe Pattern List
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Squeeze

Door

1021 1022 1023 1024

1025 1026 1027 1028

1029 1030 1031

1041 1042 1043 1044

1045 1046 1047 1048
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2D trans

3D trans

1051 1052 1053 1054

1055 1056 1057 1058

1061 1062 1063 1064

1068

1071 1072 1074 1076

1077 1088 1091 1092

1093 1094
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362
Flip tumble

Frame in-out

1101 1102 1103 1104

1124 1131 1132 1133

1135

1109 1110 1121 1122

1201 1202 1203 1204

1221 1222 1223 1224

1205 1206 1207 1208
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Picture-in-picture

Page turn

1251

1301 1302 1303 1304

1318 1341 1342 1343

1313 1315 1316 1317

1344 1345

1309 1310 1311 1312

1305 1306 1307 1308
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364
Page roll

Mirror

1338 1346 1347 1348

1335 1336 1337

1349 1350

1321 1322 1323 1324

1329 1330 1331 1332

1333

1325 1326 1327 1328

1355 1356 1357 1358
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Sphere

Character trail

Wave

Ripple

1365

1371 1372

1378 1379

1381
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366
Split slide

Sparkle

Mosaic

Defocus

1384 1385 1386 1387

1388 1389

1391 1393 1394 1396

1398 1399

1701

1702
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User programmable DME
The illustrations for patterns 1901 to 1999 show an effect register number or 
register name.

DME Wipe Patterns Available in Two-Channel Mode

Slide

Squeeze

1901 1999

2601 2602 2603 2604

2605 2606 2607 2608

2621 2622 2623 2624

2625 2626 2627 2628
367DME Wipe Pattern List
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3D trans

Picture-in-picture

2631 2632 2633 2634

2642 2644

2651 2652
DME Wipe Pattern List
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Page turn

2713 2715 2716 2717

2718 2741 2742 2743

2744 2745

2705 2706 2707 2708

2709 2710 2711 2712

2701 2702 2703 2704
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370
Page roll

2733 2735 2736 2737

2738 2746 2747 2748

2749 2750

2725 2726 2727 2728

2729 2730 2731 2732

2721 2722 2723 2724
DME Wipe Pattern List
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Brick

Frame in-out

User programmable DME
The illustrations for patterns 2901 to 2999 show an effect register number or 
register name.

2801 2802 2803 2804

2811 2812 2813 2814

2851 2852 2853 2854

2861 2862 2863 2864

2901 2999
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DME Wipe Patterns Available in Three-Channel Mode

Brick

User programmable DME
The illustrations for patterns 3901 to 3999 show an effect register number or 
register name.

3601

3901 3999
DME Wipe Pattern List
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Menu Tree

Recalling Menus

This section details the menu structure, and shows the top menu selection 
buttons in the menu control block which are used to access the menus.

Menu control block

Some menus can also be accessed by pressing other buttons twice in rapid 
succession.

For more details, see “Menu Organization” (page 68).

Note

Some menus may not appear, depending on the model.

M/E-1 to M/E-3 Menus

The functions in the M/E-1, M/E-2, and M/E-3 menus are the same, but the 
menu page numbers are distinguished as follows.

M/E-1 menus: 11xx, M/E-2 menus: 12xx, M/E-3 menus: 13xx

EXT
DISPL

M/E
1

M/E
2

M/E
3

P/P

MENU
COPY

FRAME
MEM

COLOR
BKGD

AUX
/MON

COPY
SWAP

MISC

DME GLB
EFF

RTR DEV

KEY
FRAME

SNAP
SHOT

SHOT
BOX

MCRO

FILE USER
SETUP

ENG
SETUP

DIAG

PREFS
1

PREFS
2

PREFS
3

PREFS
4

PREFS
5

PREFS
6

PREFS
7

PREFS
8

Top menu selection buttons
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374
In this section, the numbers for the M/E-1 menus are given as examples.

M/E
1

M/E
2

M/E
3

M/E-1

HF1: Type (1111)

HF2: Edge (1112)

HF3: Main Mask (1113)

HF4: Sub Mask (1114)

HF5: Processed Key (1115)

HF6: Transition (1116)

HF7: Video Process (1117)

Chroma Adjust (1111.1)

Matte Adjust (1111.2)

Key Priority (1173)

Matte Adjust (1112.1)

Zabton Adjust (1112.3)

Mask Ptn Select (1113.1)

Main Pattern(1151)

Monitor (1115.1)

Border/Crop (1115.2)

Wipe Adjust (1116.1)

DME Wipe Adjust (1116.3)

Mix Ptn Select (1112.2)

Pattern Select (1116.2)

Matte Adjust (1112.1)

Wipe Adjust (1116.1)

Mix Ptn Select (1112.2)

Pattern Select (1116.2)

Mix Ptn Select (1112.2)

Main Mask(1113)

Matte Adjust (1112.1)

Wipe Adjust (1116.1)

Pattern Select (1116.2)

1ch Pattern Select 
(1116.4)

2ch Pattern Select 
(1116.5)
Remove From Begin 
(1116.7)

VF1: Key1

VF2: Key2

VF3: Key3

VF4: Key4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

[M/E 1], [M/E 2], and [M/E 3] buttons

The functions in the Key 2 to Key 4 menus are the same 
as those in the Key 1 menu, with the following menu page 
numbers.
Key 2 menu: 112x, Key 3 menu: 113x, Key 4 menu: 114x

to next page
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VF1: Key1

VF2: Key2

VF3: Key3

VF4: Key4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

HF1: Main Pattern (1151)

HF2: Pattern Mix (1152)

HF3: Sub Pattern (1153)

HF4: Edge/Direction (1154)

HF5: Main Modify (1155)

HF6: Sub Modify (1156)

HF7: Wipe Snapshot (1157)

Matte Adjust (1154.1)

Multi Adjust (1155.1)

Multi Adjust (1156.1)

Mix Pattern Select (1154.2)

HF1: 1ch (1161)

HF2: 2ch (1162)

HF3: 3ch (1163)

HF4: Edge/Direction (1164)

HF5: Modify (1165)

HF7: DME Wipe Snapshot (1167)

Remove From Begin (1165.1)

Clip (1176.1)

Transition (1171)

Snapshot (1177)

HF1: Transition (1171)

HF2: Video Process (1172)

HF3: Key Priority (1173)

HF4: Next Key Priority (1174)

HF5: Key Assign (1175)

HF6: Clip Transition (1176)

HF7: Snapshot (1177)

M/E
1

M/E
2

M/E
3

M/E-1

[M/E 1], [M/E 2], and [M/E 3] buttons

to previous page
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PGM/PST Menu

HF1: Type (1411)

HF2: Edge (1412)

HF3: Main Mask (1413)

HF4: Sub Mask (1414)

HF5: Processed Key (1415)

HF6: Transition (1416)

HF7: Video Process (1417)

Chroma Adjust (1411.1)

Matte Adjust (1411.2)

Key Priority (1473)

Matte Adjust (1412.1)

Zabton Adjust (1412.3)

 

Mask Ptn Select (1413.1)

Main Pattern(1451)

Monitor (1415.1)

Border/Crop (1415.2)

Wipe Adjust (1416.1)

DME Wipe Adjust (1416.3)

Pattern Select (1416.2)

Mix Ptn Select (1412.2)

Matte Adjust (1412.1)

Wipe Adjust (1416.1)

Mix Ptn Select (1412.2)

Pattern Select (1416.2)

Mix Ptn Select (1412.2)

Main Mask(1413)

Matte Adjust (1412.1)

Wipe Adjust (1416.1)

Pattern Select (1416.2)

1ch Pattern Select 
(1416.4)

2ch Pattern Select 
(1416.5)

Remove From Begin 
(1416.7)

PGM/PST

P/P

VF1: DSK1

VF2: DSK2

VF3: DSK3

VF4: DSK4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

[P/P] button

The functions in the DSK 2 to DSK 4 menus are the same as those in the DSK 
1 menu, with the following menu page numbers.
DSK 2 menu: 142x, DSK 3 menu: 143x, DSK 4 menu: 144x

to next page
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HF1: Main Pattern (1451)

HF2: Pattern Mix (1452)

HF3: Sub Pattern (1453)

HF4: Edge/Direction (1454)

HF5: Main Modify (1455)

HF6: Sub Modify (1456)

HF7: Wipe Snapshot (1457)

HF1: 1ch (1461)

HF2: 2ch (1462)

HF3: 3ch (1463)

HF4: Edge/Direction (1464)

HF5: Modify (1465)

HF7: DME Wipe Snapshot (1467)

HF1: Transition (1471)

HF2: Video Process (1472)

HF3: Key Priority (1473)

HF4: Next Key Priority (1474)

HF5: Key Assign (1475)

HF6: Clip Transition (1476)

HF7: Snapshot (1477)

Matte Adjust (1454.1)

Multi Adjust (1455.1)

Multi Adjust (1456.1)

Remove From Begin (1465.1)

Clip (1476.1)

Transition (1471)

Snapshot (1477)

Mix Pattern Select (1454.2)

PGM/PST

VF1: DSK1

VF2: DSK2

VF3: DSK3

VF4: DSK4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

P/P [P/P] button

to previous page
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Frame Memory Menu

Frame Memory

FRAME
MEM

VF1: Still

VF2: Clip

VF3: Reposition/Lock

VF4: File

VF5: Folder (2551)

VF6: External HDD

HF1: Recall (2511)

HF2: Freeze/Store (2512)

HF3: Composite (2513)

HF4: Animation Record (2514)

HF5: Create Key Frame (2515)

HF7: Field Invert (2517)

HF1: Recall (2521)

HF2: Play (2522)

HF3: Record (2523)

HF4: Ancillary Enable (2525)

HF1: Reposition (2531)

HF2: Lock (2532)

HF1: Pair Recombination (2541)

HF4: Move (2544)

HF5: Delete (2545)

HF6: Rename (2546)

HF7: Backup/Restore (2547)

HF1: Format (2561)

HF2: Backup/Restore (2562)

Input Adjust (2513.1)

Pattern Adjust (2513.2)

Pattern Select (2513.3)

[FRAME MEM] button
Menu Tree
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Color Bkgd Menu

AUX/MON Menu

Color Bkgd

VF1: Color Bkgd1 (2210)

VF2: Color Bkgd2 (2220)

Mix Pattern Select (2210.1)

Mix Pattern Select (2220.1)

COLOR
BKGD

[COLOR BKGD] button

AUX
MON

Aux/Mon

VF1: Aux Bus (2311)

[AUX MON] button
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380
CCR Menu

HF1: Input Process (2411)

HF2: Primary CCR (2412)

HF3: Secondary CCR (2413)

HF4: RGB Clip(2414)

HF5: Luminance Process (2415)

HF6: Spot CCR/Output (2416)

HF7: YUV Clip (2417)

HF1: Input Process (2421)

HF2: Primary CCR (2422)

HF3: Secondary CCR (2423)

HF4: RGB Clip(2424)

HF5: Luminance Process (2425)

HF6: Spot CCR/Output (2426)

HF7: YUV Clip (2427)

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

 

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

 

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

VF1: CCR1

VF2: CCR2

VF3: Copy/Swap 
        (2431)

CCR

CCR

[CCR] button
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Copy/Swap Menu

Misc Menu

Status Menu

HF1: M/E (3111)

HF2: Key (3112)

HF3: Wipe (3113)

HF4: DME Wipe (3114)

HF5: Matte (3115)

HF6: Color (3116)

HF7: DME (3117)

VF1: Copy/Swap

COPY
SWAP

Copy/Swap

[COPY SWAP] button

VF1: Enable

VF2: Safe Title (3221)

VF3: Transition (3231)

MISC

Misc

HF1: Port Enable (3211)

HF2: Plug-In Editor (3212)

HF3: Side Flags (3213) Side Flags (7331.7)

Side Flags Button Assign (7322.10)

[MISC] button

VF1: DME Status (3311)

STATS

Status

[STATS] button
381Menu Tree



  A
ppendix (V

olum
e 1)

382
DME Menu

DME

VF1: Edge

VF2: Video Modify

VF3: Freeze

VF4: Non-Linear

VF5: Light/Trail

VF6: Input/Output

VF7: Enhanced
         Video Modify

HF1: Defocus/Blur (4121)

HF2: Multi Move (4122)

HF3: Color Modify (4123)

HF4: Mosaic (4124)

HF7: Mask (4127)

HF1: Border/Crop (4111)

HF2: Beveled Edge (4112)

HF3: Key Border (4113)

HF4: Art Edge (4114)

HF5: Flex Shadow (4115)

HF6: Wipe Crop (4116)

HF7: Color Mix (4117)

Pattern Select (4116.1)

Mix Pattern Select (4117.1)

HF1: Freeze (4131)

HF1: Lighting (4151)

HF2: Trail (4152)

HF3: Motion Decay (4153)

HF4: KF Strobe (4154)

HF5: Wind (4155)

HF6: Spot Lighting (4156)

HF1: Bkgd (4161) 

HF2: Video/Key (4162) 

HF3: Process (4163) 

HF4: Graphic (4164)

HF1: Sketch (4171) 

HF2: Metal (4172) 

HF3: Dim & Fade (4173) 

HF4: Glow (4174) 

Mask(4127) 

Mask(4127) 

  

Mask(4127)

HF1: Type (4141)

DME

Wave (4141.1)

Mosaic Glass (4141.2)

Flag (4141.3)

Twist (4141.4)

Ripple (4141.5)

Rings (4141.7)

Broken Glass (4141.8)

Flying Bars (4141.9)

Blind (4141.10)

Split (4141.11)

Split Slide (4141.12)

Mirror (4141.13)

Multi Mirror (4141.14)

Texture Ptn Select (4156.1)

Copy/Swap (4156.2)

Light1 (4156.3)

Light2 (4156.5)

Light3 (4156.7)

Color Mix (4117) Mix Pattern Select (4117.1)

Light Color Adjust (4156.4)

Light Color Adjust (4156.6)

Light Color Adjust (4156.8)

Kaleidoscope (4141.15)

Lens (4141.16)

Circle (4141.17)

Panorama (4141.18)

Page Turn (4141.19)

Roll (4141.20)

Cylinder (4141.21)

Sphere (4141.22)

Explosion (4141.25)

Swirl (4141.26)

Melt (4141.27)

Character Trail (4141.28)

Mask (4127)

Mask (4127)

Mask (4127)

[DME] button
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Global Effect Menu

Device Menu

Global Effect

VF1: Ch1-Ch4a)

VF2: Ch5-Ch8

HF1: Combiner Priority (4211)

HF2: Brick (4212)

HF3: Shadow (4213)

HF7: Combine Gp Select (4217)

HF1: Combiner Priority (4221)

HF2: Brick (4222)

HF3: Shadow (4223)

HF7: Combine Gp Select (4227)

GLB
EFF

[GLB EFF] button

a) When using the MKS-6470 DME 
Board Set, the button is indicated 
as “VF1: Ch1-Ch2”.

VF1: GPI Timeline

VF2: P-Bus Timeline

VF3: DDR/VTR

HF1: GPI Timeline (5311)

HF1: P-Bus Timeline (5321)

HF1: Cueup & Play (5331)

HF2: Timeline (5332)

HF3: File List (5333)

Device

DEV

Rewind Action (5311.1)

Rewind Action (5321.1)

Rewind Action (5332.1) 

[DEV] button
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384
Macro Menu

MCRO

Macro

VF1: Register

VF2: Attachment (5421)

VF3: Menu Macro Register

VF4: Timeline

HF2: Lock (5412)

HF3: Copy (5413)

HF6: Delete (5416)

HF7: Rename (5417)

HF1: Recall & Run (5431)

HF2: Lock (5432)

HF3: Copy (5433)

HF6: Delete (5436)

HF7: Rename (5437)

HF1: Timeline (5441)

On Line Edit (7142.2)

Off Line Edit (7143.2)

Menu Macro Edit (7144.2)

Rewind Action (5441.1)

[MCRO] button
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Key Frame Menu

Key Frame HF1: Time Line (6111) 

HF3: Path (6113)

HF4: DME User PGM (6114)

HF5: Timeline Assign (6115)

HF7: Region Select (6117)

KEY
FRAME M/E-1 (6113.1)

M/E-2 (6113.2)

M/E-3 (6113.3)

P/P (6113.4)

User1 (6113.5)

User2 (6113.6)

User3 (6113.7)

User4 (6113.8)

User5 (6113.9)

User6 (6113.10)

User7 (6113.11)

User8 (6113.12)

DME 3D Trans Local (6113.13)

DME 3D Trans Global (6113.14)

DME Effect (6113.15)

DME Global Effect (6113.16)

10 Key Region Assign (7321.7)

[KEY FRAME] button
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386
Effect Menu

HF1: Attribute (6221)

HF2: Lock (6222)

HF3: Copy/Merge (6223)

HF4: Move (6224)

HF5: Swap (6225)

HF6: Delete (6226)

HF7: Rename (6227)

HF1: Attribute (6231)

HF2: Lock (6232)

HF3: Copy/Merge (6233)

HF4: Move (6234)

HF5: Swap (6235)

HF6: Delete (6236)

HF7: Rename (6237)

HF1: Attribute (6241)

HF2: Lock (6242)

HF3: Copy/Merge (6243)

HF4: Move (6244)

HF5: Swap (6245)

HF6: Delete (6246)

HF7: Rename (6247)

HF1: Attribute (6251)

HF2: Lock (6252)

HF3: Copy/Merge (6253)

HF4: Move (6254)

HF5: Swap (6255)

HF6: Delete (6256)

HF7: Rename (6257)

EFF
HF1: Store (6211)

HF2: Lock (6212)

HF3: Copy (6213)

HF4: Move (6214)

HF5: Swap (6215)

HF6: Delete (6216)

HF7: Rename (6217)

Edit (6211.1)

VF1: Master Timeline

VF2: Effect 1-99

VF3: Effect 101-199

VF4: Effect 201-299

VF5: Effect 301-399

Status (6200)

Effect

[EFF] button
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Snapshot Menu

Status (6300)

Xpt Hold (6321.1)

Clip Event (6321.2)

HF1: Attribute (6321) 

HF2: Lock (6322) 

HF3: Copy (6323) 

HF4: Move (6324) 

HF5: Swap (6325) 

HF6: Delete (6326) 

HF7: Rename (6327) 

Snapshot

VF1: Master Snapshot

VF2: Snapshot 

VF3: Wipe Snapshot

VF4: DME Snapshot  

VF5: Key Snapshot

SNAP
SHOT Edit (6311.1)

HF2: Lock (6332) 

HF3: Copy (6333) 

HF4: Move (6334) 

HF5: Swap (6335) 

HF6: Delete (6336) 

HF7: Rename (6337) 

HF1: Store (6311) 

HF2: Lock (6312)

HF3: Copy (6313)

HF4: Move (6314)

HF5: Swap (6315)

HF6: Delete (6316)

HF7: Rename (6317)

HF2: Lock (6342) 

HF3: Copy (6343) 

HF4: Move (6344) 

HF5: Swap (6345) 

HF6: Delete (6346) 

HF7: Rename (6347) 

HF1: Attribute (6351) 

HF2: Lock (6352) 

HF3: Copy (6353) 

HF4: Move (6354) 

HF5: Swap (6355) 

HF6: Delete (6356) 

HF7: Rename (6357) 

[SNAPSHOT] button
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388
Shotbox Menu

Shotbox

VF1: Register

VF2: Module Like Control

HF1: Store/Recall (6411) 

HF2: Lock (6412) 

HF3: Copy (6413) 

HF4: Move (6414) 

HF5: Swap (6415) 

HF6: Delete (6416) 

HF7: Rename (6417)

HF2: Bank1-4 

SHOT
BOX

Edit (6411.1)

[SHOTBOX] button
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File Menu

HF1: Setup (7111)

HF2: Initial Status (7112)

HF3: Key Memory (7113)

HF4: Video Proc Memory (7114)

HF1: Effect 1-99 (7121)

HF2: Effect 101-199 (7122)

HF3: Effect 201-299 (7123)

HF4: Effect 301-399 (7124)

HF1: Snapshot (7131)

HF2: Wipe Snapshot (7132)

HF3: DME Snapshot (7133)

HF4: Key Snapshot (7134)

HF1: Shotbox (7141)

HF2: Macro (7142)

HF3: Macro Attachment (7143)

HF4: Menu Macro (7144)

HF1: Frame Memory (7151)

HF2: Frame Memory Folder (7152)

HF1: All (7161)

HF2: Import / Export (7162)

HF1: Directory (7171)

HF2: Unit ID Copy (7172)

HF3: Group ID Copy (7173)

File

VF1: Setup, Init, VK Mem

VF2: Effect

VF3: Snapshot

VF4: Shotbox, Macro

VF5: Frame Mem

VF6: All, External File

VF7: Configure

FILE

File Edit (7111.1)

File Edit (7112.1)

File Edit (7113.1)

File Edit (7114.1)

File Edit (7121.1)

File Edit (7122.1)

File Edit (7123.1)

File Edit (7124.1)

File Edit (7131.1)

File Edit (7132.1)

File Edit (7133.1)

File Edit (7134.1)

File Edit (7141.1)

File Edit (7142.1)

File Edit (7143.1)

File Edit (7144.1)

 

File Edit (7151.1)

On Line Edit (7142.2)

Off Line Edit (7142.3)

Menu Macro Edit (7144.2)

[FILE] button
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Engineering Setup Menu

HF1: Network Config (7311) 

HF2: System Config (7312)

HF3: Format (7313)

HF4: Start Up (7314) 

HF5: Initialize (7315)

HF6: Install/Unit Config (7316)

HF7: Maintenance (7317)

Panel Assign (7312.1)

Switcher Assign (7312.2)

Aspect (7313.1)

Detail Information (7316.1)

License (7316.6)

Unit Config (7316.8)

Texture Package (7316.9)

Install (7316.10)

Setup Operation Lock (7317.1)

Switcher Aspect (7313.2)

DME Aspect (7313.3)

License Management (7316.7)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

ENG
SETUP

[ENG SETUP] button

to following pages
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Table Assign (7323.3)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

HF1: Config (7321)

HF2: Xpt Assign (7322)

HF3: Aux Assign (7323)

HF4: Prefs/Utility (7324)

HF5: Device Interface (7325)

HF6: Operation (7326)

HF7: Maintenance (7327)

ENG
SETUP

Link Table Adjust (7321.5)

Link Matrix Adjust (7321.4)

Link Bus Adjust (7321.6)
DSK Fader Assign (7321.1)

10 Key Region Assign (7321.7)

Link/Program Button (7321.8)

MP2 Main/Sub Assign (7321.11)

Compact Key Module Assign (7321.15)

Table Button Assign (7322.1)

Main,V/K Pair Assign (7322.5)

Src Name/LCD Color (7322.6)

Table Copy (7322.8)

Name Export (7322.9)

Side Flags Button Assign (7322.10)

Mixer Xpt Assign (7322.11)

RTR Mode Setting (7323.1)

Utility Module Assign (7324.1)

Key 2/4 Bus Button Assign (7324.2)

GPI Input (7325.1)

GPI Output (7325.3)

DCU Serial Port Assign (7325.4)

Effect Mode (7326.2)

Flexi Pad Mode (7326.3)

Custom Button (7326.4)

Sensitivity (7326.5)

Macro (7326.6)

Button Tally (7326.9)

Key Trans Link (7321.2)

External Bus Link (7321.3)

Transition Module (7321.9)

Flexi Pad Module (7321.10)

Xpt Module (7321.12)

Fade To Black Module (7321.13)

DSK/FTB Module (7321.14)

Device Control Module (7321.16)

Joystick/Trackball Module (7321.17)

Menu Panel (7321.19)

Main, V/K Pair Assign (7322.5)

Src Name/LCD Color (7322.6)

Main,V/K Pair Assign (7322.5)

Source Table Assign (7323.2)

Level Button Assigh (7323.4)

H/L Set (7325.2)

CCP-9000 Button (7326.8)

to following 
pages

to previous pages
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392
HF1: Config (7331) 

HF2: Input (7332)

HF3: Output (7333)

HF4: Transition (7334)

HF5: Key/Wipe/FM/CCR (7335)

HF6: Link (7336) 

HF7: Device Interface (7337)

M/E Output Assign (7331.1)

PGM Config (7331.2)

K-PVW Config (7331.3)

User 1-8 Config (7331.4)

Logical M/E Assign (7331.5)

DME Config (7331.6)

Side Flags (7331.7)

Switching Timing (7331.8)

Video Process (7332.1)

Output Assign (7333.1)

Video Clip (7333.2)

V Blank/Through (7333.3)

Safe Titile (7333.4)

4:3 Crop (7333.5)

Preset Color Mix (7334.1)

Transition Curve (7334.2)

Show Key (7335.1)

Key Auto Drop (7335.2)

Internal Bus Link (7336.1)

GPI Link (7336.4)

M/E Link (7336.6)

Key Transition Link (7336.7)

Remote Assign (7337.1)

GPI Input (7337.2)

GPI Output (7337.4)

Aux Control (7337.5)

DME Type Setting (7337.6)

Side Flags (3213)

Side Flags Button Assign (7322.10)

Link Bus Select (7336.2)

Link Table Select (7336.3)

GPI Link Adjust (7336.5)

H/L Set (7337.3)

DME SDI I/F (7337.7)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

ENG
SETUP

to previous pages

[ENG SETUP] button

to next page
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HF1: Input (7341)

HF3: Output (7343)

HF4: Device Interface (7344)

HF1: Input Config (7351)

HF2: GPI Input Assign (7352)

HF3: Output Config (7353)

HF4: GPI Output Assign (7354)

HF5: Serial Port Assign (7355)

HF1: Router (7361) 

HF2: Group Tally (7362) 

HF3: Wiring (7363)

HF4: Tally Enable (7364)

HF5: Tally Copy (7365)

HF6: Parallel Tally (7366)

HF7: Serial Tally (7367)

 TBC Center (7341.1)

Monitor Output (7343.1)

DME1 GPI Input (7344.1) 

DME1 GPI Output (7344.3)

DME2 GPI Input (7344.4)

DME2 GPI Output (7344.6)

H/L Set (7352.1)

 

P-Bus Setting (7355.1)

VTR Setting (7355.2)

DDR SD9P Setting (7355.3)

DDR VDCP Setting (7355.4)

Extended VTR Setting (7355.5)

External Box Assign (7361.1)

New (7363.1)

Modify (7363.2)

New (7364.1)

Modify (7364.2)

New (7365.1)

Modify (7365.2)

Set (7366.1)

Source Assign (7367.1)

H/L Set (7344.2)

H/L Set (7344.5)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

ENG
SETUP

to previous pages

[ENG SETUP] button
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394
Diagnostic Menu

Diagnostic

VF1: Error Info

VF3: System Info

HF1: Error Status (7411)

HF2: Error Log (7412)

LAN Status (7431)

DIAG [DIAG] button
Menu Tree



  Index
Index

A
Additive mix   148
Angle   206
Aspect ratio   208, 219
Audio mixer   99
Auto

chroma key adjustments   
151

transition   124
AUTO DELEG button   58
AUTO TRANS button   41
Auto/manual transition 

combination   125
AUX

bus settings   319
delegation buttons   50
menu operations   319

AUX/MON menu   379
Auxiliary bus control block   

50

B
Background

A/B row   37
changing   18
mask   143

Bank selection buttons   50, 65
Basic menu operations   68
Blink

function   171
Border   140

parameters   179
BS button   84
Bus fixed mode

fader operation   126
wipe direction   129

Bus selection   95
Button

numbers   97

C
Caps Lock button   84
CCR menu   380
Chroma key   139

adjustments   149
composition   148
shadow   151
shadow adjustment   154
window   150

Clean mode   138
Clear button   83, 85
Clip function   284
Clip transition   103

operations   295
Close button   83, 84
Color

combination   304, 305
matte settings   114
vector key   138

Color background
selection   304
setting operations   304
settings menu   304

Color Bkgd menu   379
Color cancel   150

adjustments   152
Color corrector   327
Color data

copy   310
swap   310

Color mix   304, 305
for edge fill matte   202
for key fill   157

Color palette window   87
Control panel   34

configuration   34
Copy   308, 312
Copy/Swap menu   381
Cross-point

button numbers   38
buttons   37
control block   37

Cut   103
CUT button   41

D
Dead zone   255
Default recall button   76
Del button   85
Delegation buttons   55
Device

menu   383
DEVICE connectors   52
Device control block

joystick   43
search dial   62
trackball   59

Diagnostic menu   394
Digital multi effects   26
Direction   199, 217, 238
Display   49, 57
DME   26, 40

applying to a key   168, 
184

channel selection buttons   
57

menu   382
DME channel

copy   311
swap   311

DME monitor   57
DME override   315
DME patterns

user programmable   251
DME wipe pattern   224

edge modification   239
groups   224
selection   235

DME wipe pattern list
for one-channel mode   359
for two-channel mode   

367
DME wipe settings   235
395Index



396

   Index
for independent key 
transitions   246

DME wipes   23, 223
copy   309, 310
direction   238
modifiers   238
modify clear   245
position   240, 247
snapshot   250
swap   309, 310

Door   360
Downstream key control block   

66
Drop border   141

parameters   180
Duration

setting buttons   47
Dust mix   195, 198

E
Edge

fill   142
modifiers   140

EDIT ENBL button   45
Edit point specification 

buttons   45
Editing buttons   46
EFF LOOP button   47
Effect

menu   386
Effect execution direction 

selection buttons   47
Emboss   141
Engineering Setup menu   390
Enhanced wipes   354
Enter button   83, 85
External

key   273
processed key   58, 170, 

185
External devices   27

F
Fader lever   40, 67
File menu   389
Files   30

backups   301
deleting   300
renaming   301
restoring   302

Flip tumble   362
Frame

in-out   362
Memory menu   378

Frame input mode   118
Frame memory

clip function   284
continuously capturing 

still images (record)   
279

feed   58, 170, 186
pair file processing   298
recalling a continuous 

sequence of still images 
(animation)   281

Frame memory operations   
261

capturing an input image   
267

clip   285
input image selection   265
menu display   262
preparations   261
selecting frame memory   

266
selecting outputs   266

Fringe   212
FULL LINK   196
Function

button area   75
selection buttons   49

G
Global

Effect menu   383

H
HF buttons   75

I
Image

data management   298

Image file
deletion   300
renaming   301

Independent key transition   
21, 131

DME wipe settings   246
type   135
type selection buttons   66
wipe modifiers   217
wipe settings   216

Independent key transition 
execution section   42, 67

Independent key transition rate   
135

setting by a menu 
operation   136

setting in the numeric 
keypad control block   
135

Input
string   84
value   83

Item display   83, 84

J
Joystick   44

K
Key   22

control block   55
default   144
delegation buttons   66
deleting   19
edge modifications   158, 

179
Frame menu   385
inserting   19
mask   142
memory   143
modifier buttons   56
modifiers   140
modify clear   170
output destination   170
output status display   111
row   37
signal adjustments   153
Index



  Index

status display   42

Key active   149
adjustment   152

KEY button   50
Key fill

selection   155
selection buttons   56

Key priority   107
display   111
selecting   107
setting by a menu 

operation   109
setting in the transition 

control block   107
Key row delegation buttons   

38
Key setting

using menus   145
with the cross-point 

control block   173
Key snapshot   187

buttons   67
recalling   188
saving   188
setting buttons   67

Key source
name display   67
selection   155
selection buttons   56

Key type
selection buttons   56
setting   146

Keyboard window   84
Keyer

copy   308
swap   308

Keyframe   27
control block   45
status   76

KF button   41
Knob   51, 57

parameter buttons   76

L
Left button   85
Line feed button   85
Linear key   138

Lock function   279
Luminance key   138

M
M/E

copy   308
swap   308

M/E-1 to M/E-3 menus   373
Macro   29

attachment   30
menu   384
timeline   29

Magnitude   207
Main mask   143

using   165, 183
Main menu site   88
Main/sub modifier link   196
Manual transition   125
Masks   142, 165, 183
Matte data

copy   310
swap   310

Max./min. value indication   83
Memory

card access indicator   52
card slot   52
recall buttons   65

Memory card/USB adaptor 
block   52

“Memory Stick”/USB 
connections block   53

“Memory Sticks”   53
Menu

accessing   69, 74
control block   51
display   51
operations   76
organization   68
page number button   75
screen   75
shortcut menu   88
shutting down   86
switching between the 

main menu sites   88
title button   75
top menu list   68

MENU button   44, 61

Menu tree   373
Minus button   83
Misc menu operations   314
MIX   40, 273
Mix   101, 193
MKS-8031   59
MKS-8032   66
MKS-8033   65
MKS-8035   55
MKS-8036A   62
Mode selection buttons   48
Modulation   211
MORE button   57
Morphing   194
Mosaic

wipes   356
Multi   209, 220

N
NAM   40, 101, 274
Negative NAM   193
Next transition   101

selecting   101
selection buttons   39

Non-additive mix   40, 101
Non-Sync state   125
Normal

edge   182
mix   148

Numeric keypad   49
control block   48

O
ON AIR indicators   57
One-stroke mode   114
One-time mode   114
Operating buttons   43
Operation

buttons   60
modes   259

Outline   141
parameters   181

Output
destination specification 

buttons   57
OVERRIDE button   58
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P
Page Roll   364
Page turn   363
Pair file processing   298
Pair mode   259
Pairing   210
Parameter group button   75
Pattern key   273
Pattern limit   120

buttons   41
setting by a menu 

operation   122
setting with the fader lever   

121
transition   122

Pattern mix   193
types   193

PGM/PST
menu   376

Picture-in-picture   363, 368
Plane function   148
Positioner   204, 217, 240, 247
Positive NAM   193
Preset color mix   102
Preview   129
Previous page button   76
PRIOR SET button   42
PST COLOR MIX   40

R
Random/diamond dust wipes   

358
Regions

selection buttons   48
Related manuals   15
Replication   220
Right button   85
Rotary wipes   355
Rotation   206, 219
RUN CTRL button   47

S
Search dial   62
SEMI LINK   196
Setup   31
Shadow   141

parameters   180
SHIFT button   38
Shift button   85
Shortcut   88
Shotbox   29
Shotbox menu   388
SHOW KEY button   57
Show key function   186
Signal

assignment to buttons   96
name display   100
selection   94

Simple P/P Software   348
Slide   359, 367
Snapshot   28

menu   387
Soft edge   141, 217
Softening

edge   182
wipe pattern edge   217

Source
name displays   38

Space button   85
Speed   206
Spiral   214
Split   200, 359
Spring   213
Squeeze   360, 367
Standard wipe patterns   190
Standard wipes   353
Status area   75
Status menu   320, 381
STOP NEXT KF button   47
Sub (subsidiary) mask   143

using   167, 183
Subsidiary menu site   88
SUPER MIX   40
Super mix   102

settings   113
Swap   308, 312

T
TC button   83
Time offset execution   132
Timecode input mode   118
Top menu list   68

Top menu selection buttons   
51

Top menu window   85
TRACE button   58
TRANS PVW button   41
Transition

control block   39, 134
execution   117
indicator   67
next   101
preview   129

Transition execution
section   40
with the fader lever   125

Transition indicator   40
function   117

Transition rate   118
display   41
setting by a menu 

operation   120
setting in the MISC menu   

317
setting in the numeric 

keypad control block   
119

Transition type   101
selecting by a menu 

operation   112
selection buttons   40

Trim button   83

U
User preference button   51
User programmable DME   

367, 371
Notes on keyframe 

creation   252
patterns   251
transition mode   227, 251

Utility   29
Utility/shotbox control block   

65

V
V/K mode   259
VF buttons   75
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Video

processing   92, 171
signal adjustment   151

Video process   323
memory   324
settings   325

W
Window adjustment   150, 154
WIPE   40
Wipe   23, 102

copy   309
enhanced   190
modify clear   215
mosaic   190
pattern list   353
random/diamond dust   

190
rotary   190
standard   190
swap   309

Wipe direction   199, 217
selection buttons   41

Wipe modifiers   198
Wipe pattern

aspect ratio   208, 219
edge modification   200
key   139
modulation   211
replication   209, 220
rotation   206
selection   191
types   190

Wipe pattern/modifier 
combinations   215

Wipe position   204, 217
Wipe settings   191

for independent key 
transitions   216

Wipe snapshot   221

X
XPT HOLD

button   38

Y
Y balance   150

adjustment   154

Z
Zabton   141, 164, 182
Z-ring   61
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